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Safety Precautions 
 
 

 

    
Ignoring these instructions and improperly handling the machine may lead to 
death or serious injury. 

 

    
Ignoring these instructions and improperly handling the machine may lead to 
injury. 
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General Precautions 
 
 

 

    
 

 

 
Do not touch the safety switch inside the machine. High voltage that can cause electric 
shock may result. Injury may also result from the turning of gears. 

 

 

 
Do not use flammable sprays near the machine. Fire may result due to the high 
temperature parts inside the machine. 

 

 

If the cover becomes abnormally hot, smoke is emitted, or a strange smell or noise is 
emitted, remove the power plug from the outlet and contact your dealer. 
Fire may result. 

 

 

If liquid such as water enters the inside of the machine, remove the power plug from the 
outlet and contact your dealer. 
Fire may result. 

 

 

If a foreign object such as a paper clip is dropped inside the machine, remove the power 
plug from the outlet and contact your dealer. 
Electrocution, fire, or injury may result. 

 

 

 
Do not operate or assemble the machine except as indicated in the user's manual. 
Electrocution, fire, or injury may result. 

 

 

If the machine is dropped or the cover is damaged, remove the power plug from the outlet 
and contact your dealer. 
Electrocution, fire, or injury may result. 

 

 

Remove the power plug from the outlet periodically and clean the base of the prongs and 
between the prongs. 
A fire caused by a short circuit may result due to dust accumulating at the base of the 
power plug prongs if the power plug is left in the outlet for an extended period of time. 

 
 

 

Do not vacuum spilled toner with an electric vacuum cleaner. Vacuuming spilled toner 
with an electric vacuum cleaner may result in ignition due to sparks from electric contacts 
or other reasons. 
If toner is spilled on the floor, etc., gently wipe it away with a wet rag, etc. to ensure that 
the toner does not scatter. 

 

 

 
Do not insert objects into the air vents. 
Electrocution, fire, or injury may result. 
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Do not place objects such as cups of water on the machine. 
Electrocution or fire may result. 

 

 

 
Ensure that pet urine does not enter or wet the machine. 
Electrocution or fire may result.  

 

 

 
If you open the cover of the machine, do not touch the fuser unit. 
Burns may result. 

 

 

 
Do not throw a used image drum or toner cartridge into a fire. 
A dust explosion or burns may result. 

 

 

Do not connect a power cord, cable, or ground wire other than those indicated in the 
user's manual. 
Fire may result. 

 

 

Operation is not guaranteed if a UPS (uninterruptible power supply) or inverter is used. 
Do not use an uninterruptible power supply or inverter. 
Fire may result. 

  
 
 

 

    

 

 

 
Keep away from the paper outlet when turning the power on and while printing. 
Injury may result. 

 

 

 
Do not touch a broken LCD display. Injury may result. If liquid (liquid crystal) that leaks 
from the LCD display gets into your eyes or mouth, immediately rinse them with a large 
amount of water. Also seek medical advice, as required. 

 

 

 
Do not disassemble or forcibly open the image drum or toner cartridges. The toner may 
be scattered, causing you to inhale the toner or get your hands or clothes stained with the 
toner. 
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Other Cautions 
 

Regarding the Printing of Paper Currency and Securities, etc. 
• The duplication and printing of items such as paper currency (including foreign paper currency), 

national bonds, municipal bonds, postage stamps, and revenue stamps or the creation of similar 
misleading objects is a crime and punishable by the law, regardless of the intended use. 

• The duplication and printing of the following items for the purpose of use as the real thing is 
punishable as a crime. 

• Securities such as stock, bills, and checks 

• Documents such as certificates created by a public official or government office 

• Documents regarding rights and obligations or proof of facts, such as contracts 

• Seals, signatures, or symbols of government offices or public officials 

• Seals or signatures of individuals 
 

• The unauthorized duplication of materials protected by copyright law (such as books, magazines, 
paintings, maps, and photos) is illegal, except for personal or home use, or other corresponding 
use within a limited scope. 

• Related Laws 
Criminal Law, Law Concerning the Regulation of Securities Resembling Paper Currency, Act on 
Control of Imitation, etc. of Revenue Stamps, etc., Act on Control of Imitation, etc. of Postal Stamps, 
etc., Act on Counterfeit, Alteration and Imitation of Coins, Money Bills, Banknotes and Securities 
Circulating in Foreign States, Copyright Law 

 

Regarding the Prevention of Electromagnetic Interference 
This machine is a class A device. Using this machine in a residential environment may cause 
electromagnetic interference. In this case, the user may be requested to implement appropriate 
countermeasures. 

 

Regarding the Regulation of Harmonic Waves 
This machine conforms to the JIS C 61000-3-2 standard on harmonic wave currents. 

 
 

Trademarks 
Microsoft, Windows, and Windows Server are trademarks or registered trademarks of Microsoft 
Corporation in the United States and other countries. 

Other product names and brand names are trademarks or registered trademarks of their respective owners. 
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Screens 
Unless otherwise specified, this manual uses screens from the following operating system in examples. 

• Windows 10 

Screens may differ from those in this manual, depending on the operating system, model, and version 
you are using. 

 
 

Marks  
This manual uses the following marks. 
 

Mark Meaning 
 

 
Indicates cautions for operating the machine correctly. Make sure to read these 
cautions to ensure that you operate the machine correctly. 

 

 
Indicates information that is convenient or useful for using the machine. It is 
recommended that you read this information. 

 

 
Indicates a reference topic. Read when you need more information. 

 
 

Symbols  
This section describes the symbols used in this manual and their meaning. 

 

Symbol Meaning 
« » Indicates buttons/keys on the operation panel of the machine. 
 
 
[ ] 

Indicates menu names, item names, and selections displayed on the operation 
panel. 
Indicates the menus, windows, and dialog names displayed on the computer 
screens. 

 
" " 

Indicates message and entered text displayed on the operation panel. 
Indicates file names on a computer. 
Indicates the titles of links. 

< > Indicates keys on the keyboard of the computer. 
> Indicates the menu transition of the machine and the computer. 

 
 
Illustrations  
The operation panel screens used in this manual use the default settings. 
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Licenses 
 
The software license agreement that customers agree to before using the products included in the 
package of the machine is indicated below. 

 
• Request for Agreement 

Please make sure to read this agreement before using the products included in the package of 
the machine. 

When a customer uses the products included in this package, the customer is deemed to have agreed 
to the terms of this agreement. 

If you do not agree to the terms of this agreement, please return the product to the dealer where it 
was purchased. 
 

Oki Data Corporation (hereinafter "Oki Data") grants the customer non-exclusive rights to use the 
software included in this package (hereinafter "the software"), based on the following terms. Oki Data 
reserves the right to license the use of the software to customers. 
 

1. Scope of Use 

The customer may use the software by installing its programs to multiple computers directly or via a 
network, only while the customer owns an Oki Data printer that supports the software. The customer 
may also make one copy of the software for backup purposes. 

 
2. Property Rights and Responsibilities 

(1) Oki Data and its licensers reserve the right to copy, publish, and own the software and its copies. The 
configuration, structure, and code of the software are important confidential information for the business 
of Oki Data and its licensers. The software is protected by copyright law in the United States and Japan 
and international treaties, and must be handled in the same manner as books and other works. 

(2) Except for the copy indicated in Clause 1, the software may not be duplicated, loaned, rented, 
leased, transferred, or licensed, in full or in part. 

(3) The customer agrees to not revise, modify, translate, reverse engineer, decompile, or disassemble the 
software. 

(4) The customer agrees to not rename the software. 

(5) The customer holds no rights regarding the software, except those recognized in this agreement. 
 

3. Period 

(1) The license granted to the customer for the software is valid until this agreement is terminated. 

(2) The customer can terminate this agreement by discarding and erasing the software and all of its 
copies. 

(3) Oki Data reserves the right to terminate the license agreement granted to the customer if the customer 
violates the terms of this agreement. When this agreement is terminated in such a manner, the 
customer must discard and erase the software and all of its copies and stop using the software. 
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4. Guarantee 

(1) Oki Data and its licensers do not guarantee anything regarding the software, including the following. That 

using the software will enable the customer to obtain the desired performance or results. 
That the software is free from defects. 
That the software does not violate the rights of third parties. That 
the software is fit for a specific purpose. 

(2) The software may be modified or changed without notice. 
 

5. Limited Liability 

Oki Data and its licensers will not be held responsible for any direct, indirect, or derivative damages or 
losses caused by the software, even if Oki Data was aware of the possible of such damages occurring, 
even if the claim for those damages is based on an illegal act (including, but not limited to negligence), 
or based on any other legal grounds. Furthermore, Oki Data and its licensers will also not be held 
responsible for any claims made by third parties caused by the software or related to the software. 

 
6. Applicable Law 

The license agreement for the software is based on Japanese law, including the formation of this 
agreement. 

 
7. Validity of This Agreement 

If part of this agreement is deemed invalid and not legally binding, this will not affect the other parts of 
this agreement, and those other parts will remain valid and legally binding. 

 
8. Export Control 

The software may not be exported to countries prohibited by the export control laws of Japan and the 
United States or other related laws and regulations, and may also not be used in a way that is prohibited 
by any law or regulation. The customer agrees to not export or re-export the software or products 
created from the software without obtaining permission from the government of the United States and 
Japan. If the customer violates this clause, this agreement is terminated automatically. 
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How to Unpack the Machine 
 

• Packaging and cushioning materials are used for transporting the machine. Do not dispose of them, 
and keep them for future use. 

 

1 Remove the machine from the box, and then remove the cushioning material and plastic bag. 

2 Lift the machine, and then place it where it is to be installed. 

 

• For details on the installation location, refer to "Installation". 
 
 
 
 

Checking the Accessories 
Check that you have everything shown below. 

 

• Be sure to use the consumables supplied with the machine first. If consumables other 

than the supplied ones are installed first, the life time may not be shown correctly or 

supplied consumables may become unusable. 
 

• Main Body 
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• Toner Cartridge 

 

• A toner cartridge can print approximately 5,000 pages (reference value based on tests 

printing simple 1-inch square black mark patterns). 

 
 
 

• Guide Rib x 4 
 

 
 
 

• Power Cord 
 
 

• A LAN cable and USB cable are not included. Prepare cables suitable for the connection 
environment. 

 

• Packaging, cushioning materials, and cover toner are used for transporting the 

machine.  

 

NOTE: Do not dispose of them, and keep them for future use. 
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Installing Consumables 
 

• Do not turn the power of the machine on. 

• Install the consumables after confirming that the power of the machine is off. 

• Use extra care when handling the image drum (the glossy cylinder), because it is fragile. 

• Do not expose the image drum unit to direct sunlight or strong light (approximately 

1,500 lux or more). Do not leave the image drum unit exposed for 5 minutes or more, 

even under room lighting. When the image drum unit will be left alone for 5 minutes or 

more, cover it with black paper, etc. to prevent it from being exposed to light. 
 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

2 Open the top cover until it stops. 
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3 Peel off the protective tape. 

4 Peel off the protective tape, and remove the desiccant. 

 

5 Remove the cover toner. 
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6 Close the top cover. 

 

7 Open the toner cartridge cover. 

 

 

 

8 Take out the toner cartridge from the packaging bag, and shake it several times 
vertically and horizontally. 
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9 Place the toner cartridge in the direction that it will be attached to the machine. 

 

10 Attach the toner cartridge. 
  
 
 

 

 

11 Close the toner cartridge cover. 
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 Using the Machine 
 

Installation 
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Installing Options 
Turning On or Off the Machine 
Connecting a LAN Cable 
Connecting via Wireless LAN 
Using Both a Wired LAN and Wireless LAN Connection 
Connecting a USB Cable 
Installing the Printer Driver to a Computer 
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Installation 
 

Installation Environment  
 
Install the machine in the following environment: 
 
Ambient temperature: 10°C to 32°C 
 
Ambient humidity: 20% to 80% relative humidity 
 
Maximum wet bulb temperature: 25°C 

 
 

• Use care to prevent condensation. It may cause a malfunction. 

• If you install the machine in a location whose ambient humidity is 30% RH or below, use a humidifier or 
antistatic mat. 

• Depending on the installation environment, the machine may emit bothering operation noise. If 

the noise bothers you, we suggest the machine be installed in a location away from you or in 

another room. 

 

 
 
 
 
 
 
 
 
 
 
 

• Do not install the machine directly on a thick rug or carpet. 
• Do not install the machine in a location with bad circulation and ventilation such as a closed room. 
• Make sure to ventilate the room if you use the machine in a small room continuously for an 

extended period of time. 
• Install this machine away from a source that emits strong magnetic fields or noise. 
• Install this machine away from a monitor or television. 

• Do not install the machine in a location subject to high temperatures or in a location near fire. 
• Do not install the machine in a location where chemical reactions may occur (such as a laboratory). 
• Do not install the machine near alcohol, thinners, or other flammable solvents. 
• Do not install the machine in a location within the reach of small children. 
• Do not install the machine in an unstable location (such as on an unsteady stand or slanted location). 
• Do not install the machine in a location subject to high level of humidity, dust, or direct sunlight. 
• Do not install the machine in an environment exposed to salty air or corrosive gas. 
• Do not install the machine in a location subject to much vibration. 
• Do not install the machine in a location where its vent hole is blocked. 
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Installation Space  
Install the machine on a flat surface that is wide enough to accommodate the legs of the 

machine. As shown in the following figures, allow enough space around the machine for your 

media type. 

 
 
 
 
 
 
 
 
 
 
 

15” 
7.75” 

7.68” 

9.60” 

17.28” 
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Names of Components 
  Front View  

 

 
 
 
 

No. Name Description 
1 Top Cover The top cover of the machine. Close this when 

printing. 
2 Top Cover Lever Use this to open the top cover. 
3 LCD Panel Indicates the status of the machine and the settings. 
4 Toner Cartridge Cover Opens and closes when replacing the toner cartridge. 
5 Power ON/OFF Switch The power switch cover. Open the cover to find the 

power switch. 
6 Paper Outlet Outputs printed paper. 
7 Air Outlet The air vent. 
8 Buzzer The buzzer. Can be set to sound when an error 

occurs in the machine. 
 
 
 

  Rear View  
 
 
 
 
 

 
  
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 

 
 
  

11 

9 

10 

12 

13 

14 

15 
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No. Name Description 
   
9 Feeder Cover The cover of the paper feeder. 

10  Paper Inlet  Load paper here. 

11  Feeder Cover Lever  Use this to open the feeder cover. 

12 AC Inlet  The terminal for the power cable. 

13 Paper Sensor The sensor for detecting the paper. 
14 Paper Guide Align this with the paper width. 
15 Paper Guide Lever Fixes the Paper Guide. 

 
  Side of the Machine  

 
 
 
 
 
 
 
 
 
 
 
 

16 18 17 
 

No. Name Description 
16 LAN The terminal for the LAN cable. 
17 USB The terminal for the USB cable. 
18 W-LAN The slot for the Wireless LAN Module. 
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  Inside of the Machine  
 
 

 
 
 

  

 
 

 
 
 
 
 
 
 
 
 

No. Name Description 
19 LED Heads The LED heads. 
20 Image Drum Unit The image drum unit. 
21 Fuser Unit The fuser unit. Take care, as this becomes hot while 

printing. 
22 Toner Cartridge The toner cartridge. 
23 Transfer Belt Unit The transfer belt unit. This is set below the image 

drum unit. 

19 

20 

21 

22 

23 
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Installing Options 
The machine has the following optional products. 
 

• Wireless LAN Module 

Installed to connect via wireless LAN. 

• Presenter Unit 

Installed to stop the printed paper before it is fully ejected. 
 

  Installing the Wireless LAN Module  
Install the Wireless LAN Module to connect the machine and a computer via wireless LAN. 

 

 

1 Turn off the machine. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 
 

2 Insert the Wireless LAN Module into the connector on the side of the machine. 
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3 Insert the cable of the Wireless LAN Module into the recess on the side 
of the machine. 

 

4 Attach the Wireless LAN Module to the front of the machine. 

5 Turn the machine on while holding «OK» button on the operation panel. 

6 Hold «OK» button until [BOOT MENU] is displayed on the screen. 
 

 

7 When [BOOT MENU] is displayed, release your finger and press «OK» button again. 
 

 

8 When [ENTER PASSWORD] is displayed, enter the password. 
 

 
 

• The default password is "999999." 

BOOT MENU  
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9 When the password has been entered, press «OK» button. 
 

 
 

10 Press «∧» button or «∨» button to display [WIRELESS MODULE], and press 
«OK» button. 

 

 

11 Press «∧» button or «∨» button to display [ENABLE], and press «OK» button. 

 

12 "*" is displayed on the right edge of the bottom of the screen. 
 

 

13 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
 

 
 

WIRELESS MODULE  

WIRELESS MODULE 
ENABLE * 

READY TO PRINT  
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  Installing the Presenter Unit  
The Presenter Unit is installed to retain the printed paper in the outlet without ejecting it. 

When installation of the Presenter Unit is complete, set the Presenter Unit to 
[ENABLE] on the operation panel. 

 

• Installing the Presenter Unit 
 

1 Turn off the machine. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

2 Remove Cover-Front-Sub-A. 

3 Remove Cover-Front-Sub-B. 
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4 Remove the Label-Cap (x 2). 
 

 
 
 

5 Remove the Cap-Cover-PSNT (x 2) of the Presenter Unit. 

 
 

6 Mount the Presenter Unit to the machine. 

• Take care, as it will not be completely secure. 
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7 Tighten the screws (x 2). 

8 Connect the connector. 
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9 Attach the Cover-Cable-PSNT. 

10 Attach the Cap-Cover-PSNT (x 2). 
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  Enable the Presenter Unit  
 

1 Turn on the machine. 

• For information on turning on the machine, refer to "Turning On the Machine". 
 

2 Confirm that [READY TO PRINT] is displayed on the machine. 

3 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

4 Press «OK» button. 

5 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 

6 When the password has been entered, press «OK» button. 

7 Press «∧» button or «∨» button several times to display [OTHERS SETUP]. 

8 Press «OK» button. 

9 Press «∧» button or «∨» button several times to display [PRESENTER UNIT]. 

10 Press «OK» button. 
 

11 With the setting flashing, press «∧» button or «∨» button to display [ENABLE], 
and press «OK» button. 

12 The machine restarts and returns to the [READY TO PRINT] standby status. 
 

• For information on printing, refer to "Printing Using the Presenter Unit". 
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Turning On or Off the Machine 
 

  About the Power Supply  
Ensure the following conditions for the power supply. 

N36700A: 110 to 127V AC (Range 99 to 
140V AC) N36700B: 220 to 240V AC 
(Range 198 to 264V AC) 
Power frequency: 50/60 Hz ± 2% 

 

• If the power supply is unstable, use a voltage regulator. 

• The maximum power consumption of the machine is 650W. Check that the power supply is sufficient. 

• Operation is not guaranteed if an uninterruptible power supply (UPS) or inverter is 

used. Do not use an uninterruptible power supply (UPS) or inverter. 

 
 

    
Fire or electric shock may result. 
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• Be sure to turn off the machine before connecting and disconnecting the power cord and the ground 
wire. 

• Be sure to connect the ground wire to the designated ground terminal. 
• If the machine cannot be grounded, contact your dealer. 
• Be sure not to connect the ground wire to a water pipe, a gas pipe, the ground terminal of a telephone 

line, or a lightning rod. 
• Be sure to connect the ground wire before connecting the power cord to the outlet. 

Also, be sure to unplug the power cord from the outlet before disconnecting the ground wire. 
• Be sure to hold the power plug when plugging in or unplugging the power cord. 
• Be sure to insert the power cord fully into the power outlet. 
• Do not plug in or unplug the power cord with wet hands. 
• Install the power cord in a location where users cannot step on it, and do not place any object on the 

power cord. 
• Do not bundle or tie the power cord. 
• Do not use a damaged power cord. 
• Do not overload the outlet. 
• Do not connect the power cords of this machine and other electric products to the same outlet. If the 

power cord of this machine is connected to the same outlet as other electric products, especially an 
air conditioner, copier, or shredder, this machine may malfunction due to electrical noise. If you have 
to connect the power cord of this machine to the same outlet as other products, use a commercially 
available noise filter or noise cut transformer. 

• Use the power cord included in this machine, and plug the cord directly into the outlet. Do not use the 
power cords of other products for this machine. 

• Do not use an extension cord. If you have to use an extension cord, use a cord rated 10A or higher. 
• If you use an extension cord, this machine may not work properly due to AC voltage drop. 
• Do not turn off this machine or unplug the power cord while printing. 
• If you do not use this machine for an extended period of time at occasions such as holidays or trips, 

unplug the power cord from the outlet. 
• Do not use the power cord included in this machine for other products. 
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  Turning On the Machine  
 

1 Connect the power cable to the power connector on the rear of the machine. 

2 Insert the power plug into the outlet. 

 

3 Open the cover on the front left of the machine and press and hold the power 
switch for approximately one second. 
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  Turning Off the Machine  
 

1 Open the cover on the front left of the machine and press and hold the power 
switch for one second. 

 

 
 

2 Wait until [SHUTTING DOWN. PLEASE WAIT/TURN OFF AUTOMATICALLY] is 
displayed on the operation panel and the operation panel turns off. 

 

3 Remove the power plug from the outlet. 
 

 
 

4 Remove the power cable from the power connector on the rear of the machine. 

 

• When you want to shut down the machine forcefully, press and hold the power switch for more than 5 
seconds. 
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Connecting a LAN Cable 
A LAN cable can be used to connect the machine to a computer via a wired network. Before 
installing the printer driver, connect the printer to the network using a LAN cable. 

 

1 Prepare a LAN cable and hub. 
 

 

2 Make sure that the machine and the computer are turned off. 

3 Insert the LAN cable into the network interface connector of the machine. 

4 Insert the other end of the LAN cable into the hub. 
5 Insert the LAN cable into the network interface connector of the hub. 
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Connecting via Wireless LAN 
 

  Preparing to Connect via Wireless LAN  
 

Connecting via an Access Point 

1 Check whether your wireless LAN access point supports the following environment. 
• Standard: IEEE 802.11 a/b/g/n 

• Access method: Infrastructure mode 
 

2 Check whether the wireless LAN access point supports WPS. 
If it does not support WPS, check the SSID and encryption key in the manual that came 
with the wireless LAN access point. 
 

• The SSID may also be called the network name, ESSID, or ESS-ID. 

• The encryption key may also be called the network key, security key, password, or pre-shared key 
(PSK). 

 

Directly Connecting to the Machine 

1 Check whether your wireless terminal supports the following environment. 
• Standard: IEEE 802.11 b/g/n 

• Security: WPA2-PSK (AES) 
 

2 Check whether your wireless terminal supports WPS-PBC (push). 
If you are not sure whether it supports WPS-PBC, turn the machine on and 
connect manually. 

 
  Connecting via an Access Point (Infrastructure)  
To choose a valid default gateway. 

1 Press up or down on the operator panel to display [ADMIN SETUP]. 

2 Press the «OK» button. 

3 Enter the Admin password, and then press the «OK» button. 

4 Press «∧» button or «∨» button on the operator panel to display 
[NETWORK SETUP], and then press the «OK» button. 

 

5 Press «∧» button or «∨» button on the operator panel to display [ENABLING 
DEFAULT GATEWAY], and then press the «OK» button. 

 

6 Press «∨» button the operator panel to display [WIRELESS 
(INFRASTRUCTURE)], and then press the «OK» button. 
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Connecting Using WPS 
If the wireless LAN access point supports WPS, the connection to the wireless LAN can be made 
easily by using the easy setup button (WPS button). 
Follow the procedure below for the setup. 

 

1 Confirm the position of the easy setup button and when to press the button by 
referring to the user manual of the wireless LAN access point. 

2 Confirm that the wireless LAN access point has been activated and is 
functioning normally. 

3 Turn on the printer. When [SETUP WIRELESS?] appears, select [YES]. Proceed 
to Step 6. 

4 Press «∧» button or «∨» button on the operator panel to display 
[WIRELESS SETTING], and then press the «OK» button. 

5 Enter the Admin password, and then press the «OK» button. 

 

• The default password is 999999. 
 

6 Press up on the operator panel to select [ENABLE], and then press the «OK» button. 

7 Press «∧» button or «∨» button on the operator panel to display [WPS SETUP], 
and then press the «OK» button. 

8 Select [WPS-PBC], and then press the «OK» button. 

9 Select [YES], and then press the «OK» button. 

10 The Printer starts searching for wireless LAN access points. During 2 minutes, 
press the easy setup button for the wireless LAN access point for a few seconds. 

11 Once the setup completion screen is displayed, it indicates that the wireless LAN setup has 
completed. 

 
Set the IP Address 
Set a different IP address for the wireless LAN from that of the wired LAN. Enter the setting menu and 
make the settings by the following procedure. 

1 Press «∧» button or «∨» button on the operator panel to display 
[WIRELESS SETTING], and then press the «OK» button. 

2 Enter the Admin password and then press the «OK» button. 

 

• The default password is 999999. 
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3 Press «∧» button or «∨» button on the operator panel to display 
[NETWORK SETTING], and then press the «OK» button. 

4 Press «OK» button when [IP ADDRESS SET] is displayed. 

5 Press «∧» button or «∨» button on the operator panel to select [AUTO] or 
[MANUAL]. If [MANUAL] is selected, manually input the IPv4 Address, Subnet Mask 
and Gateway Address. 

 
 

  Directly Connecting to the Machine (AP Mode)  
 

Automatic Setup (Push Button) 
If the wireless terminal (computer, tablet, smartphone, etc.) supports «WPS-PBC» 
(push button), then you can use the WPS button to connect via wireless (AP mode). 
 
Follow the procedure below to connect. 

 

1 Confirm the position of the WPS button in the user's manual provided with the 
wireless terminal (computer, tablet, smartphone, etc.). 

2 Turn on the printer. 
3 When [SETUP WIRELESS?] appears, select [NO]. 

4 Press «∧» button or «∨» button on the operator panel to display [WIRELESS 
(AP MODE) SETTING], and then press the «OK» button. 

5 Enter the Admin password, and then press the «OK» button. 

 

• The default password is 999999. 
 

6 Select [ENABLE], and then press the «OK» button. 

7 Press «∧» button or «∨» button on the operator panel to display 
[AUTOMATIC SETUP (PUSHBUTTON)], and then press the «OK» button. 

8 Select YES, and then press the «OK» button. 

9 Start WPS-PBC (push button) on the wireless terminal (computer, tablet, 
smartphone, etc.). 

10 Once the setup completion screen is displayed, it indicates that the wireless LAN setup has 
completed. 
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Using Both a Wired LAN and Wireless LAN Connection 
The machine can use both a wired LAN and wireless LAN connection at the same 

time. The available combinations are indicated in the table below. 

 

• Wireless LAN (infrastructure) and wireless LAN (AP mode) cannot be enabled at the same time. 

• When wired LAN and wireless LAN are connected to the same subnet, communication may become 
unstable. 

 
 

Yes: Enabled, No: Disabled 
 Connected with LAN 

Cable 
Wireless LAN 
(Infrastructure) 

Wireless LAN 
(AP Mode) 

Available 
Combinations 

Yes Yes No 
Yes No Yes 
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Connecting a USB Cable 
 

• A USB cable is not included with the machine. Prepare an A-B type cable separately. 
 
 

1 Prepare a USB cable. 

 

2 Make sure that the machine and the computer are turned off. 

3 Insert the B end of the USB cable into the USB interface connector of the machine. 

• Do not insert the USB cable into the network interface connector. Doing so may cause a malfunction. 
 

 

4 Insert the A end of the USB cable into the USB interface connector of the computer. 

• For Windows, do not insert the other end of the USB cable into the computer until an 

instruction appears on the screen during the printer driver installation. 
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Installing the Printer Driver to a Computer 
This section uses the procedure for installing from the software DVD-ROM of the machine as an 
example. 

The software DVD-ROM is not included with the machine. Obtain the "Software DVD-
ROM" or the software you want to install from the provider of your machine. 

1 Connect this machine to a computer via a network or USB cable. 

2 Insert the "Software DVD-ROM" into the computer. 

3 When [Auto Play] is displayed, click [Run setup.exe]. 

• If the [User Account Control] screen is displayed, click [Yes]. 
 

4 Select a language from the drop-down list. 

5 Read the license agreement, and then click [Accept]. 

6 Select [Network] or [USB] in accordance with the connection method of the 
machine and computer, and then click [Next]. 

 

• If the [Windows Security Alert] screen is displayed, click [Allow access]. 
 

7 Select the model name of the machine, and then click [Next]. 

8 Click [Install Optional Software]. 

9 Click [Complete]. 

10 Click [Next]. 

11 Click [Exit]. 
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 Using the Operation Panel 
 

Name and Function 
Description of the Display 
Entering and Viewing the Menu 
Entering Characters 
Printing a Demonstration Page 
Adjusting the Volume 
Checking Information About the Machine 
Setting the Power Save Mode Transition Time 
Setting the Sleep Mode Transition Time 
Precautions for the Power Save Function 
Setting the Auto Power Off Time 
Initializing the Flash Memory 
Initializing the Network Settings 
Initializing the Settings of the Machine 
Changing the Administrator Password 
Correcting the Color Density 
Adjusting the Color Balance (Density) 
Correcting Color Shift 
Adjusting the Paper Sensors (Sensor Calibration) 
Menu List 

4 
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Name and Function 
 
 
 
 
 

6 

8 

7 

9 
 
 
 
 

 

 
 

No. Name Description 
1 LCD Displays the status of the machine and the menu 

items. Turns off when the machine is in the Power 
Save mode. 

2 «∧» Button Enters the Menu mode. Returns to the previous item 
when the machine is in the Menu mode. Press and 
hold it for 1 second or more to skip forward. 

3 «∨» Button Enters the Menu mode. Proceeds to the next item 
when the machine is in the Menu mode. Press and 
hold it for 1 second or more to skip forward. 

4 «BACK» Button Returns to the previous screen. 
5 «OK» Button Confirms the selected item. Or confirms the set 

value. 
6 «POWER SAVE» Button Enters the Power Save mode. Or cancels the Power 

Save mode. Lights red when the machine is in the 
Power Save mode. 

7 «CANCEL» Button Stops an operation or cancels a setting. 
8 «ONLINE» Button. Switches the machine online/offline. 
9 «FEED/CUT» Button Cuts, ejects, and feeds the paper. 

10 POWER LED Lights up when the power of the machine is on. 
However, flashes when the machine is in the Sleep 
mode. 

11 ONLINE LED Lights up when the machine is online (when printing 
can be performed). 

12 WARNING LED Lights up when an error has occurred in the machine. 
Printing is possible. 

13 ERROR LED Flashes when an error has occurred in the machine. 

 3 4   

 

8 

7 

 

  12  
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Description of the Display 
The display indicates the status of the machine and the menu items, etc. 

 

  When Printing Can Be Performed  
When the machine can perform printing, [READY TO PRINT] is displayed on the top of the 
screen. 

 

 

  When an Error Has Occurred in the Machine  
Top: Displays the solution. 
Bottom: Displays the error code and error type. 

 

• For information on errors and solutions, refer to "9. Troubleshooting". 
 

  When the Machine Is in the Menu Mode  
Top: Displays the category or item. 
Bottom: Displays the setting when an item is displayed on the top. 

 

 

The menu depth (level) is also displayed with [>]. 
When [>] or [>>] is displayed, there are items in a lower level. 

 

• For details on menu items, refer to "Menu List". 

READY TO PRINT  

REPALCE TONER 
412:TONER EMPTY 
  

POW SAVE TIME 
1MIN            * 

FEEDER CONFIG 
> 
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Entering and Viewing the Menu 

1 Confirm that [READY TO PRINT] is displayed on the machine. 
 

 
 

2 Press «∧» button or «∨» button to enter the Menu mode and display the 
menu categories. 

 

 
 

3 Press «∧» button or «∨» button several times to display the category you want to 
set, and press «OK» button. 

 

 
 

4 Display the lower menu categories. The [>] indicating the menu depth is 
displayed on the bottom of the screen. 

 

5 Press «∧» button or «∨» button several times to display the category you want to set, and 
press «OK» button. 

 

 

READY TO PRINT  

DEMO PAGE  

MENU  

POW SAVE TIME  

SYSTEM ADJUST 
> 
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• [>>] is displayed on the bottom of the screen if there are lower menu categories. 
 

 

6 When an item is displayed on the top and a setting is displayed on the bottom, press 
«OK» button to make the setting flash and become changeable. Press «∧» button or 
«∨» button several times to display the value you want to set, and press «OK» button. 

 

 

7 "*" is displayed on the right edge of the setting. 
 

 
 

8 To end the Menu mode, press «ONLINE» button, or press «BACK» button until 
"READY TO PRINT" is displayed. 

 

POW SAVE TIME 
1MIN  

POW SAVE TIME 
1MIN * 

READY TO PRINT  
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Entering Characters 

1 When the screen for entering the password, etc. is displayed, press «∧» button or 
«∨» button to select the character to enter. 

Press «∧» button to display characters starting with lower case letters. 
The characters are displayed in the following order: 
lower case letters → symbols → upper case letters → numbers (0 to 9) 

Press «∨» button to display the characters in reverse order. 
Numbers (9 to 0) → upper case letters in reverse → ... 

 

 

2 Press «OK» button to confirm the selected character. 
 

 

3 The cursor moves to the next digit. 
 

 
 

4 Perform the same operation to enter the rest of the characters, and press 
«OK» button when all the characters have been entered. 

 

ENTER PASSWORD 
9 

ENTER PASSWORD 
* 

ENTER PASSWORD 
*_  

ENTER PASSWORD 
****** 
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Printing a Demonstration Page 
 

• Use cut sheet cut to the following size or continuous paper (roll paper) without a mark. 

The operation is not guaranteed for other paper. 

When printing on cut sheet 
Prepare paper that is 74 mm wide and 210 mm long. 
You can print on A4 or LETTER paper that has been cut to a quarter of its long side.  
Print after setting [MENUS] > [FEEDER CONFIG] > [PAPER FORM] > [CUT PAPER]. 

 
When printing on continuous paper (roll paper) 
Prepare continuous paper (roll paper) without a mark that is 74 mm to 86 mm wide. 
Print after setting [MENUS] > [FEEDER CONFIG] > [PAPER 

FORM] > [CONTINUOUS PAPER] and [MENUS] > [FEEDER 

CONFIG] > [CUT TYPE] > [LENGTH]. 
 
 
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Load the paper. 

3 Press «∧» button or «∨» button to display [DEMO PAGE]. 

4 Press «OK» button. 

5 Press «OK» button when [DEMO1/EXECUTE] is displayed. 
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Adjusting the Volume 
A buzzer notifies the user when an error has occurred in the machine or printing has finished. 

By default, the machine is set to sound the buzzer when the paper has run out. 

This section describes how to change the volume and set whether to sound the buzzer. 
 

  Setting the Volume  
Available values high, low, and off.  Low is set by default. 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 

5 When the password has been entered, press «OK» button. 

6 Press «∧» button or «∨» button several times to display [BUZZER SETUP]. 

7 Press «OK» button. 

8 Press «OK» button when [ERROR VOLUME] is displayed. 

9 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

10 Confirm that "*" is displayed to the right of the value you want to set. 

11 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
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  Setting the Volume for the Printing Complete Buzzer  
The buzzer volume can be set to high, low, or off, and is set to off by default. 

If the buzzer volume is set to high or low, the buzzer sounds each time a page is printed by 
default, regardless of the page count of the print data. You can change the buzzer to sound 
when printing is complete for all the pages of the print data. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 
5 When the password has been entered, press «OK» button. 

6 Press «∧» button or «∨» button several times to display [BUZZER SETUP]. 

7 Press «OK» button. 

8 Press «∧» button or «∨» button several times to display [PRINT 
COMPLETION VOLUME]. 

9 Press «OK» button. 

10 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

11 Confirm that "*" is displayed to the right of the value you want to set. 

12 If [OFF] is set, proceed to the last step. 
 
13 If [LOW] or [HIGH] is set, press «∨» button once to display [PRINT 

COMPLETION BUZZER]. 

14 Press «OK» button. 

15 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

16 Confirm that "*" is displayed to the right of the value you want to set. 

17 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
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Checking Information About the Machine 
 

  Printing and Checking a Report  
Perform the procedure below to print and check the values set in the machine. 

 

• Use cut sheet cut to the following size or continuous paper (roll paper) without a mark. 

The operation is not guaranteed for other paper. 

When printing on cut sheet 
Prepare paper that is 74 mm wide and 210 mm long. 
You can print on A4 or LETTER paper that has been cut to a quarter of its long side. Print 

after setting [MENUS] > [FEEDER CONFIG] > [PAPER FORM] > [CUT PAPER]. 

When printing on continuous paper (roll paper) 
Prepare continuous paper (roll paper) without a mark that is 74 mm to 86 mm wide. 
Print after setting [MENUS] > [FEEDER CONFIG] > [PAPER FORM] > [CONTINUOUS 

PAPER] and [MENUS] > [FEEDER CONFIG] > [CUT TYPE] > [LENGTH]. 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Print «∧» button or «∨» button to display [PRINT INFO]. 

3 Press «OK» button. 

4 Press «OK» button when [CONFIGURATION/EXECUTE] is displayed. 

5 Load the paper displayed on the screen in the machine. 

6 Press «OK» button. 
 

  Checking the Operation Panel  
You can check the print count, remaining consumables, network settings, and machine information on the 
operation panel. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [CONFIGURATION]. 

3 Press «OK» button to display the print count. 

4 To also check the remaining consumables, network settings, or machine 
information, press «∧» button or «∨» button to display the item you want to 
check, and press 

5 «OK» button 

6 Press «∧» button or «∨» button to check each value. 
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7 When you have finished checking, press «ONLINE» button, or press «BACK» 
button until [READY TO PRINT] is displayed. 

 
 

Setting the Power Save Mode Transition Time 
The machine enters the Power Save mode when it has not been used for a certain 
period of time. 0 minutes is set by default. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [MENUS], and press 
«OK» button. 

 

3 Press «∧» button or «∨» button several times to display [SYSTEM ADJUST], and 
press «OK» button. 

4 Press «OK» button when [POW SAVE TIME] is displayed. 

5 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

6 Confirm that "*" is displayed to the right of the value you want to set. 

7 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
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Setting the Sleep Mode Transition Time 
If the machine is not used for a certain period of time after it enters the Power 
Save mode, the machine enters the Sleep mode. 15 minutes is set by default. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [MENUS], and press 
«OK» button. 

3 Press «∧» button or «∨» button several times to display [SYSTEM ADJUST]. 

4 Press «OK» button. 

Display [POW SAVE TIME]. 

5 Press «∨» button once to display [SLEEP TIME], and press «OK» button. 

6 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

7 Confirm that "*" is displayed to the right of the value you want to set. 

8 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
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Precautions for the Power Save Function 
The machine does not enter the Sleep mode in the following cases. 

• When an error has occurred in the machine 
 
 
The machine does not enter the Power Save mode in the following cases. 

• When paper is remained in the Presenter Unit 
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Setting the Auto Power Off Time 
If the machine is not used for a certain period of time, it automatically turns off. 
By default, the machine does not automatically turn off. To make the machine 
automatically turn off, enable the Auto Power Off setting on the operation panel, and 
then set the time until the power turns off. 4 hours is set by default. 

 
 

  Enabling Auto Power Off  
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 
2 Press «∧» button or «∨» button several times to display [ADMIN SETUP], and press 

3 «OK» button 

4 Press «∧» button or «∨» button several times to display [POWER SETUP]. 
5 Press «OK» button. 
6 Display [AUTO PW OFF]. 

7 Press «∧» button or «∨» button several times to set to [ENABLE] or [AUTO 
CONFIG], and press «OK» button. 

 

8 Press «ONLINE» button, or press «BACK» button until [READY TO PRINT] is 
displayed. 

 
 

  Setting the Time Until Auto Power Off  
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [MENUS], and press 
«OK» button. 

3 Press «∧» button or «∨» button several times to display [SYSTEM ADJUST]. 

4 Press «OK» button. 

5 Display [POW SAVE TIME] 
 

6 Press «∧» button or «∨» button several times to display [AUTO PW OFF TIME], 
and press «OK» button. 

 

7 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

 

8 Press «ONLINE» button, or press «BACK» button until [READY TO PRINT] is 
displayed. 



64  

Initializing the Flash Memory 
When you initialize the flash memory, the following data is deleted. 

• Form data 

• Download demo print data 

• Saved menu settings 
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 

5 When the password has been entered, press «OK» button. 

6 Press «∧» button or «∨» button several times to display [OTHERS SETUP], 
and press «OK» button. 

 

7 Press «∧» button or «∨» button several times to display [STORAGE SETUP], 
and press «OK» button. 

 

8 [ENABLE INITIAL] is displayed. If [NO *] is displayed on the bottom, proceed to 
step 9. If [YES *] is displayed on the bottom, proceed to step 10. 

9 The bottom flashes when «OK» button is pressed. Press «∨» button to display 
[YES] on the bottom, and press «OK» button. (The flashing stops and [YES *] is 
displayed.) 

 

10 Press «BACK» button once to display [STORAGE SETUP]. Press «∧» button 
once to display [FLASH SETUP], and press «OK» button. 

11 Press «OK» button when [FLASH INITIALIZE / EXECUTE] is displayed. 

12 When the confirmation message is displayed, press «∧» button or «∨» 
button to display [YES] or [NO], and press «OK» button. 

 

13 If you selected [NO], the machine returns to the previous 
screen. If you selected [YES], a confirmation message is 
displayed again. 

14 If you selected [NO], the previous screen is displayed again, but since the machine 
remembers that it needs to initialize the flash memory, the flash memory is 
initialized the next time that the power is turned on. 
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15 If you selected [YES], the machine automatically restarts and the flash 
memory is initialized. 

 

Initializing the Network Settings 
The default network settings can be restored. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 

5 When the password has been entered, press «OK» button. 

6 Press «OK» button when [NETWORK SETUP] is displayed. 

7 Press «∧» button or «∨» button several times, and press «OK» button 
when [FACTORY DEFAULTS/EXECUTE] is displayed. 
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Initializing the Settings of the Machine 
The default settings of the machine can be restored. When this operation is 
performed, the machine automatically restarts. 
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 

5 Press «∧» button or «∨» button several times to display [SETTINGS]. 

6 Press «OK» button. 

7 Press «OK» button when [MENU RESET/EXECUTE] is displayed. 

8 Wait until [READY TO PRINT] is displayed on the screen after the device restarts. 
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Changing the Administrator Password 
This section describes the method for changing the administrator password. It is 
recommended that the default password is changed for increased security. 

Set 6 to 12 digits for the password. Numbers and lower case letters can be used for the password. 
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [ADMIN SETUP]. 

3 Press «OK» button. 

4 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 

5 When the password has been entered, press «OK» button. 

6 Press «∧» button once to display [CHANGE PASSWORD]. 

7 Press «OK» button. 

8 When [NEW PASSWORD] is displayed, enter the new password. 

9 When the confirmation screen is displayed, enter the same password. 

10 The password change is complete when [CHANGE PASSWORD] is displayed. 

11 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 



68  

Correcting the Color Density 
This section describes the procedure for correcting the density on the operation panel. 

 
1 Confirm that [READY TO PRINT] is displayed on the machine. 
2 Press «∧» button or «∨» button several times to display [CALIBRATION], and press 

«OK» button. 

3 Press «∨» button once to display [ADJUST DENSITY/EXECUTE]. 

4 Press «OK» button. 

5 The procedure is complete when [READY TO PRINT] is displayed on the screen. 
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Adjusting the Color Balance (Density) 
You can adjust the cyan, magenta, and yellow highlights (light areas), intermediate areas, and 
dark areas. 

This section describes the procedure for adjusting cyan. If you want to adjust other 
colors, perform the same operation for those colors. 

 

1 Confirm that [READY TO PRINT] is displayed on the machine. 
2 Press «∧» button or «∨» button several times to display [CALIBRATION], and press 

«OK» button. 

3 Press «∧» button or «∨» button several times to display [CYAN TUNING], and press 
«OK» button. 

4 Press «∧» button or «∨» button several times to display [CYAN HIGHLIGHT] (light 
areas), [CYAN MID-TONE] (intermediate areas), or [CYAN DARK] (dark areas), 
and press «OK» button. 

5 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. Positive values are darker and 
negative values are lighter. 

6 Confirm that "*" is displayed to the right of the value you want to set. 

7 Press «ONLINE» button to return to the [READY TO PRINT] standby status. 
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Correcting Color Shift 
This section describes the procedure for correcting color shift on the operation panel. 

 
1 Confirm that [READY TO PRINT] is displayed on the machine. 
2 Press «∧» button or «∨» button several times to display [CALIBRATION], and press 

«OK» button. 

3 Press «∧» button or «∨» button several times to display [ADJUST 
REGISTRATION/ EXECUTE]. 

4 Press «OK» button. 

5 The procedure is complete when [READY TO PRINT] is displayed on the screen. 
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Adjusting the Paper Sensors (Sensor Calibration) 
If paper jams or paper mark detection errors occur frequently, follow the procedure 
below to perform sensor calibration. 

 

1 The paper sensors are adjusted to the position suitable for the paper to use. 

• Adjust the paper sensors to a suitable position, as they cannot be correctly calibrated unless they are 
in a suitable position. 

 

• For details, refer to "Setting the Paper Sensors". 
 

2 Confirm that [READY TO PRINT] is displayed on the machine. 

3 Press «∧» button or «∨» button several times to display [MENUS], and press 
«OK» button. 

 

4 Press «∧» button or «∨» button to display [SENSOR CONFIG], and press 
«OK» button. 

 

5 Press «OK» button when [SENSOR CALIBRATION/EXECUTE CALIBRATION] is 
displayed. 

6 When [PLEASE REMOVE PAPER/YES] is displayed, remove the paper from the 
machine. 

7 With [YES] flashing, press «OK» button. 

8 Load the paper in the machine when [PLEASE LOAD PAPER] is displayed. 

9 The procedure is complete when [READY TO PRINT] is displayed. 
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Menu List 
This section describes the menu items that can be set on the operation panel. 

 
 
 

For details, refer to "DEMO PAGE". 
 
 
 

For details, refer to "CONFIGURATION". 
 
 
 

For details, refer to "PRINT INFO". 
 
 
 

For details, refer to "MENUS". 
 
 
 

For details, refer to "ADMIN SETUP". 
 
 
 

For details, refer to "PRINT STATISTICS". 
 
 
 

For details, refer to "CALIBRATION". 
 
 
 

For details, refer to "WIRELESS SETTING". 
 
 

For details, refer to "WIRELESS (AP 
MODE) SETTING". 

 
 

For details, refer to "BOOT MENU". 
 
 

 
DEMO PAGE  

 
Item Setting Description 

DEMO1 EXECUTE Prints a demonstration page. 

 
CONFIGURATION  
Enables you to check the information of the machine. 

 
Item Setting Description 

PRINT COUNT nnnnnn Displays the print count. 
SUPPLIES LIFE DRUM UNIT LIFE REMAINING nnn% Displays the remaining life of the 

image drum unit. 
BELT LIFE REMAINING nnn% Displays the remaining life of the 

transfer belt unit. 

Menu 
 

DEMO PAGE   
  

 
CONFIGURATION  

 
 

PRINT INFO  
 
 

MENUS  
 
 

ADMIN SETUP  
 
 

PRINT STATISTICS  
 
 

CALIBRATION  
 
 

WIRELESS SETTING  
 
 WIRELESS (AP MODE) 

SETTING  

 
 

BOOT MENU  
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Item Setting Description 
FUSER LIFE REMAINING nnn% Displays the remaining life of the fuser 

unit. 
TONER (n.nK) REMAINING nnn% Displays the remaining life of the toner 

cartridge. 
NETWORK 
(*When the 
Wireless LAN 
Module is not 
installed) 

PRINTER NAME **************** 
*************** 

Displays the machine name. 

SHORT NAME *************** Displays the short name. 
IPV4 ADDRESS xxx.xxx.xxx.xxx Displays the IPv4 address. 
SUBNET MASK xxx.xxx.xxx.xxx Displays the subnet mask. 
GATEWAY ADDRESS xxx.xxx.xxx.xxx Displays the gateway address. 
MAC ADDRESS xx:xx:xx:xx:xx:xx Displays the MAC address. 
NETWORK VERSION xx.xx Displays the version of the network 

firmware of the machine. 
WEB VERSION xx.xx Displays the version of the Web page 

of the machine. 
IPV6 LOCAL xxxx:xxxx:xxxx:xxxx: 

xxxx:xxxx:xxxx:xxxx 
Displays the IPv6 address. 

IPV6 STATELESS xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateless). 

IPV6 STATEFUL xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateful). 

NETWORK 
(*When the 
Wireless LAN 
Module is 
installed) 

NETWORK INFO PRINTER NAME **************** 
*************** 

Displays the machine name. 

SHORT NAME *************** Displays the short name. 
ENABLING DEFAULT 
GATEWAY 

WIRED WIRELESS 
(INFRASTRUCTURE) 

Displays the enabled default gateway. 

WIRED ENABLE 
DISABLE 

Displays whether wired LAN is 
enabled or disabled. 

IPV4 ADDRESS xxx.xxx.xxx.xxx Displays the IPv4 address. 
SUBNET MASK xxx.xxx.xxx.xxx Displays the subnet mask. 
GATEWAY ADDRESS xxx.xxx.xxx.xxx Displays the gateway address. 
MAC ADDRESS xx:xx:xx:xx:xx:xx Displays the MAC address. 
NETWORK VERSION xx.xx Displays the version of the network 

firmware of the machine. 
WEB VERSION xx.xx Displays the version of the Web page 

of the machine. 
IPV6 LOCAL xxxx:xxxx:xxxx:xxxx: 

xxxx:xxxx:xxxx:xxxx 
Displays the IPv6 address. 

IPV6 STATELESS xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateless). 

IPV6 STATEFUL xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateful). 

 
 

Item Setting Description 
 WIRELESS 

(INFRASTRUCTURE) 
INFO 

FW VERSION  Displays the version of the wireless 
LAN firmware. 

WIRELESS 
(INFRASTRUCTURE) 

ENABLE 
DISABLE 

Displays whether wireless 
(infrastructure) is enabled or disabled. 

SSID  Displays the SSID of the connection 
destination. 

SECURITY 
 
*1: Can only be set for 

the Web 
*2: Can only be set for 

the Web 

DISABLE 
WEP 
WPA/WPA2-PSK 
WPA2-PSK 
WPA/WPA2-EAP *1 
WPA2-EAP *2 

Displays the type of security for the 
wireless LAN function. 

STATE STARTED 
SCANNING 
CONNECTED 
DISABLE 

Displays the connection status of 
wireless LAN. 



74  

BAND 2.4 GHz (B) 
2.4 GHz (B+G) 
2.4 GHz (B+G+N) 
2.4 GHz (G) 
2.4 GHz (N) 
2.4 GHz (B/G/N) 
2.4 GHz 
5.0 GHz (A+N) 
5.0 GHz (A) 
5.0 GHz (N) 
5.0 GHz (A/N) 
5.0 GHz 

Displays the bandwidth being used. 

CHANNEL  Displays the channel number being 
used. 

RSSI  Displays the reception signal strength 
as a percentage. 

IPV4 ADDRESS xxx.xxx.xxx.xxx Displays the IPv4 address. 
SUBNET MASK xxx.xxx.xxx.xxx Displays the subnet mask. 
GATEWAY ADDRESS xxx.xxx.xxx.xxx Displays the gateway address. 
MAC ADDRESS xx:xx:xx:xx:xx:xx Displays the MAC address. 
IPV6 LOCAL xxxx:xxxx:xxxx:xxxx: 

xxxx:xxxx:xxxx:xxxx 
Displays the IPv6 address (local). 

IPV6 STATELESS xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateless 
address). 

IPV6 STATEFUL xxxx:xxxx:xxxx:xxxx: 
xxxx:xxxx:xxxx:xxxx 

Displays the IPv6 address (stateful 
address). 

WIRELESS (AP MODE) 
INFO 

WIRELESS (AP 
MODE) 

ENABLE 
DISABLE 

Displays whether wireless (AP mode) 
is enabled or disabled. 

SSID  Displays the SSID of the connection 
destination. 

PASSWORD  Displays the password. 
CONNECTED 
DEVICES 

 Displays the number of connected 
devices. 

IPV4 ADDRESS xxx.xxx.xxx.xxx Displays the IPv4 address. 
SYSTEM SERIAL NUMBER xxxxxxxxxxxxxxxxxx 

xxxxxxxx 
Displays the serial number of the 
printer. 

ASSET NUMBER xxxxxxxxxxxxxxxxxx 
xxxxxxxxxxxxxx 

Displays the asset number of the 
printer. 

LOT NUMBER xxxxxxxxxxxxxxxxxx 
xxxxxxxx 

Displays the lot number of the 
machine. 

FW VERSION xxx.xx_x_x Displays the firmware version. 
CU VERSION xx.xx Displays the firmware version of the 

control unit. 
PU VERSION xx.xx.xx Displays the firmware version of the 

print unit. 
RAM xxMB Displays the size of the RAM in the 

machine. 
FLASH MEMORY xxMB [Fxx] Displays the size of the flash memory 

in the machine. 
 
 

PRINT INFO  
Information related to the device can be printed. 

 
Item Setting Description 

CONFIGURATION EXECUTE Prints information about the printer configuration. 
PRINT FILE LIST EXECUTE Prints a file list. 
PRINT ERROR LOG EXECUTE Prints an error log. 
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MENUS  
Settings related to printing and the operation of the machine. 

 
Item Setting Description 

FEEDER CONFIG PAPER FORM CONTINUOUS PAPER 
CUT PAPER 

Sets the paper format. 

X DIMENSION 1.00 IN / 25.0 MM 
~ 

2.91 IN / 74.0 MM 
~ 

3.40 IN / 86.0 MM 

Sets the paper width. 

Y DIMENSION 2.10 IN / 53.0 MM 
~ 

8.27 IN / 210.0 MM 
~ 

21.70 IN / 551.0 MM 

Sets the paper length. 

MEDIATYPE PLAIN 
USERTYPE1 
USERTYPE2 
USERTYPE3 
USERTYPE4 
USERTYPE5 

Sets the paper type. 
*USERTYPE1 to 5 are displayed if they are 
registered. 

MEDIAWEIGHT LIGHT 
MEDIUM LIGHT 
MEDIUM 
MEDIUM HEAVY 
HEAVY 
ULTRA HEAVY1 
ULTRA HEAVY2 

Sets the paper weight. 

CUT TYPE B/M(FRONT) 
B/M(BACK) 
SIDE HOLE 
CENTER HOLE 
NOTCH 
GAP 
LENGTH 

Set the type of mark used for cutting the 
paper. 

GAP LENGTH 0.12 IN / 3.0 MM 
~ 

0.51 IN / 13.0 MM 

It is not necessary to change this when printing 
on plain paper. 

CUT POSITION SET -0.25 IN / -6.5 MM 
~ 

0.00 IN / 0.0 MM 
~ 

+21.70 IN / +551.0 MM 

Sets the position to cut paper with a black 
mark. 

-0.25 IN / -6.5 MM 
~ 

0.00 IN / 0.0 MM 
~ 

+0.25 IN / +6.5 MM 

Sets the position to cut paper with a hole and 
paper with a gap. 

SENSOR 
CONFIG 

SENSOR CALIBRATION EXECUTE CALIBRATION Adjusts the paper sensors. 
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Item Setting Description 
SYSTEM ADJUST POW SAVE TIME 0 MIN 

1 MIN 
2 MIN 
3 MIN 
4 MIN 
5 MIN 
10 MIN 
15 MIN 
30 MIN 
60 MIN 

Sets the time until the machine enters the 
Power Save mode. 

SLEEP TIME 1 MIN 
2 MIN 
3 MIN 
4 MIN 
5 MIN 
10 MIN 
15 MIN 
30 MIN 
60 MIN 

Sets the time until the machine enters the 
Sleep mode from the Power Save mode. 

AUTO PW OFF TIME 1 HOUR 
2 HOURS 
3 HOURS 
4 HOURS 
8 HOURS 
12 HOURS 
18 HOURS 
24 HOURS 

Sets the time until the power is automatically 
turned off. 

CLRABLE WARNING OK BUTTON 
JOB END 

Sets the timing for erasing warning errors that 
the machine can recover from. 

AUTO CONTINUE ON 
OFF 

Sets whether to automatically recover the 
printer when a memory overflow is displayed. 
The waiting time until recovery is 15 seconds. 

MANUAL TIMEOUT OFF 
30 SEC 
60 SEC 

Sets the time until paper is loaded. 
Printing cannot be performed unless paper is 
loaded within this time. 

TIMEOUT INJOB OFF 
5 SEC 
10 SEC 
20 SEC 
30 SEC 
40 SEC 
50 SEC 
60 SEC 
90 SEC 
120 SEC 
150 SEC 
180 SEC 
210 SEC 
240 SEC 
270 SEC 
300 SEC 

Sets the time until forced printing is performed 
when print data stops being received. 

TIMEOUT LOCAL 0 SEC 
5 SEC 

~ 
40 SEC 

~ 
290 SEC 
295 SEC 
300 SEC 

Sets the time that the ports are left open when 
an operation finishes. (Excluding the network 
ports.) 



77  

Item Setting Description 
 TIMEOUT NET 0 SEC 

5 SEC 
~ 

90 SEC 
~ 

290 SEC 
295 SEC 
300 SEC 

Sets the time that the network ports are left 
open when an operation finishes. 

JAM RECOVERY ON 
OFF 

Sets whether to print the page where a paper 
jam occurred again. 
When this is set to OFF, the remaining pages 
are not printed, including the page where the 
paper jam occurred. 

ERROR REPORT ON 
OFF 

Sets whether to print an error report when an 
error occurs in the printer. 

HEX DUMP EXECUTE Prints a hex dump of the received data as a 
QR code. 
When the power of the printer is turned off, the 
printer returns to the regular print mode. 
Communication cannot be performed with the 
status monitor, etc. while printing in the dump 
format. 

PRINT ADJUST POSITION ADJUST X ADJUST 0.00 MM 
+0.25 MM 

~ 
+2.00 MM 
-2.00 MM 

~ 
-0.25 MM 

Corrects the position of the entire print image 
in the direction perpendicular to the feed 
direction of the paper. Set in increments of 
0.25 mm. 

Y ADJUST 0.00 MM 
+0.25 MM 

~ 
+2.00 MM 
-2.00 MM 

~ 
-0.25 MM 

Corrects the position of the entire print image 
in the feed direction of the paper. Set in 
increments of 0.25 mm. 

PAPER COLOR SET 0 
+1 
+2 
-2 
-1 

Performs fine adjustment when faint white 
dots or other visual problems occur in the print 
results. 
Lower the setting when there are faint white 
dots occur and raise the setting when high 
density areas become lighter. 

SMR SETTING YELLOW 0 
+1 
+2 
+3 
-3 
-2 
-1 

Corrects uneven printing due to differences 
in the print density/print frequency or 
temperature/humidity. Change the yellow 
setting when the image is uneven. 

MAGENTA 0 
+1 
+2 
+3 
-3 
-2 
-1 

Corrects uneven printing due to differences 
in the print density/print frequency or 
temperature/humidity. Change the magenta 
setting when the image is uneven. 

CYAN 0 
+1 
+2 
+3 
-3 
-2 
-1 

Corrects uneven printing due to differences 
in the print density/print frequency or 
temperature/humidity. Change the cyan setting 
when the image is uneven. 
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Item Setting Description 
 BG SETTING 0 

+1 
+2 
+3 
-3 
-2 
-1 

Corrects uneven printing due to differences 
in the print density/print frequency or 
temperature/humidity. Change this value when 
the background is dense. 

DRUM CLEANING ON 
OFF 

Set ON to reduce white horizontal streaks that 
appear in the print results. The lifetime of the 
image drum unit is shorter when this is set to 
ON. 

HIGH HUM. MODE OFF 
ON 

Set ON when the printed paper curls greatly. 

NARROW PAPER SPEED NORMAL 
MODE1 

Sets the print speed of narrow paper. 
NORMAL: The print speed is not switched 
when printing on narrow paper. 
*If temperature adjustment occurs, the 
machine operates at low speed until printing 
stops. 
MODE1: The print speed is switched to low 
speed when printing on narrow paper. 

 
 
 

  ADMIN SETUP  
The settings for the administrator of the machine. A password is required to enter this menu. 

 
Item Setting Description 

Password ****** Enter the password for the administrator menu. 
The default password is "999999." 

NETWORK 
SETUP 

ENABLING DEFAULT 
GATEWAY 

WIRED 
WIRELESS 
(INFRASTRUCTURE) 

Sets whether to use the default gateway of the wired LAN or wired 
LAN interface. 
This item is only displayed when [WIRELESS MODULE] is set to 
[ENABLE]. 

WIRED ENABLE 
DISABLE 

Sets whether to enable or disable wired LAN. 

TCP/IP ENABLE 
DISABLE 

Sets whether to enable or disable the TCP/IP protocol. 

NETBIOS OVER TCP ENABLE 
DISABLE 

Sets whether to enable or disable the NETBEUI protocol. 

IP ADDRESS SET AUTO 
MANUAL 

Sets the method for setting the IP address. 

IPV4 ADDRESS xxx.xxx.xxx.xxx 
◆ With a cable attached 
169.254.XXX.XXX 
◆ Without a cable 
attached 
192.168.100.100 

Sets the IP address. 

SUBNET MASK xxx.xxx.xxx.xxx Sets the subnet mask. 
GATEWAY ADDRESS xxx.xxx.xxx.xxx Sets the gateway address (default gateway). 

0.0.0.0 means that there is no router. 
DHCPV6 ENABLE 

DISABLE 
Sets whether to enable or disable DHCPv6. 

WEB ENABLE 
DISABLE 

Sets whether to enable or disable WEB. 

TELNET ENABLE 
DISABLE 

Sets whether to enable or disable TELNET. 

FTP ENABLE 
DISABLE 

Sets whether to enable or disable FTP. 

IPSEC DISABLE Disables IPSec. 
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Item Setting Description 
 SNMP ENABLE 

DISABLE 
Sets whether to enable or disable SNMP. 

NETWORK SCALE NORMAL 
SMALL 

NORMAL: Operates efficiently even when connected to a hub 
with the spanning tree function. However, the printer startup time 
may become longer when connected to a small LAN with two or 
three computers. 
SMALL: Supports a small LAN with two or three computers up to 
a large LAN. May not operate efficiently when connected to a hub 
with the spanning tree function. 

HUB LINK SETTING AUTO NEGOTIATE 
100BASE-TX FULL 
100BASE-TX HALF 
10BASE-T FULL 
10BASE-T HALF 

Sets the method for connecting to hubs. 
AUTO: Automatically selects a connection method and tries 
connecting to all hubs. 
Other items: Only tries connecting to hubs using the set 
connection method. 

FACTORY DEFAULTS EXECUTE Restores the default network settings. 
USB SETUP USB ENABLE 

DISABLE 
Sets whether to enable or disable the USB interface. 

SPEED 480 Mbps 
12 Mbps 

Sets the maximum transfer speed for the USB interface. 

SOFT RESET ENABLE 
DISABLE 

Sets whether to enable or disable the Soft Reset command. 

SERIAL NUMBER ENABLE 
DISABLE 

Sets whether to enable or disable the USB serial number. 
The USB serial number is used to identify USB devices connected 
to a computer. 

CONNECTED HOST NORMAL 
SPECIFIC 

Specific: Enables printing from a specific computer connected via 
USB. 

PRINT 
SETUP 

COPIES 1 
~ 
999 

Sets the number of copies. 
The number of copies setting is disabled when printing information 
related to the machine. 

MEDIA CHECK ENABLE 
DISABLE 

Sets whether to check whether the paper size of the print data 
matches the paper size set in the machine. 
ENABLE: Detects a paper size error when the paper length is 
17.5 mm or more shorter than the actual paper. 
DISABLE: Does not detect a paper size error. 

EDGE TO EDGE ON 
OFF 

Sets whether to expand the print area. 
ON: Sets the margin (unprintable area) to approximately 2 mm. 
OFF: Sets the margin to approximately 4.2 mm. 

RESOLUTION 600 DPI 
1200 DPI 

Sets the resolution for printing. 

TONER SAVE OFF 
LOW 
MIDDLE 
HIGH 

Sets the amount of toner to save. 
When set to OFF, toner is not saved. 

ORIENTATION PORTRAIT 
LANDSCAPE 

Sets the print orientation. 

EDIT SIZE FEEDER SIZE 
CUSTOM 

Sets the area to print when the paper size is not specified in the 
print data. 
FEEDER SIZE: Uses the value set in [MENUS] > [FEEDER 
CONFIG] > [X DIMENSION] / [Y DIMENSION]. 
CUSTOM: Uses the value set in the following [X DIMENSION] / 
[Y DIMENSION]. 

X DIMENSION 1.00 IN / 25.0 MM 
~ 

2.91 IN / 74.0 MM 
~ 

3.40 IN / 86.0 MM 

Sets the default paper width for custom paper. 
The paper width is the length perpendicular to the paper feed 
direction. 

Y DIMENSION 2.10 IN / 53.0 MM 
~ 

8.27 IN / 210.0 MM 
~ 

21.70 IN / 551.0 MM 

Sets the default paper length for custom paper. 
The paper length is the length in the same direction as the paper 
feed direction. 
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BARCODE ADJUST OFF 
ON1 
ON2 

Adjusts the line width of barcodes. 
ON1: Makes barcodes one dot thinner than the standard line 
width. 
ON2: Makes barcodes two dots thinner than the standard line 
width. 

 
 
 

Item Setting Description 
 PRESENTER MODE OFF 

MODE1 
MODE2 

Configures paper output. 
OFF: Outputs paper with the regular output method. 
MODE1: Retains the paper with the Presenter Unit and prints the 
next page when the paper is pulled out. 
MODE2: Retains the paper with the Presenter Unit and prints the 
next page when print data exists. 
*Displayed when [PRESENTER UNIT] is set to [ENABLE]. 

COLOR 
MENU 

CMY100% DENSITY ENABLE 
DISABLE 

Selects whether to use halftones when outputting in 100% C, M, 
or Y. 

PCL SETUP FONT SOURCE RESIDENT 
DOWNLOADED 

Sets the location of the PCL fonts. 
DOWNLOADED is displayed when software fonts have been 
downloaded to RAM permanently. 

FONT NO. I0 
~ 
I30 

Sets the PCL font number. 

FONT PITCH 0.44 CPI 
~ 
10.00 CPI 
~ 
99.99 CPI 

Sets the width of the PCL default font. Set in characters per inch 
(fixed pitch scalable font by default). 

FONT HEIGHT 4.00 POINT 
~ 
12.00 POINT 
~ 
999.75 POINT 

Sets the height of the PCL default font. The value is displayed in 
increments of 0.25 point. 
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SYMBOL SET PC-8 
PC-8 Dan/Nor 
PC-8 Grk 
PC-8 TK 
PC-775 
PC-850 
PC-851 Grk 
PC-852 
PC-855 
PC-857 TK 
PC-858 
PC-862 Heb 
PC-864 L/A 
PC-866 
PC-866 Ukr 
PC-869 
PC-1004 
Pi  Font 
Plska Mazvia 
PS Math 
PS Text 
Roman-8 
Roman-9 
Roman Ext 
Serbo Croat1 
Serbo Croat2 
Spanish 
UCS-2 
Ukrainian 
VN Int'l 
VN Math 
VN US 
Win 3.0 
Win 3.1 Arb 
Win 3.1 L/G 
Win 3.1 Blt 
Win 3.1 Cyr 
Win 3.1 Grk 
Win 3.1 Heb 
Win 3.1 L1 
Win 3.1 L2 
Win 3.1 L5 

Sets the PCL symbol set. 
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Item Setting Description 
  Wingdings  

Dingbats MS 
Symbol 
OCR-A 
OCR-B 
OCRB Subset2 
HP ZIP 
USPSFIM 
USPSSTP 
USPSZIP 
Arabic-8 
Bulgarian 
CWI Hung 
DeskTop 
German 
Greek-437 
Greek-437 Cy 
Greek-737 
Greek-8 
Greek-928 
Hebrew NC 
Hebrew OC 
Hebrew-7 
Hebrew-8 
IBM-437 
IBM-850 
IBM-860 
IBM-863 
IBM-865 
ISO Dutch 
ISO L1 
ISO L2 
ISO L4 
ISO L5 
ISO L6 
ISO L9 
ISO Swedish1 
ISO Swedish2 
ISO Swedish3 
ISO-2 IRV 
ISO-4 UK 
ISO-6 ASC 
ISO-10 S/F 
ISO-11 Swe 
ISO-14 JASC 
ISO-15 Ita 
ISO-16 Por 
ISO-17 Spa 
ISO-21 Ger 
ISO-25 Fre 
ISO-57 Chi 
ISO-60 Nor 
ISO-61 Nor 
ISO-69 Fre 
ISO-84 Por 
ISO-85 Spa 
ISO-Cyr 
ISO-Grk 
ISO-Hebrew 
Kamenicky 
Legal 
Math-8 
MC Text 
MS Publish 
PC Ext D/N 
PC Ext US 
PC Set1 
PC Set2 D/N 
PC Set2 US 
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Item Setting Description 
 WHITE PAGE SKIP ON 

OFF 
Selects whether to print blank pages. 
ON: Do not print blank pages 
OFF: Print blank pages 

CR FUNCTION CR 
CR+LF 

Sets the operation to take when a CR code is received. 
CR: Return 
CR+LF: Return and line feed 

LF FUNCTION LF 
LF+CR 

Sets the operation to take when an LF code is received. 
LF: Line feed 
LF+CR: Line feed and return 

PRINT MARGIN NORMAL 
1/5 INCH 
1/6 INCH 
1/12.5 INCH 

Sets the unprintable area of the paper. 

PEN WIDTH ADJUST ON 
OFF 

Sets whether to enhance thin lines so they look thicker. 

PANEL 
SETUP 

NEARLIFE STATUS ENABLE 
DISABLE 

Sets whether to display a message when a near life warning has 
occurred. 
ENABLE: Display a near life warning. 
DISABLE: Do not display a near life warning. 

NEARLIFE LED ENABLE 
DISABLE 

Sets whether to light up the LED when a near life warning has 
occurred. 
ENABLE: Light up the LED. 
*For the image drum unit, lights up when [PANEL SETUP] > 
[NEARLIFE STATUS] is set to [ENABLE]. 
DISABLE: Do not light up the LED. 

BUZZER 
SETUP 

ERROR VOLUME OFF 
LOW 
HIGH 

Sets the buzzer volume when an error has occurred in the 
machine. 

PRINT COMPLETION 
VOLUME 

OFF 
LOW 
HIGH 

Sets the buzzer volume when printing is completed. 

PRINT COMPLETION 
BUZZER 

PAGE END 
JOB END 

Sets the timing for sounding the buzzer when printing is 
completed. 
Displayed when [PRINT COMPLETION VOLUME] is set to [LOW] 
or [HIGH]. 
PAGE END: The buzzer sounds each time printing of one page is 
complete. 
JOB END: The buzzer sounds when printing of all pages of the 
print data is complete. 

POWER 
SETUP 

AUTO PW OFF ENABLE 
AUTO CONFIG 
DISABLE 

Set the Auto Power Off operation. 
ENABLE: The machine enters the Auto Power Off mode even 
when connected via a LAN cable. 
AUTO CONFIG: The machine does not enter the Auto Power Off 
mode when connected via a LAN cable. The machine also does 
not enter the Auto Power Off mode when the wireless LAN of a 
USB host is connected and wireless LAN is enabled. The machine 
enters the OFF mode when connected via USB. 
DISABLE: The power does not automatically turn off. 

FEEDER 
SETUP 

UNIT OF MEASURE INCH 
MILLIMETER 

Specifies the unit for custom paper sizes. 
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Item Setting Description 
OTHERS 
SETUP 

RAM 
SETUP 

RECEIVE 
BUF SIZE 

AUTO 
0.5 MB 
1  MB 
2  MB 
4  MB 
8 MB 
16 MB 
32 MB 

Sets the reception buffer size to secure for the local interface. 
Normally, [AUTO] is used. 
When memory overflow errors occur, lowering this setting may 
improve the problem. 
The setting can also be raised to shorten the release time on the 
computer side. 

FLASH 
SETUP 

FLASH 
INITIALIZE 

EXECUTE Initializes the flash memory. 
The downloaded demo data, etc. displayed in the file list is 
deleted. 

STORAGE 
SETUP 

ENABLE 
INITIAL 

NO 
YES 

Prevents setting changes resulting from initialization of the flash 
memory. 

LANGUAGE 
SETUP 

LANGUAGE 
SELECT 

CATALAN 
CZECH 
DANISH 
DUTCH 
ENGLISH 
FINNISH 
FRENCH 
GERMAN 
HUNGARIAN 
ITALIAN 
JAPANESE 
NORWEGIAN 
POLISH 
PORTUGUESE 
PORTUGUESE 
(BRAZIL) 
SPANISH 
SWEDISH 
TURKISH 

Selects the language displayed on the LCD. 
However, machine information such as reports is printed in 
English. 

LANGUAGE 
INITIALIZE 

EXECUTE Initializes the downloaded user language message file. 

JOB 
CANCEL 
SETUP 

CANCEL 
KEY 
BEHAVIOR 

SHORT 
LONG 
OFF 

Sets the operation performed when the job cancel button is 
pressed. 
SHORT: Execute job cancellation with a short press (2 seconds or 
less). 
LONG: Execute job cancellation with a long press (2 to 5 
seconds). 
OFF: Ignore presses of the job cancel button. In other words, 
disable job cancellation by pressing the job cancel button. 

INQUIRY 
DISPLAY 

ON 
OFF 

Sets whether to display the query screen when job cancellation is 
executed. 
ON: Display the query screen. 
OFF: Execute job cancellation without displaying the query 
screen. 

FOCUS 
POSITION 

YES 
NO 

Sets whether to place the focus on [YES] or [NO] on the query 
screen for job cancellation. 
YES: Place the focus on [YES]. 
NO: Place the focus on [NO]. 

DISPLAY 
TIMEOUT 

60 
to 
180 
to 
300 

Sets the timeout value for the query screen when job cancellation 
is executed. When a timeout occurs, printing is executed with the 
cancellation operation disabled. 
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Item Setting Description 
 NEARLIFE 

SETUP 
DRUM 
NEARLIFE 

500 
1000 
1500 
2000 
2500 
3000 
3500 
4000 
4500 
5000 

Sets the timing for displaying the near life warning for the image 
drum unit. 
Displays the near life warning for the image drum unit in front of 
the selected value for the image drum unit lifetime. 

FUSER 
NEARLIFE 

500 
1000 
1500 
2000 
2500 
3000 
3500 
4000 
4500 
5000 

Sets the timing for displaying the near life warning for the fuser 
unit. 
Displays the near life warning for the fuser unit in front of the 
selected value for the fuser unit lifetime. 

BELT 
NEARLIFE 

500 
1000 
1500 
2000 
2500 
3000 
3500 
4000 
4500 
5000 

Sets the timing for displaying the near life warning for the transfer 
belt unit. 
Displays the near life warning for the transfer belt unit in front of 
the selected value for the transfer belt unit lifetime. 

ERASE PRIVACY DATA EXECUTE The following data set in the machine is erased. 
• Administrator password, values set for menus 
• Data registered in the machine 

PRESENTER UNIT DISABLE 
ENABLE 

Sets whether to enable or disable the Presenter Unit. 
ENABLE: Attached 
DISABLE: Not attached 
Match this setting with the status of the Presenter Unit. 
Paper jams will occur if the setting does not match. 

SETTINGS MENU RESET EXECUTE Resets the default menu settings of the machine. 
SAVE MENU EXECUTE Saves the current menu settings. 

The menu is overwritten with that saved at the time of last 
execution. 

RESTORE MENU EXECUTE Changes the menu to the sved menu settings. 
Displayed when [SAVE MENU] has been executed to save the 
menu settings. 
Disabled when executed when the machine has print data. 

CHANGE 
PASSWORD 

NEW PASSWORD ************ Sets the new password for entering [ADMIN SETUP] and [BOOT 
MENU]. 
The password is set using 6 to 12 numbers or lower case letters. 

VERIFY PASSWORD ************ Enter the new password set in [NEW PASSWORD] again for 
confirmation purposes. 
The password is set using 6 to 12 numbers or lower case letters. 
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  PRINT STATISTICS  
Settings related to print statistics. 

 
Item Setting Description 

USAGE REPORT ENABLE 
DISABLE 

Sets whether to enable or disable the print statistics function. 
The device restarts if this setting is changed. 

RST MAIN CNT EXECUTE Resets the main counter. 
CHANGE 
PASSWORD 

NEW PASSWORD **** Sets the new password for entering [PRINT STATISTICS]. 
The password is set using a 4 digit number. 

VERIFY PASSWORD **** Enter the new password set in [NEW PASSWORD] again for confirmation 
purposes. 

 
 
 

  CALIBRATION  
Settings related to color. 

 
Item Setting Description 

DENSITY CONTROL FULL 
QUICK 
MANUAL 

Sets whether to automatically perform density correction. 
FULL: Automatically perform density correction. 
QUICK: Automatically perform density correct when the printer 
deems it necessary. 
MANUAL: Do not automatically perform density correction. 

ADJUST DENSITY EXECUTE Executes density correction. 
Execute it when the printer is in standby. 

COLOR TUNING PRINT PATTERN Prints a color tuning pattern. 
CYAN TUNING CYAN HIGHLIGHT 0 

+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the cyan highlights (light areas). 
Positive values are darker and negative values are lighter. 

CYAN MID-TONE 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the cyan intermediate areas. 
Positive values are darker and negative values are lighter. 

CYAN DARK 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the cyan dark areas. 
Positive values are darker and negative values are lighter. 
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Item Setting Description 
MAGENTA TUNING MAGENTA 

HIGHLIGHT 
0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the magenta highlights (light areas). 
Positive values are darker and negative values are lighter. 

MAGENTA MID- 
TONE 

0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the magenta intermediate areas. 
Positive values are darker and negative values are lighter. 

MAGENTA DARK 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the magenta dark areas. 
Positive values are darker and negative values are lighter. 

YELLOW TUNING YELLOW 
HIGHLIGHT 

0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the yellow highlights (light areas). 
Positive values are darker and negative values are lighter. 

YELLOW MID- 
TONE 

0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the yellow intermediate areas. 
Positive values are darker and negative values are lighter. 

YELLOW DARK 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the yellow dark areas. 
Positive values are darker and negative values are lighter. 

COLOR DENSITY CYAN DENSITY 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the cyan density. 
Positive values are darker and negative values are lighter. 
This setting is enabled when printing after density correction is 
executed. 

MAGENTA 
DENSITY 

0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the magenta density. 
Positive values are darker and negative values are lighter. 
This setting is enabled when printing after density correction is 
executed. 

YELLOW DENSITY 0 
+1 
+2 
+3 
-3 
-2 
-1 

Adjusts the yellow density. 
Positive values are darker and negative values are lighter. 
This setting is enabled when printing after density correction is 
executed. 

ADJUST REGISTRATION EXECUTE When this menu is selected, the printer executes automatic color shift 
correction. Execute this when the machine is idle. 
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  WIRELESS SETTING  
Settings related to wireless LAN. 

 
Item Setting Description 

WIRELESS (INFRASTRUCTURE) ENABLE 
DISABLE 

Sets whether wireless (infrastructure) is enabled or 
disabled. 

NETWORK 
SETTING 

IP ADDRESS SET AUTO 
MANUAL 

Sets the method for setting the IP address. 

IPV4 ADDRESS xxx.xxx.xxx.xxx Sets the IP address. 
SUBNET MASK xxx.xxx.xxx.xxx Sets the subnet mask. 
GATEWAY ADDRESS xxx.xxx.xxx.xxx Sets the gateway address (default gateway). 
DHCPV6 ENABLE 

DISABLE 
Sets DHCPv6. 

WPS SETUP WPS-PBC  Executes WPS-PBC. 
WPS-PIN  Executes WPS-PIN. 

WIRELESS 
SELECTION 

xxxxxx 
...... 

 Lists the wireless APs that have been detected. 

MANUAL 
SETUP 

SSID  Enter an SSID. 
SECURITY 
 
*1: Can only be set for 

the Web 
*2: Can only be set for 

the Web 

DISABLE 
WEP 
WPA/WPA2-PSK 
WPA2-PSK 
WPA/WPA2-EAP *1 
WPA2-EAP *2 

Sets the security for the wireless LAN function. 

WEP KEY  Enter the WEP Key. 
WPA ENCRYPTION 
TYPE 

AES 
TKIP/AES 

Displays the WPA-PSK encryption method. 
A unique value is determined by the security settings. (It 
cannot be switched with this menu.) 

WPA PRE-SHARED 
KEY 

 Enter the pre-shared Key. 

EXECUTE  Executes the changes to the security settings. 
RECONNECTION EXECUTE Wireless LAN reconnection will be executed. 

 
 
 

  WIRELESS (AP MODE) SETTING  
Settings related to wireless LAN. 

 
Item Setting Description 

WIRELESS(AP MODE) ENABLE 
DISABLE 

Sets whether wireless (AP mode) is enabled or disabled. 

AUTOMATIC SETUP (PUSHBUTTON)  When YES is selected, automatic connection via a push button is 
started. 
If the connection fails, the machine returns to the previous screen. If it 
succeeds, 

SUCCEEDED PRESS OK 
is displayed. 

MANUAL SETUP SSID  Displays the SSID. 
PASSWORD  Displays the password. 

CONNECTION 
SETTING 

SSID  Enter an SSID. 
PASSWORD  Enter the password. 
IPV4 ADDRESS xxx.xxx.xxx.xxx Enter the IP address. 
EXECUTE  Starts connecting. 

AP MODE USER SETTING ENABLE 
DISABLE 

Sets whether to disclose the AP mode information to people other than 
the administrator. 
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  BOOT MENU  
Perform the following operation to display the BOOT MENU. 

1. If the machine is on, turn it off. 

2. Turn the machine on while holding «OK» button on the operation panel. Hold 
«OK» button until [BOOT MENU] is displayed on the screen. 

3. When [BOOT MENU] is displayed, release your finger and press «OK» button again. 

4. When the screen for entering the password is displayed, enter the password. The 
password is the same as that used to enter the [ADMIN SETUP] menu for the 
administrator. 

 
Item Setting Description 

WIRELESS MODULE ENABLE 
DISABLE 

Enables the wireless LAN board. 
When set to ENABLE, the setting is retained even when the wireless LAN 
board is removed. 

MENU LOCKOUT ON 
OFF 

Sets the menu lockout function. 
ON: The menu is not displayed. 
OFF: The menu is displayed. 

PANEL LOCKOUT MODE1 
MODE2 
OFF 

Sets the panel lockout function. 
MODE1: The «ONLINE», «OK», «CANCEL», «POWER SAVE», and 
«FEED/CUT» buttons can be used, but other buttons are disabled. 
MODE2: The «ONLINE», «OK», «POWER SAVE», and «FEED/ 
CUT»buttons can be used, but other buttons are disabled. 
OFF: All buttons are disabled. 

MENU OPERATION 
SETUP 

UP/DOWN KEY NORMAL TYPE 
OLD TYPE 

Sets the operation performed when «∧» button or «∨» button is pressed 
when selecting a category/item/value in a menu. 
NORMAL TYPE: When «∧» button is pressed, the machine returns to the 
previous item (up in the displayed list). When «∨» button is pressed, the 
machine moves to the next item (down in the displayed list). 
OLD TYPE: When «∧» button is pressed, the machine moves to the 
next item (down in the displayed list). When «∨» button is pressed, the 
machine returns to the previous item (up in the displayed list). 
 
A confirmation message is displayed when this setting is changed. 
When [YES] is selected, the setting is changed and the machine restarts. 

POWER RETURN ALWAYS ON 
ALWAYS OFF 
LAST STATE 

Sets the power supply method when the machine recovers from a power 
failure. 
ALWAYS ON: The machine restarts when the power supply resumes. 
ALWAYS OFF: The power needs to be turned on manually. 
LAST STATE: The state before the power failure is resumed. 

SENSOR RESET EXECUTE Resets the calibration values of the paper sensors. 
The paper sensor calibration values calibrated by executing [MENUS] > 
[SENSOR CONFIG] > [SENSOR CALIBRATION] are reset. 
*Execute this menu operation if the "OPEN TOP COVER/380:PAPER 
JAM" error occurs after executing [SENSOR CALIBRATION] and the error 
is not cleared when the machine is restarted. If paper sensor adjustment 
is required after executing this menu operation, execute [SENSOR 
CALIBRATION] again. 
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 Loading Paper 
 

Available Paper Sizes 
Paper Storage 
Flow of Loading Paper 
Setting Paper Information on the Operation Panel 
Setting the Paper Sensors 
Attaching the Guide Ribs 
Loading Paper 
Feeding the Paper 

5 
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Available Paper Sizes 

• Paper Format 
 

Paper Format Description 
Continuous Paper Paper wound into a roll or paper folder along a perforation 

Cut Sheet Paper cut into rectangles in the range of 25 mm to 86 mm 
width and 53 mm to 551 mm length 

 
• Paper Type 

 

Paper Type Description 
Plain Paper Wood-free paper 

 

• Types of Marks Used for Cutting Paper 
 

• Paper without a mark is cut at the specified length. 
 
 

Mark Type Description 
Black Mark Mark position: Paper front or back 
Hole  
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  Paper Specifications  

• Continuous Paper: Without Mark 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paper Thickness 0.080 to 0.250 mm 
Paper Width A 25 to 86 mm 
Cut Length F 53 to 551 mm 
Side margin a 4.2 mm 

b 2 mm 
Top margin c 4.2 mm 

d 2 mm 
Bottom margin e 6.3 mm 

f 2 mm 
Paper Format Setting CONTINUOUS PAPER 
Cut Type Setting LENGTH 
Usage Conditions  

Guaranteed Print Range  

Printable Range B Maximum 80 mm 

 

 

 

B Printable Range 
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• Continuous Paper: With Black Mark 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paper Thickness 0.080 to 0.250 mm 
Paper Width A 25 to 86 mm 
Cut Length F 53 to 551 mm 
Side margin a 4.2 mm 

b 2 mm 
Top margin c 4.2 mm 

d 2 mm 
Bottom margin e 6.3 mm 

f 2 mm 
Black Mark Width H 9 mm or more 
Black Mark Length I 2.5 to 13 mm 
Black Marks Pitch J 53 to 551 mm 
Cut Position K -6.5 to length of Black Marks Pitch (J) 
Unprintable Range for Pre-printing In order to prevent misdetection of the black mark, do not 

print around the mark. 
Paper Format Setting CONTINUOUS PAPER 
Cut Type Setting When the black mark is on the front: B/M(FRONT) 

When the black mark is on the back: B/M(BACK) 
Usage Conditions Use black marks printed in carbon. 
Guaranteed Print Range  

Printable Range B Maximum 80 mm 
 

 

 

 

B Printable Range 
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• Continuous Paper: With Holes 

                            With holes in the paper center                                Without holes in the paper center 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paper Thickness 0.080 to 0.250 mm 
Paper Width A 36 to 86 mm 
Cut Length F 53 to 551 mm 
Side margin a 4.2 mm 

b 2 mm 
Top margin c 4.2 mm 

d 2 mm 
Bottom margin e 6.3 mm 

f 2 mm 
Hole margin g 2 mm or more 
Hole Width H 7 mm or more 
Hole Length I With holes in the paper center: 1.6 to 5 mm 

Without holes in the paper center: 1.6 to 13 mm 
Hole Pitch J 53 to 551 mm 
Paper Center Separation 
Distance Right Side 

P(R) 3.5 to 36 mm 

Paper Center Separation 
Distance Left Side 

P(L) 3.5 to 29 mm 

Paper Format Setting CONTINUOUS PAPER 
Cut Type Setting With holes in the paper center: CENTER HOLE 

Without holes in the paper center: SIDE HOLE 

 

 B Printable Range 
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Usage Conditions When there is a hole in the center of the paper, set [Bottom 
margin] to a value equal or above the size of the hole. 
When there is not a hole in the center of the paper, set [Top 
margin] and [Bottom margin] to a value equal or above half 
the size of the hole. 

Guaranteed Print Range  

Printable Range B Maximum 80 mm 
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• Cut Sheet 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paper Thickness 0.060 to 0.250 mm 
Paper Width A 25 to 86 mm 
Cut Length F 53 to 551 mm 
Side margin a 4.2 mm 

b 2 mm 
Top margin c 4.2 mm 

d 2 mm 
Bottom margin e 6.3 mm 

f 2 mm 
Paper Format Setting CUT PAPER 
Cut Type Setting  

Usage Conditions  

Guaranteed Print Range  

Printable Range B Maximum 80 mm 

 

 

 

B Printable Range 
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• Roll Paper 
 

Outer Wind Diameter 203.2 mm or less 
Wind Core Inner Diameter 50.8 mm 
Wind Core Outer Diameter Not specified 
Printed Surface Outer surface only 

 
 

• Paper with Perforation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Paper Thickness 0.060 to 0.250 mm 
Cut position V 1.5 mm or more 

 
 
 

• When cutting paper with perforation, cut the paper at a position at least 1.5 mm away from the 
perforation. 
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Paper Storage 
Store paper under the following conditions to maintain quality. 

• In a dark, dry, and flat location such as inside a cabinet. 

• On a flat surface 

• Temperature: 20°C 

• Humidity: 50% RH (relative humidity) 
 
 

Do not store paper in places such as the following: 

• Directly on the floor 

• In a location exposed to direct sunlight 

• Near the inside of an exterior wall 

• On an uneven surface 

• Where static electricity may be generated 

• Where temperature may become excessively high or change rapidly 

• Near a photocopier, air conditioner, heater, or duct 
 
 

• Do not open the package of the paper until ready to use the paper. 

• Do not leave paper unwrapped for a long period. Doing so may result in printing problems. 

• Reduced print quality or paper curling may occur due to the paper type, usage conditions, or storage 
conditions. 



100  

Flow of Loading Paper 
 
 

Setting Paper Information to the Machine For details, refer to "Setting Paper 
Information on the Operation Panel". 

  

Setting the Paper Sensors 
 

For details, refer to "Setting the Paper 
Sensors". 

  

Attaching the Guide Ribs 
 

For details, refer to "Attaching the Guide 
Ribs". 

  

Loading Paper 
 

For details, refer to "Loading Paper". 

 
 

When loading of the paper is complete, start printing. 
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Setting Paper Information on the Operation Panel 
Use the operation panel to set the information for the paper to use to the machine. 

Set the information in the following order: paper format → paper size → paper weight → cut type 
→ cut position 

 
• Paper Format 

For roll paper or continuous paper folded along a perforation, set [CONTINUOUS 
PAPER]. For paper cut into rectangles, set [CUT PAPER]. 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Press «∧» button or «∨» button several times to display [MENUS], and press 
«OK» button. 

 

3 Press «∧» button or «∨» button to display [FEEDER CONFIG], and press 
«OK» button. 

4 Press «∧» button or «∨» button to display [PAPER FORM], and press «OK» button. 

5 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

 

6 Confirm that the setting stops flashing and "*" is displayed to the right of the value 
you want to set. 

• Paper Size 
You can set 25.0 mm to 86.0 mm (1.00 inches to 3.40 inches) for the width and 3.0 mm to 551 mm 
(2.10 inches to 21.70 inches) for the length. 

7 Press «∨» button once to display [X DIMENSION], and press «OK» button. 

8 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

 

9 Confirm that the setting stops flashing and "*" is displayed to the right of the value 
you want to set. 

10 Press «∨» button once to display [Y DIMENSION], and press «OK» button. 

11 With the setting flashing, press «∧» button or «∨» button to display the value you want to 
set, and press «OK» button. 

 

12 Confirm that the setting stops flashing and "*" is displayed to the right of the value you 
want to set. 
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• Paper Weight 
Set the weight of the paper to use. You can set LIGHT, MEDIUM LIGHT, 
MEDIUM, MEDIUM HEAVY, HEAVY, ULTRA HEAVY1, ULTRA HEAVY2. 

13 Press «∨» button once to display [MEDIAWEIGHT], and press «OK» button. 

14 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

 

15 Confirm that the setting stops flashing and "*" is displayed to the right of the value 
you want to set. 

 

• Cut Type 
Set the type of mark used for cutting the paper. Set it according to the paper to use. When the paper has a 
black mark on the surface that is printed on: B/M(FRONT) When the paper has a black mark on the surface 
that is not printed on: B/M(BACK) For paper with a hole in the center: CENTER HOLE 
For paper without a hole in the center: SIDE HOLE for paper without a mark: LENGTH 

16 Press «∨» button once to display [CUT TYPE], and press «OK» button. 

17 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

 

18 Confirm that the setting stops flashing and "*" is displayed to the right of the value 
you want to set. 

19 If you set [LENGTH], proceed to step 23. 
If you set something other than [LENGTH], proceed to step 20. 

 

• Cut Position 
This setting specifies the cut position of paper with a black mark or hole. When set to 0 mm, the paper is cut 
at the center of the black mark or hole. The values that can be set are indicated below. 
Paper with a black mark: -6.5 mm (-0.25 inches) to the paper length Paper with a hole: -6.5 mm to 6.5 mm (-
0.25 inches to 0.25 inches) 

 

• Generally, set this to 0 mm when printing on paper with a hole. If the paper cannot be cut in 

the center of the hole, change the setting. 

20 Press «∨» button twice to display [CUT POSITION SET], and press «OK» button. 

21 With the setting flashing, press «∧» button or «∨» button to display the value 
you want to set, and press «OK» button. 

22 Confirm that "*" is displayed to the right of the value you want to set. 

23 Press «ONLINE» button, or press «BACK» button until "READY TO PRINT" is 
displayed. 
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Setting the Paper Sensors 
 

Checking the Paper Sensor Position  
The position for setting the paper sensors differs according to the paper to use. Adjust the 
paper sensors while checking the position based on the table below. 

 

• A paper jam will be incorrectly detected if the sensor position and cut type setting of the 

machine do not match. In this case, change the position of the top sensor and bottom 

sensor so that they do not overlap if their positions were matching or to match if their 

positions were overlapped. 
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Supported 
Paper Type 

Sensor Position 
Printer Driver or Operation Panel Setting* 

PAPER FORM CUT TYPE GAP LENGTH 
Paper with black 
mark on the 
front 

Top: Position of black mark 
Bottom: Position that does not 

overlap with the black mark 
on the front 

 

 

CONTINUOUS 
PAPER 

B/M(FRONT) - 

Paper with black 
mark on the 
back 

Top: Position that does not overlap 
with the black mark on the 
back 

Bottom: Position of black mark 
 

 

CONTINUOUS 
PAPER 

B/M(BACK) - 

Paper with holes Top: Position of hole 
Bottom: Position of hole 

 

 

CONTINUOUS 
PAPER 

SIDE HOLE 
CENTER HOLE 

- 



105  

Supported 
Paper Type 

Sensor Position 
Printer Driver or Operation Panel Setting* 

PAPER FORM CUT TYPE GAP LENGTH 
Paper without 
mark 
 
 
 

 

Top: Position that does not overlap 
with the bottom sensor 

Bottom: Center 
 

 

CONTINUOUS 
PAPER 

LENGTH - 

Cut Sheet Top: Position that does not overlap 
with the bottom sensor 

Bottom: Center 
 

 

CUT PAPER - - 

*The setting of the printer driver is prioritized. 
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  Adjusting the Paper Sensor Position  
 

• If the guide ribs are attached, remove them before adjusting the position of the paper 

sensors. When the adjustment is complete, attach them again. 

 

• For information on attaching the guide ribs, refer to "Attaching the Guide Ribs." 
 

1 Insert your finger below the gray lever on the left of the machine rear, and lift it up 
to open the feeder cover. 

 

 
2 Insert a stick-shaped thing with a pointing tip (such as a ball-point pen) into the 

back of the metal part of the upper sensor on the back of the feeder cover, and 
pull it out to unlock it. 

 

 
3 Hold the both ends of the upper sensor and move it to the correct position. 
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4 Push in the metal part of the upper sensor to fix the sensor. 

5 Insert a stick-shaped thing with a pointing tip (such as a ball-point pen) below 
the metal part of the lower sensor, and pull it out to unlock it. 

 

 
6 Hold the both ends of the lower sensor and move it to the correct position. 

7 Push in the metal part of the lower sensor to fix the sensor. 
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8 Close the feeder cover. 
 

 

Attaching the Guide Ribs 
 
 

Feed Direction 
Feed 

Direction 
 
 
 

Feed Direction 
 

1 Turn the machine to make its rear side face to you. 

2 Insert your finger below the gray lever on the left of the machine rear, and lift it up 
to open the feeder cover. 
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3 Attach the guide rib to the position where the paper edge will be retained of the 
groove where the paper sensors move. 

 

 
 
 

• Ensure that the paper sensors are not moved. 

• Take care of the orientation of the guide rib. 

• Ensure that you do not drop the guide rib inside the machine. 
 

4 Close the feeder cover. 

Paper Sensor 

Guide Rib Guide Rib 
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Loading Paper 

Set the upper and lower paper sensors in the appropriate positions. 
 

• For details, refer to "Setting the Paper Sensors". 
 

1 Insert your finger below the gray lever on the left of the machine rear, and lift it up to open the 
feeder cover. 

 

 

2 Turn up the paper guide lever on the left side on the front of the machine to unlock it. 

3 Align the paper guide with the paper width. 

• Adjust the paper guide so that there is no gap between it and the paper. 
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4 Turn down the paper guide lever toward you to lock it. 

5 Remove the paper temporarily, and close the feeder cover. 
 

 

6 Insert the paper into the inlet until it stops. 
The paper is automatically loaded. 
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Feeding the Paper 
Feeding is performed for the paper set in the machine according to the machine settings. 

Execute feeding in the following cases. Printing may not be able to be performed correctly unless feeding is 
performed. 

• When paper is set in the machine again because it had run out, etc. 

• When paper was cut at the appropriate position because of a paper jam, etc. 

• When the cut position setting is changed 

 
 

• When the tip of the paper is dirty, performing paper feeding to cut off the dirty part with the paper still 
loaded in the machine. 

 
 

• When the paper to print on has been changed to another paper type, execute sensor calibration. 
 
 
 

1 Confirm that paper is loaded in the machine. 

2 Confirm that [READY TO PRINT] is displayed on the machine. 

3 Press «FEED/CUT» button. 

When a paper jam occurs during printing, the paper may be removed from the machine in order 
to clear the paper jam. 

When paper is set in the machine again after clearing a paper jam, a screen similar to the 
following is displayed. 

Press «FEED/CUT» button while this screen is displayed to execute paper feeding. 
 
 

RESTART PRINT? 
OK OR FEED/CUT  
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 Printing 
 

Registering Paper Information to the Printer Driver 
Printing from a Computer 
Printer Driver Screens and Functions 
Registering Frequently Used Settings (Favorites) 
Specifying the Print Orientation 
Rotating the Print Result 180 Degrees 
Specifying the Number of Prints 
Printing from the Last Page 
Cutting Every Specified Number of Pages 
Changing the Print Quality 
Printing with the Photo Mode 
Correcting Barcodes for Printing 
Changing the Color Settings 
Reducing Toner Consumption When Printing 
Overlaying Text or Logos When Printing 
Registering Print Documents as New Forms 
Saving the Documents to Print as Files in the Form Format 
Printing Hidden Text (Watermarks) 
Printing with a Specified Font 
Adjusting the Rendering Position 
Reducing the Size of Spool Files (Disabling EMF) 
Keeping the Page Layout when Resizing a Document 
Correcting Faintness in Thin Lines and Small Text 
Executing Drum Cleaning Before Printing 
Skipping Blank Pages 
Printing Using the Presenter Unit 
Removing the Windows Printer Driver 

6 
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Registering Paper Information to the Printer Driver 
Register the information for the paper to use. 

1 Click [Start], and select [Control Panel] in [Windows System]. 

2 Click [View devices and printers]. 

3 Right-click the [Pro330 PCL6] icon, and select [Printing Preferences]. 

4 Click [User-defined paper] on the [Setup] tab. 

 

5 Enter the information for the paper to register. 
1) Select [New Paper] from [Registered User-defined paper]. 
2) Enter the paper name in [Paper Name]. 

3) Select the paper format. 
4) Select the cut type. 

5) Select the paper type. 
6) Select the paper weight. 
7) Enter the paper size information. 

 

• Enter the paper size information after measuring the paper with a ruler, where possible. 

• Select [Hole Position Center)] if the paper has a hole in the center. 
 

6 Click [Add] when all the information has been entered. 
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Adjusting the Paper Sensors (Sensor Calibration) 
If paper jams or paper mark detection errors occur frequently, follow the procedure below to 
perform sensor calibration. 
It adjusts the paper sensors to the position suitable for the paper to use. 

• For details, refer to "Setting the Paper Sensors". 

 

• The paper sensors cannot be correctly calibrated unless they are in a suitable position. 
 

1 Confirm that [READY TO PRINT] is displayed on the machine. 

2 Click [Start] on the computer, and select [Control Panel] in [Windows System]. 

3 Click [View devices and printers]. 

4 Right-click the [Pro330 PCL6] icon, and select [Printing Preferences]. 

5 Click [Sensor Calibration…] on the [Setup] tab. 

6 Remove the paper from the machine when [Would you like to execute sensor 
calibration] is displayed. 

7 Click [Execute] on the printer driver screen of the computer. 

8 Load the paper in the machine when [PLEASE LOAD PAPER] is displayed on the screen of 
the machine. 

9 The procedure is complete when [READY TO PRINT] is displayed. 
 
 

• Remove the paper in the machine when [PLEASE REMOVE PAPER] is displayed on the 

screen. Failing to do so will cause a paper detection error. The paper detection error can be 

cleared by opening and closing the cover. 

• Sensor calibration cannot be performed from the printer driver while the machine has print data or 

while [PLEASE LOAD PAPER] is displayed on the screen. 

• An execution error occurs unless paper is loaded within one minute of [PLEASE LOAD PAPER] 

being displayed. The execution error can be cleared by opening and closing the cover. 

• When you change the paper to use, it is recommended that you execute sensor calibration. 



116  

Printing from a Computer 
Word pad is used here as an example. 

 
1 Load the paper. 

• For details, refer to "Chapter 5 Loading Paper". 
 

2 Open the file to print. 

3 Select [Print] from the [File] menu. 

4 Select [Pro330] as the printer, and click [Preferences]. 

5 Select the paper to use in [Paper Settings] on the [Setup] tab. 

• If the paper to use does not exist, click [User-defined paper] and register the paper. For details, 

refer to "Registering Paper Information to the Printer Driver". 

6 Select the items to set on each tab, and click [OK]. 

7 Click [Print]. 
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1 

Printer Driver Screens and Functions 
This section describes the functions of the printer driver. 

The printer driver screen is displayed by opening the file to print and clicking [Print] - 
[Preferences] in the [File] menu. 

 

[Setup] Tab 
 
 
 

 

 
  
 
  
 

  
  

 
 

  
 

 
 

 

 
 

 
No. Item Description 
1 Favorites Enables the printer driver settings to be saved to a file. 
2 Paper settings Sets the paper to print on. 
3 User-defined paper Adds, changes, and deletes paper. 
4 Paper Form Displays the paper format set for the user-defined paper. 
5 Cut Type Displays the cut type set for the user-defined paper. 
6 Media Type Displays the paper type set for the user-defined paper. 
7 Media Weight Displays the paper weight set for the user-defined paper. 
8 Sensor Calibration Adjusts the sensors used for detecting paper and marks. 
9 Orientation Sets the orientation for printing on the paper. 

10 180 turn Prints with the orientation rotated 180 degrees. 
11 Copies Enter the number of copies to print at once 
12 Print in reverse order Prints from the last page of the document. 
13 Cut Mode Cuts every specified number of pages. 
14 Quality Sets the resolution for printing. 
15 Photo Enhance Prints the image data for photos, etc. in detail. 
16 Barcode correction Configures settings for improving the accuracy of 

reading barcodes. 
17 About Displays the version information of the printer driver. 
18 Default Restores the default settings of this tab. 

2 
3 4 

6 
5 

7 
8 

9 10 

11 12 

13 

14 15 

16 
17 

18 
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[Color] Tab 
 
 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Description 
1 Color Mode Displays the color mode set with the [Detail] button. 
2 Detail Configures settings related to color printing. 
3 Toner Saving Configures settings related to saving toner when 

printing. 

1 

3 

2 
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[Overlays] Tab   
 

1 
 
 
 
 

  
  

 
 
 
 
 
 
 
 
 
 
 
 
 

No. Item Description 
1 Overlay Selects whether to print the document with a form 

overlaid, register the document as a new form, or save 
the document to a file as a form. 

2 Do not use overlay print Prints documents without overlaying a form. 
3 Register print document as a new 

form 
Registers the document to print to the printer as a new 
form. 

4 Overlay Print Overlays the selected form or group to the document to 
print. 

5 Saving the printed document as a 
form in a file 

Saves the document to print as a file in the form format. 

6 Edit list Sets the list of overlays that can be selected for overlay 
printing. 

7 Test Print Prints the selected form only. 

1 

2 

3 
4 

5 

6 

7 
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[Extend] Tab   
 
 
 
 
 
 

1 

 
2 

 
3 

 
 
 
 
 
 
 

4 
 
 
 

No. Item Description 
1 Watermarks You can print data created by an application with a 

watermark over it. 
2 Fonts Configures settings related to TrueType fonts and printer 

fonts. 
3 Drawing position adjustment Adjusts the position of the drawing data created by the 

printer driver. 
4 Advanced When the desired print results are not obtained, this 

may enable them to be produced, depending on the 
symptom. 

1 

2 

3 

4 
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Registering Frequently Used Settings (Favorites) 
Registering frequently used settings to favorites with a name eliminates the need for changing 
the settings each time printing is performed. Select the registered name when printing. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Change the items on each tab to the values you want to set. 

5 Click [Register]. 

6 Enter the setting name in [Setting Name], and click [OK]. 

7 Click [OK] to close the print settings dialog. 

To print with the registered settings, select the name registered in [Favorites], and perform 
printing. 
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Specifying the Print Orientation 
Perform the procedure below to change the print orientation. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the desired print orientation in [Orientation] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 



123  

Rotating the Print Result 180 Degrees 
You can change the settings of the printer driver to rotate the print result by 180 degrees, 
without changing the file to print. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [180°] in [Orientation] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Specifying the Number of Prints 
Available values are from 1 to 999. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Enter the number of prints in [Copies] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Printing from the Last Page 
The document will be in page order if the print results are stacked with the printed surface facing 
up. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Print in reverse order] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Cutting Every Specified Number of Pages 
You can cut the paper every specified number of pages. 

Specify the position to cut the paper when using continuous paper. 
 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Enter the number of pages to cut the paper at in [Page(s) per cut] in [Cut Mode] on the 
[Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
 

• When [Hole] is selected in [Cut Type], [Cut by Page] is always set to [1]. 
• You cannot specify a number of pages that exceeds a total of 551 mm in paper length. 
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Changing the Print Quality 
Perform the procedure below to change the print quality. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select a value of your choice in [Quality] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Printing with the Photo Mode 
Perform the procedure below to print the image data of photos in detail. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Photo Enhance] on the [Setup] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Correcting Barcodes for Printing 
Perform the procedure below to improve the accuracy of reading barcodes. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Preferences] in [Barcode Correction] on the [Setup] tab. 

5 Select a value in [Bar Width Adjustment]. 
 

• The print results of images and illustrations other than barcodes may become thinner. 

• If selected, colors may overlap or unintended colors may be printed when printing in color. 
 

6 Select [Replace mono barcode with cyan] as necessary. 
 

• Black or grey parts may be replaced by cyan when printing images or figures other than barcodes. 

• If selected, colors may overlap or unintended colors may be printed when printing in color. 
• May become disabled when greyscale is set from the application. 
 

7 Click [OK]. 

8 Click [Print]. 
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Changing the Color Settings 
You can adjust color printing. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select a value of your choice in [Color Mode] on the [Color Settings] tab. 

5 Click [OK]. 

6 Click [Print]. 
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Reducing Toner Consumption When Printing 
You can reduce the toner consumption when performing test prints, etc. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select a value in [Toner Saving] on the [Color Settings] tab. 

5 Click [OK]. 

6 Click [Print]. 



132  

Overlaying Text or Logos When Printing 
You can print on forms registered in the machine in advance. 

 
1 Register the forms to the machine. 

• For details, refer to "Saving Documents to Print as Files in the Form Format". 
 

2 Open the file to print. 

3 Select [Print] from the [File] menu. 

4 Click [Preferences]. 

5 Select the [Overlays] tab. 

6 Select [Overlay Print] from the pull-down menu, and select the form to use for overlay 
printing from the drop-down list. 

 

• When adding a form registered in the Configuration Tool or overlaying multiple forms as a group, 

click [Edit List] to add them to the list. 

To add a form registered in the Configuration Tool: Click [Add a registered form], enter the form name 

in [Form name] and the form ID registered in the Storage Manager plug-in of the Configuration Tool in 

[ID], select the pages to apply that form to in [Print on Pages], and click [OK]. 

7 Click [OK]. 

8 Configure the settings as required, and click [OK]. 

9 Click [Print] on the [Print] screen. 
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Registering Print Documents as New Forms 
Before performing overlay printing, perform the procedure below to register 

the forms. You can register up to 32 forms. 

1 Create the forms to register to the printer in an application. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Register print document as a new form] from the pull-down menu on the 
[Overlays] tab. 

5 Click [OK]. 

6 Configure the settings as required, and click [OK]. 

7 Click [Print] on the [Print] screen. 

8 Enter the [Form name] and [ID] to register to the printer in [New Form]. 

• The position for performing overlay printing can also be specified. 
 

9 Select the page to apply the overlay to in [Print on Pages] as the registration 
information for the printer driver. 

 To specify the pages to apply, select [Custom], and enter the pages to apply in [Custom 
Pages]. 

10 Click [OK]. 
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Saving the Documents to Print as Files in the Form Format 
You can save the documents to print as files in the form format. 

 
1 Create the forms to register to the printer in an application. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Save the printed document as a form in a file] from the pull-down menu on the 
[Overlays] tab. 

5 Click [Use] and select the destination. 

6 Click [OK]. 

7 Configure the settings as required, and click [OK]. 

8 Click [Print] on the [Print] screen. 

9 In [Save the form with a name], enter [ID] and click [OK]. 

• The position for performing overlay printing can also be specified. 
 

10 Click [OK]. 
 

• Forms do not include a watermark. 
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Printing Hidden Text (Watermarks) 
You can overlay user-defined text over files to print. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Watermark] on the [Extend] tab. 

5 Click [New]. 

6 Enter the characters to print in [Text] on the [Watermarks] screen. 

7 Configure [Font], [Size], and the other settings as required, and click [OK]. 

8 Confirm that the watermark to print is selected, and click [OK]. 

9 Configure the settings as required, and click [OK]. 

10 Click [Print] on the [Print] screen. 
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Printing with a Specified Font 
You can print by specifying a font in a computer or the machine. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Extend] tab. 

5 Click [Font]. 

6 Select the print method in [TrueType Font Output Type]. 

7 Click [OK]. 

8 Configure the settings as required, and click [OK]. 

9 Click [Print] on the [Print] screen. 
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Adjusting the Rendering Position 
Perform the procedure below to adjust the position of the render data. 

 
1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Adjustment] on the [Extend] tab. 

5 Enter the vertical (Y) and horizontal (X) values on the [Adjustment] screen, and click [OK]. 

6 Click [OK]. 

7 Click [Print] on the [Print] screen. 
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Reducing the Size of Spool Files (Disabling EMF) 
The following procedure may be effective for reducing the time until processing is returned to 
the application after printing starts. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] on the [Extend] tab. 

5 On the [Advanced] screen, click [Reduce Size of Spool File], and select [ON] from the 
[Settings] drop-down box. 

6 Click [OK]. 

7 Click [OK]. 

8 Click [Print]. 
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Keeping the Page Layout when Resizing a Document 
The following procedure may be effective for maintaining the page layout when printing with a 
zoom ratio. 

 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] on the [Extend] tab. 

5 On the [Advanced] screen, click [Keep page layout when resizing document], and 
select [ON] from the [Settings] drop-down box. 

6 Click [OK]. 

7 Click [OK]. 

8 Click [Print]. 
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Correcting Faintness in Thin Lines and Small Text 
Perform the procedure below to improve faintness in thin lines and small text. 

 
1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] on the [Extend] tab. 

5 On the [Advanced] screen, click [Adjust ultra-fine lines], and select [ON] from the 
[Settings] drop-down box. 

6 Click [OK]. 

7 Click [OK]. 

8 Click [Print]. 
 

 

• If the expansion of curved lines causes barcodes to become smudged, setting this to [OFF] may 
improve the problem. 
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Executing Drum Cleaning Before Printing 
Perform the procedure below to execute drum cleaning before printing. 

 
1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] on the [Extend] tab. 

5 On the [Advanced] screen, click [Run maintenance cycle before printing], and select [ON] 
from the [Settings] drop-down box. 

6 Click [OK]. 

7 Click [OK]. 

8 Click [Print]. 
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Skipping Blank Pages 
You can skip the printing of blank pages to save paper. 

 
1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] on the [Extend] tab. 

5 On the [Advanced] screen, click [Skip White Pages], and select [ON] from the [Settings] drop-
down box. 

6 Click [OK]. 

7 Click [OK]. 

8 Click [Print]. 
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Printing Using the Presenter Unit 
Using the optional Presenter Unit enables printed paper to be retained in the outlet without 

being output. The following operation modes exist. 

MODE1:  Retain the printed paper in the outlet. Printing of the next paper starts  
      when the printed paper is removed. 

MODE2:   The last printed paper is retained in the outlet and output when the next  
                 printing starts. The last paper is retained in the outlet until the next    
                 printing starts. 

OFF :    Output the printed paper without retaining it. 
 

• Setting the Mode 
 

1 Install the Presenter Unit. 

• For details, refer to "Installing the Presenter Unit". 
 

2 Turn on the machine. 

• For information on turning on the machine, refer to "Turning On the Machine". 
 

3 Confirm that [READY TO PRINT] is displayed on the machine. 
 

4 Press «∧» button or «∨» button several times to display [ADMIN SETUP], and press «OK» 
button. 

5 When [ENTER PASSWORD] is displayed, enter the password. 

• The default password is "999999." 
 

6 When the password has been entered, press «OK» button. 
 

7 Press «∧» button or «∨» button several times to display [PRINT SETUP], and press 
 «OK» button. 

8 Press «∧» button or «∨» button several times to display [PRESENTER MODE], and press 
«OK» button. 

 

9 With the setting flashing, press «∧» button or «∨» button to display the value you want 
to set, and press «OK» button. 
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10 Press «ONLINE» button, or press «BACK» button until [READY TO PRINT] is 
displayed. 

 
 

• When Set to MODE1 
 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the items to set on each tab, and click [OK]. 

5 Click [Print]. 

6 When the printed paper stops near the Presenter Unit, check the operation panel and pull 
out the paper. 

7 Repeat step 6 until all pages have been printed. 

8 Pull out the final page that has stopped near the Presenter Unit. 
 
 

• When Set to MODE2 
 

1 Open the file to print. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the items to set on each tab, and click [OK]. 

5 Click [Print]. 

6 Pull out the final page that has stopped near the Presenter Unit. 
 

• The machine does not enter the Power Save mode when it is retaining the printed paper. 
 

• If the printed paper is not fully ejected, check whether the settings in [PRESENTER MODE] 

and [PRESENTER UNIT] on the operation panel match your environment. 
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Removing the Windows Printer Driver 
 

• You must log in as the administrator to perform this procedure. 
 

1 Restart the computer. 

2 Click [Devices and Printers]. 

3 Right-click the icon for the printer to delete, and select [Remove device]. 
 If the icons are grouped, select [Remove Print Queue] > [Pro330 PCL6]. 

4 When a confirmation message is displayed, click [Yes]. 

• When a message is displayed to inform you of the device in use, repeat steps 1 to 3. 
 

5 Select an icon in [Printers], and click [Print server properties] on the top bar. 

6 Select the [Driver] tab. 

7 If [Change Driver Settings] is displayed, click it. 

8 Select the printer driver to be removed, and click [Delete]. 

9 If the [Remove Driver and Package] screen is displayed, select [Remove driver and 
driver package], and click [OK]. 

10 When a confirmation message is displayed, click [Yes]. 

11 When the [Remove Driver Package] screen is displayed, click [Delete] > [OK]. 

• If removal is rejected, restart the computer, and then repeat steps 4 to 10. 
 

12 Click [Close] in the [Print Server Properties] screen. 

13 Restart the computer. 
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Cautions for Replacing Consumables 
Observe the following cautions when replacing consumables. 

 
 

    
 

 

 
 
Do not throw toner or a toner cartridge into a fire. The toner will scatter, resulting in burns. 

 

 

 
Do not store a toner cartridge in a location where it is exposed to fire. The toner may 
ignite, resulting in fire or burns. 

 

 

Do not vacuum spilled toner with an electric vacuum cleaner. Vacuuming spilled toner with 
an electric vacuum cleaner may result in ignition due to sparks from electric contacts or 
other reasons. If toner spills on the floor or other places, wipe the toner with a damp rag or 
other cloth. 

 
 

    

 

 

 
Some parts inside the machine become very hot. Do not touch the locations around a 
"CAUTION HOT" label. This may cause burns. 

 

 

 
 
Keep toner cartridges out of the reach of children. 

 

 

 
If you inhale toner, gargle with a large amount of water, and move to a place with fresh air. 
Also seek medical advice, as required. 

 

 

 
 
If toner stains your hands or other areas of skin, wash thoroughly with soap and water. 

 

 

 
If toner gets into your eyes, immediately rinse them with a large amount of water. Also 
seek medical advice, as required. 

 

 

 
 
If toner is swallowed, seek medical advice, as required. 
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When handling a paper jam or replacing toner cartridges, use care not to let your clothes 
or hands get dirty with toner. If toner stains your clothes, wash with cold water. If you warm 
the stained clothes by washing them with hot water or other methods, the toner will soak 
into the fabric and become impossible to remove. 

 

 

 
Do not disassemble or forcibly open the image drum or toner cartridges. The toner may 
be scattered, causing you to inhale the toner or get your hands or clothes stained with the 
toner. 

 

 

 
 
Keep a used toner cartridge in a bag so that the toner is not scattered. 

 

 

 
If toner is spilled on the floor, gently wipe it away with a wet rag, etc. to ensure that the 
toner does not scatter. 

 

• Use genuine Oki Data consumables to ensure product performance. 
 

• Problems caused by using non-genuine consumables require a payment, regardless of the 

warrant or maintenance contract. (Although use of non-genuine consumables does not always 

result in problems, be extremely careful when using them.) 
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Replacing the Toner Cartridge 
When "ORDER TONER" is displayed on the screen of the operation panel, prepare a replacement 
toner cartridge. 

When "REPLACE TONER" is displayed and printing is stopped, replace the toner cartridge. 
 

§ The print quality deteriorates after one year or more passes since you open the toner cartridge. In 

this case, prepare a new toner cartridge for replacement. 

 

§ If you replace the toner cartridge/image drum unit while it is being used, the amount of toner used will 
not be counted accurately. 

 

1 Open the toner cartridge cover. 

2 Pull out the toner cartridge. 
 

 
                 WARNING 

Burns may result. 
 

 

Never throw used toner cartridges into a fire. They may explode, and the 
toner inside may be scattered and cause burns. 

 

§ Place paper under the removed toner cartridge, as toner may leak from the bottom. 
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3 Take out the new toner cartridge, and shake it several times vertically and horizontally. 

4 Place the toner cartridge in the direction that it will be attached to the machine. 

 

5 Attach the toner cartridge. 

6 Close the toner cartridge cover. 
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Replacing the Image Drum Unit 
When "ORDER IMAGE DRUM" is displayed on the screen of the operation panel, prepare a 
replacement image drum unit. 

If you continue printing, "IMAGE DRUM LIFE" is displayed and printing stops. 

When "IMAGE DRUM LIFE" is displayed and printing stops, replace the image drum unit. 

The estimated replacement cycle of an image drum unit is approximately 25,000 pages for 216 
mm simplex printing (one page per job). 

 

§ The actual number of pages you can print with the image drum unit depends on how you use the 

machine. It may be less than half the above estimation depending on the printing conditions. 

§ Printing quality of the toner cartridge may deteriorate after one year has passed since unpacking. 

Replace the image drum unit with a new one. 

§ Even after "IMAGE DRUM LIFE" is displayed, you can continue printing, but we recommend 

you replace the unit immediately when "REPLACE IMAGE DRUM" is displayed. 

§ The "ORDER IMAGE DRUM" message is not displayed when [ADMIN SETUP] > [PANEL SETUP] > 

[NEARLIFE STATUS] is set to [DISABLE]. 

§ Use genuine Oki Data consumables to ensure product performance. 
§ Problems caused by using non-genuine consumables require a payment, regardless of the 

warrant or maintenance contract. (Although use of non-genuine consumables does not always 

result in problems, be extremely careful when using them.) 

 

§ Use extra care when handling the image drum (the glossy cylinder), because it is fragile. 
§ Do not expose the image drum unit to direct sunlight or strong light (approximately 1,500 lux or 

more). Do not leave the image drum unit exposed for 5 minutes or more, even under room 

lighting. When the image drum unit will be left alone for 5 minutes or more, cover it with black 

paper, etc. to prevent it from being exposed to light. 

§ You can change the timing for displaying the "ORDER IMAGE DRUM" message. Set it using [ADMIN 
SETUP] > [OTHERS SETUP] 
[NEARLIFE SETUP] > [DRUM NEARLIFE] on the operation panel. Available values are from 500 to 
5,000 (in 500 increments). 

 
 

1 Turn off the machine. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
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2 Insert your finger into the recess on the top of the machine and pull up the lever. 

 

3 Open the top cover until it stops. 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 

4 Hold the blue handle and pull out the image drum unit vertically. 
 

• Pull it out after opening the top cover fully. 
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5 Hold the blue handle of a new image drum unit, confirm the position to install it to the 
machine, and lower it vertically. 

 

 
6 Peel off the protective tape. 

7 Peel off the protective tape, and remove the desiccant. 
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8 Remove the cover toner. 
 

 

9 Close the top cover. 
 
 

 

 

 

10 Open the toner cartridge cover. 
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11 Take out the new toner cartridge from the packaging bag, and shake it several times 
vertically and horizontally. 

 

 
12 Place the toner cartridge in the direction that it will be attached to the machine. 

13 Attach the toner cartridge. 

 

 

 

14 Close the toner cartridge cover. 
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15 Turn on the machine. 

• For information on turning on the machine, refer to "Turning On the Machine".
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When the Lightproof Film is Dirty 

When the lightproof film of the image drum unit is dirty, wipe it clean with a soft tissue. 
 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

2 Open the top cover until it stops. 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 

3 Wipe the lightproof film with a soft tissue paper lightly. 
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Replacing the Fuser Unit 
When "ORDER FUSER UNIT" is displayed on the screen of the operation panel, prepare a 
replacement fuser unit. The estimated timing for the next message to be displayed is when 
printing approximately 5,000 pages. 

When "FUSER UNIT LIFE" is displayed, replace the fuser unit. 

The estimated replacement cycle of the fuser unit is approximately 100,000 pages for 216 
mm simplex printing (one page per job). 

 

• The actual number of pages you can print with the fuser unit before replacement depends on how you 
use it. 

• Even after "FUSER UNIT LIFE" is displayed, you can extend the lifetime of the fuser unit 

somewhat by opening and closing the cover, etc., but we recommend you replace the fuser unit 

soon to prevent malfunction. 

• Replace the fuser unit after you use it up to the end of its lifetime. If you use the removed fuser unit 

with another device, its lifetime will not be displayed correctly. 

• "ORDER FUSER UNIT" is not displayed when [ADMIN SETUP] > [PANEL SETUP] > [NEARLIFE 
STATUS] is set to [DISABLE]. 

• Do not expose the image drum unit to direct sunlight or strong light (approximately 1,500 lux or 

more). Do not leave the image drum unit exposed for 5 minutes or more, even under room 

lighting. 

• You can change the timing for displaying the "ORDER FUSER UNIT" message. Set it using [ADMIN 
SETUP] > [OTHERS SETUP] 
[NEARLIFE SETUP] > [FUSER NEARLIFE] on the operation panel. Available values are from 500 to 
5,000 (in 500 increments). 

 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 
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2 Open the top cover until it stops. 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 

 
\Hold the blue handle and pull out the image drum unit vertically. 

 
 

• Pull it out after opening the top cover fully. 
 

 

3 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 
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4 Pull up the blue handle at the front of the machine interior and pull out the fuser unit 
vertically. 

 
 

   Burns may result. 
 

 

Since the fuser unit gets hot, carry out the operation carefully, and make sure 
to hold it by the handle when lifting it up. When it is hot, do not attempt to 
carry out the operations. Wait until it is cooled down and then carry out the 
operations. 

 

 
5 Hold the blue handle of a new fuser unit, align the red ▲ on the right side and the red ▼ in 

the machine, and lower it vertically to set the unit in the machine. 
 
 

 
6 Turn down the blue handle of the fuser unit toward you to put it away. 
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7 Hold the blue handle of an image drum unit, confirm the position to install it to the 
machine, and lower it vertically. 

 

 
8 Close the top cover. 
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Replacing the Transfer Belt Unit 
When "ORDER BELT UNIT" is displayed on the screen of the operation panel, prepare a 
replacement transfer belt unit. The estimated timing for the next message to be displayed is 
when printing approximately 5,000 pages. 

When "BELT UNIT LIFE" is displayed, replace the transfer belt unit. 

The estimated replacement cycle of the transfer belt unit is approximately 100,000 pages for 216 
mm simplex printing (one page per job). 

 

• The actual number of pages you can print with the transfer belt unit depends on how you use it. 
• Even after "BELT UNIT LIFE" is displayed, you can extend the lifetime of the transfer belt unit 

somewhat by opening and closing the cover, etc., but we recommend you replace the transfer 

belt unit soon to prevent malfunction. 

• Replace the transfer belt unit after you use it up to the end of its lifetime. If you use the removed 

transfer belt unit with another device, its lifetime will not be displayed correctly. 

• "ORDER BELT UNIT" is not displayed when [ADMIN SETUP] > [PANEL SETUP] > [NEARLIFE 

STATUS] is set to [DISABLE] on the operation panel. 

• Use extra care when handling the image drum (the glossy cylinder), because it is fragile. 
• Do not expose the image drum unit to direct sunlight or strong light (approximately 1,500 lux or 

more). Do not leave the image drum unit exposed for 5 minutes or more, even under room 

lighting. 

 

• You can change the timing for displaying the "ORDER BELT UNIT" message. Set it using [ADMIN 

SETUP] > [OTHERS SETUP] > [NEARLIFE SETUP] > [BELT NEARLIFE] on the operation panel. 

Available values are from 500 to 5,000 (in 500 increments). 
 
 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 
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2 Open the top cover until it stops. 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 

3 Hold the blue handle and pull out the image drum unit vertically. 

 
• Pull it out after opening the top cover fully. 

 

4 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 

 



165  

5 Hold the handle (black) of the transfer belt unit and pull it out vertically. 
 

 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 

 

 
6 Hold the handle (black) of a new transfer belt unit, and lower it vertically to set the unit into 

the machine. 
 

 
7 Hold the blue handle of the image drum unit, confirm the position to install it to the 

machine, and lower it vertically. 
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8 Close the top cover. 
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Replacing the Feed Roller 
When paper jams frequently occur or the color is shifted, replace the feed 

roller. The feed roller should be replaced after approximately 60 km of 

printing. 

 

• The actual lifetime of a feed roller depends on environment and paper. 

• If paper jams persist even after cleaning the feed roller, we recommend that you replace the feed 
roller. 

 
 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

2 Open the top cover until it stops. 

 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 
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3 Hold the blue handle and pull out the image drum unit vertically. 

• Pull it out after opening the top cover fully. 
 

 
 

4 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 

 

 
 

5 Hold the handle (black) of the transfer belt unit and pull it out vertically. 
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6 Insert your fingers in the both ends of the recess in the center bottom of the back of the 
machine interior, and turn down the sensor lever towards yourself. 

 

 
7 Slide the blue levers (two locations) inside the machine inward to unlock it. 
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8 Hold the tabs (white and black) on the right and left sides of the feed roller and pull it out. 
 

 
9 Attach a new feed roller into the machine.  Set it so that it is on the same surface as the blue 

lock. 
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10 Slide the blue levers (two locations) outward to fix the feed roller.  Ensure that the blue lock is 
over the black knob on the right and that the blue lock is over the left knob. 

 

 
11 Push the sensor lever into the machine. Return it to its original position. 

 

 
12 Return the transfer belt unit to its original position in the machine. 
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13 Return the image drum unit to its original position in the machine. 

14 Close the top cover. 
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Replacing the Paper Feed Roller 
When paper jams frequently occur, replace the paper feed roller. 

The paper feed roller should be replaced after approximately 60 km of printing. 
 

1 Turn the machine to make its rear side face to you. 

2 Insert your finger below the gray lever on the left, and lift it up to open the feeder 
cover. 

 

 
3 Loosen the right screw with a driver. 
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4 Lift up the right-side side cover to remove it. 

5 Loosen the left screw with a driver. 

 

6 Lift up the left-side side cover to remove it.  Lift the front up and pull it out forwards. 
 

 
7 Turn up the left lever of the paper feed roller to unlock it. 
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8 Turn up the right lever of the paper feed roller to unlock it. 

9 Hold the right and left levers of the paper feed roller and lift it directly up. 

 

10 Hold the right and left levers of a new paper feed roller and insert the roller vertically.  
With the side with the white gear on the right, hold the blue levers on both ends and 
insert it from directly above. 
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11 Turn down the left lever of the paper feed roller until it stops to lock it. 

 

12 Turn down the right lever of the paper feed roller until it stops to lock it. 

13 Attach the left-side side cover over the top and tighten the screw. 

 

 

 

14 Attach the right-side side cover over the top and tighten the screw. 
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15 Close the feeder cover until it clicks. 
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Cleaning the Surface of the Machine 

1 Turn off the machine. 
 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

2 Wipe the surface of the machine with a cloth that has been moistened with water or 
neutral detergent and squeezed well. 

 

 

3 Wipe the surface of the machine with a dry soft cloth. 
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Cleaning the LED Head 
Clean the LED head if white lines or black lines appear, images are faded, or the periphery of 
letters are smudged in the printouts. 

 

• Do not use solvents, such as methyl alcohol or thinners. They may damage the LED head. 

• Do not expose the image drum unit to direct sunlight or strong light (approximately 1,500 lux or 

more). When leaving the image drum unit under room lighting for five minutes or more or leaving 

the top cover open, cover it with a black cloth or paper to prevent it from being exposed to light. 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

 

2 Open the top cover until it stops. 
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3 Cover the image drum unit with black paper, etc. so that it is not exposed to light. 
 
 

4 Wipe the three lenses of the LED heads with a soft tissue lightly. 
 

 

5 Remove the black paper, etc. on the image drum unit, and close the top cover. 
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Cleaning the Feed Rollers 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

 
 

2 Open the top cover until it stops. 
 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 
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3 Hold the blue handle and pull out the image drum unit vertically. 

• Pull it out after opening the top cover fully. 
 
 

 

4 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 

 

 
5 Hold the handle (black) of the transfer belt unit and pull it out vertically. 
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6 Insert your fingers in the both ends of the recess in the center bottom of the back of the 
machine interior, and turn down the sensor lever towards yourself. 

 

 
7 Wipe the feed roller with a soft cloth that has been moistened with water and then 

squeezed well. 
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Cleaning the Paper Feed Rollers 

1 Turn the machine to make its rear side face to you. 

 

 
2 Insert your finger below the gray lever on the left, and lift it up to open the feeder 

cover. 
 

 
3 Wipe the paper feed roller with a soft cloth that has been moistened with water and then 

squeezed well. 
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When the LED Lights Up 
When a problem occurs in the machine, the ERROR LED or WARNING LED lights up or flashes 
and a message is displayed on the screen. 
 
Check the message and perform the remedy. For details, refer to "List of Messages". 
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When the Paper Is Jammed 
Error 381 (Paper on the Transfer Belt Unit) 

 
1 Insert your finger into the recess on the top of the machine and pull up the lever. 

2 Open the top cover until it stops. 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 
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3 Hold the blue handle and pull out the image drum unit vertically. 

• Pull it out after opening the top cover fully. 
 

 

4 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 

 

 
5 If the tip of the paper is visible, gently pull it out to the front. 

 

• If paper is jammed in the fuser unit, refer to "Error 382 (Paper Jammed in the Fuser Unit)". 
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6 Return the image drum unit to its original position in the machine. 

7 Close the top cover. 
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  Error 382 (Paper Jammed in the Fuser Unit) 
 

1 Insert your finger into the recess on the top of the machine and pull up the lever. 

2 Open the top cover until it stops. 

 
 

 

   Burns may result. 
 

 

The fuser unit is extremely hot. Do not touch it. 
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3 Hold the blue handle and pull out the image drum unit vertically. 

• Pull it out after opening the top cover fully. 
 

 
 

4 Place the image drum unit you took out on a flat surface and cover it with black paper, etc. so 
that the image drums are not exposed to light. 

 

5 Take out the fuser unit. 
 

 

   Burns may result. 
 

 

Since the fuser unit gets hot, carry out the operation carefully, and make sure 
to hold it by the handle when lifting it up. When it is hot, do not attempt to 
carry out the operations. Wait until it is cooled down and then carry out the 
operations. 
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6 Gently pull the paper out to the back of the fuser unit (the opposite direction from the 
paper feed direction). 

 

 
7 Hold the blue handle of a new fuser unit, align the red ▲ on the right side and the red ▼ in 

the machine, and lower it vertically to set the unit in the machine. 
 

 
8 Return the fuser unit to its original position in the machine. 
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9 Return the image drum unit to its original position in the machine. 

10 Close the top cover. 
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  Error 380/390 (Paper Jammed Near the Cutter) 
 

1 Turn the machine to make its rear side face to you. 

2 Insert your finger below the gray lever on the left, and lift it up to open the feeder 
cover. 

 

 
3 Gently pull out the jammed paper. 
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4 Close the feeder cover until it clicks. 
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Canceling Printing 
 

  Pressing «CANCEL» Button 
 

1 Press «CANCEL» button on the operation panel to cancel printing. 
 
 
 

  Canceling from a Computer 
You can cancel printing from a computer when a large amount of data has been accidentally 
sent to the printer. 

 

1 Click [Devices and Printers]. 

2 Right-click the icon for the printer, and select [See print jobs]. 

3 Select the file name to cancel printing for. 

4 Press the <Delete> key on the keyboard. 

5 Check the display of the control panel. 

6 Printing can be canceled from the operation panel of the machine when 
"PROCESSING" or "DATA" is displayed. 
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Cannot Print 
 

 

Cause Remedy Reference 
The machine is in the Sleep mode. Press «POWER SAVE» button on 

the operation panel to switch the 
machine to standby. 

 Using the Operation Panel 

This machine is not turned on. Turn the machine on.  Turning On the Machine 
The LAN cable/USB cable is 
disconnected. 

Check whether the cable is 
correctly connected to the 
computer and the machine. 

 Using the Machine 

There is a problem with the cable. Replace the cable with a new one. - 
The machine is offline. Press «ONLINE» button on the 

operation panel to display [READY 
TO PRINT]. 

- 

An error message is displayed on 
the screen of the operation panel. 

Check the displayed error 
message and perform the remedy. 

 List of Messages 

The interface settings are disabled. Check the interface settings to 
see whether the machine settings 
match the connection environment. 

 Using the Machine 
 Connecting via Wireless LAN 

There is a problem with the print 
function. 

Check whether the configuration 
list can be printed. 

 Checking Information about the 
Machine 

The machine is not set as the 
default printer. 

Set the machine as the default 
printer. 
Right-click the [Your  Printer] icon 
in the [Devices and Printers] folder, 
and select [Set as default printer]. 

- 

The output port of the printer driver 
is incorrect. 

Select the output port where 
the LAN cable/USB cable is 
connected. 

- 

Printing is being processed from 
another interface. 

Wait until the process is complete. - 

[PRESS OK BUTTON/INVALID 
DATA] is displayed on the screen 
of the operation panel and printing 
is not performed. 

Set a longer time in [MENUS] > 
[SYSTEM ADJUST] > [TIMEOUT 
INJOB] on the operation panel. 
The default setting is 40 seconds. 
When [PRESS OK BUTTON/ 
INVALID DATA] is displayed on 
the screen of the operation panel 
and printing is not performed, the 
print data may not be suitable 
for the machine. Check whether 
the printer driver matches the 
machine. 

- 



200  

List of Messages 
This section describes the messages displayed on the operation panel. 

□ : Means that an arbitrary message is displayed on the top. 
[CODE] : Displays an arbitrary numeric value. 
[INFO]  : Displays an arbitrary message.  
[FS_ERROR] : Displays an arbitrary numeric value.  
[ERRERROR] : Displays an arbitrary numeric value. 
[SUBCODE] : Displays an arbitrary numeric value.  
[COVER]  : Indicates the top cover or feeder cover. 

 
 

Message Description 
PLEASE WAIT Wait until the machine becomes ready to print. 
INITIALIZING The machine is initializing. Wait until the machine 

becomes ready to print. 
MENU RESETTING The menu items are being reset. Wait until the 

machine becomes ready to print. 
WAIT A MOMENT 
NETWORK INITIAL 

The network settings are being initialized. Wait until 
the machine becomes ready to print. 

DETECTED AN ABNORMALITY OF INTERNAL 
DATABASE 
AFTER PRESSING [OK] THE DATA WILL BE 
DELETED AND THEN REBOOT 

An error occurred in the internal database of the 
machine. Press «OK» button to delete the data. The 
machine then restarts. 

PU FLASH ERROR The machine cannot start. 
Contact your dealer. 

READY TO PRINT Printing can be performed. 
OFFLINE The machine is offline. Press «ONLINE» button to 

turn the machine online. 
FILE ACCESSING The internal file system of the machine is being 

accessed. Wait until the machine becomes ready to 
print. 

DATA ARRIVE Data is being received. 
PROCESSING Data is being processed. 
DATA Unprinted data remains in the machine. 
PRINTING The machine is printing. 
PRINT DEMO PAGE A demonstration page is being printed. 
PRINT CONFIGURATION The settings of the machine are being printed. 
PRINT FILE LIST The list of files stored in the internal file system of the 

machine is being printed. 
PRINT ERROR LOG An error log is being printed. 
□ 
COPY kkk/lll 

A copy is being printed. 
[kkk] indicates the number of pages being printed 
and [lll] indicates the total number of pages. 

CANCELING JOB Printing is being canceled. 
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CANCELING JOB 
(JAM) 

The print data is being deleted because a paper jam 
occurred. 

□ 
ADJUSTING TEMP. 

The temperature of the fuser unit is being adjusted. 
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Message Description 
□ 
OPTIMIZING TEMP 

The internal temperature of the machine is being 
adjusted. 

□ 
POWER SAVE 

The machine is in the Power Save mode. 

□ 
SLEEP MODE 

The machine is in the Sleep mode. 

CHANGING LANGUAGE 
PLEASE WAIT 

The language displayed on the operation panel is 
being changed. Wait until the machine becomes 
ready to print. 

LANGUAGE CHANGE FAILED 
ERROR NUM: [CODE] 

Failed to change the language displayed on the 
operation panel. Turn the machine off and then on 
again. 

□ 
ADJUSTING COLOR 

Automatic color shift correction is being performed. 

□ 
ADJUSTING DENSITY 

Automatic density correction is being performed. 

PLEASE WAIT 
EXECUTING MAINTENANCE 

The machine is executing maintenance. Wait until 
the machine becomes ready to print. 

FEEDING Paper is being fed. 
□ 
USB MEMORY CONNECTING 

USB memory is connecting to the machine. 

PLEASE LOAD PAPER 
SENSOR CALIBRATING 

The paper sensors are being adjusted. 

□ 
TAKE LABEL 

Paper is waiting to be pulled out from the machine. 
Pull out the paper. 

□ 
ORDER TONER 

Toner is low. Prepare a new toner cartridge. 

□ 
TONER NOT RECOMMENDED 

The toner cartridge is not recommended for the 
machine. 

PRESS OK BUTTON 
ERROR PDL 

An error has occurred in the machine. Press «OK» 
button to clear the error. 

□ 
ORDER IMAGE DRUM 

The image drum unit is reaching the end of its 
lifetime. Prepare a new image drum unit. 

□ 
ORDER FUSER UNIT 

The fuser unit is reaching the end of its lifetime. 
Prepare a new fuser unit. 

□ 
ORDER BELT UNIT 

The transfer belt unit is reaching the end of its 
lifetime. Prepare a new transfer belt unit. 

□ 
FUSER UNIT LIFE 

The fuser unit has reached the end of its lifetime, and 
printing will stop soon. Prepare a new fuser unit. 

□ 
BELT UNIT LIFE 

The transfer belt unit has reached the end of its 
lifetime, and printing will stop soon. Prepare a new 
transfer belt unit. 

□ 
TONER EMPTY 

The toner cartridge is empty, and printing will stop 
soon. Prepare a new toner cartridge. 

□ 
REPLACE TONER 

The toner cartridge is empty. Replace the toner 
cartridge with a new one. 
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□ 
TONER NOT INSTALLED 

A toner cartridge is not installed in the machine. Set 
the toner cartridge in the machine. 
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Message Description 
□ 
IMAGE DRUM NOT RECOMMENDED 

A suitable image drum unit is not installed in the 
machine. 

□ 
IMAGE DRUM LIFE 

The image drum unit has reached the end of its 
lifetime, and printing will stop soon. Prepare a new 
image drum unit. 

□ 
FILE SYSTEM IS FULL 

The internal file system of the machine is full. 

□ 
FILE IS WRITE PROTECTED 

The machine is trying to write to a file in the internal 
file system of the machine that does not allow writing. 

PLEASE DETACH IT 
USB HUB UNSUPPORTED 

The machine is connected to an unsupported USB 
hub. Remove the hub. 

PLEASE DETACH IT 
UNSUPPORTED USB DEVICE DETECTED 

The machine is connected to an unsupported USB 
device. Remove the USB device. 

PLEASE DETACH IT 
UNRECOGNIZED USB DEVICE 

The USB device connected to the device was not 
recognized correctly. Remove the USB device. 

□ 
SNTP SERVER COMMUNICATION ERROR 

Failed to retrieve the time from the SNTP server. 
Check the network settings. 

□ 
FILE OPERATION FAILED [FS_ERR] 

An error occurred in the internal file system of the 
machine. Operations that do not use the file system 
can be performed. 
The error is cleared when the following print data is 
received. 

PRESS OK BUTTON 
INVALID DATA 

Invalid data was received. 
Press «OK» button to clear the error. 

CHANGE IPV4 ADDRESS 
IPV4 ADDRESS IS CONFLICTED 

The IPv4 address is the same as another device. 
Check the IPv4 address. 

PAPER DETECTION ERROR 
[ERRCODE]:ERROR [SUBCODE] 

The paper sensor could not detect the paper 
correctly. 
Check the position, cleanliness, and settings of the 
paper sensor. 
The meaning of [SUBCODE] is indicated below. 
0 to 6: An error has occurred in the bottom sensor. 
11 to 15: An error has occurred in the top sensor. 
21 to 26: An error has occurred in the translucent 
sensor. 

CHANGE [MEDIA_SIZE] [MEDIA_TYPE] 
PRESS OK BUTTON 

The paper type of the paper loaded in the machine 
does not match the print data. Load the correct paper 
to the machine. Press «OK» button when loading of 
the paper is complete. 

RESTART PRINT? 
OK OR FEED/CUT 

Press «OK» button to resume printing immediately. 
Press «FEED/CUT» button to resume printing after 
cutting the paper at the proscribed position. 
Press «CANCEL» button to return to the standby 
screen without printing. 

REDUCE PRINT DATA 
[ERRCODE]:MEMORY OVERFLOW 

The print data is too complex. Attach extra memory 
or reduce the size of the print data. 
This error is automatically cleared after approximately 
15 seconds. 
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Message Description 
PRESS OK BUTTON 
[ERRCODE]:WIRELESS STARTUP ERROR 

The wireless LAN module is not correctly connected 
to the machine. 
Correctly connect the wireless LAN module to the 
machine or turn the machine off and then on again. 
Press «OK» button to clear this message. 

PRESS OK BUTTON [ERRCODE]: 
WIRELESS SETTINGS ARE 
INCOMPLETE 

The wireless LAN settings are insufficient. 
Press «OK» button to clear this message. 

PRESS OK BUTTON 
[ERRCODE]:NOT CONNECTED TO WIRELESS 
ACCESS POINT 

The machine is not connected to the wireless access 
point. 
Press «OK» button to clear this message. 

NETWORK CONFIG 
WRITING 

Network related settings are being configured. 

WAIT A MOMENT 
NETWORK INITIAL 

Network related settings are being initialized. 

DOWNLOAD MESSAGE 
PROCESSING 

Message data for updating is being processed. 

DOWNLOAD MESSAGE 
WRITING 

Message data for updating is being written. 

DOWNLOAD MESSAGE 
SUCCESS 

Writing of message data for updating succeeded. 
The machine then restarts. 

DOWNLOAD MESSAGE 
FAILED[ERRCODE] 

Writing of message data for updating failed. 

PRESS OK BUTTON FOR RESTORATION 
[ERRCODE]:RECEIVING DATA TIMEOUT 

A timeout has occurred while receiving data. 
This error is automatically cleared after approximately 
15 seconds. 

PLEASE TRY AGAIN 
[ERRCODE]:FW UPDATE ERROR.IF NETWORK 
DOESN'T WORK,PLEASE TRY FW UPDATE OVER 
USB 

Failed to update the firmware. 
Execute the firmware update again. 

LOAD [MEDIA_SIZE] 
490 :FEEDER EMPTY 

The paper has run out. Load paper to the machine. 

REPLACE TONER 
412:TONER EMPTY 

The toner has run out. Replace the toner cartridge 
with a new one. 

TONER NOT RECOMMENDED 
556:ERROR 

Replace the toner cartridge with a recommended 
one. 

INSTALL TONER 
[ERRCODE]:TONER MISSING 

A toner cartridge is not installed in the machine. Set 
the toner cartridge in the machine. 

IMAGE DRUM NOT RECOMMENDED 
692, 702, 706, 686:ERROR 

Replace the image drum unit with a recommended 
one. 
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Message Description 
UNKNOWN CONSUMABLEGO TO USER MANUAL 
"TROUBLE SHOOTING" 
709 

You can use any consumables in your product, but 
you must accept the risks of using non-genuine 
consumables. 
If the use of non-genuine consumables causes 
damage to the product or results in your product not 
functioning to its full specification, then such damage 
or effect on the product is not covered by warranty. 
To accept these risks and to restore function; (1) Turn 
off your product. 
(2) Press and hold the «CANCEL» button and turn 
your product on. 
(3) After start up, release the «CANCEL» button. 
Note: This operation will be recorded for future 
reference. 

OPEN TOP COVER 
[ERRCODE]:PAPER SIZE ERROR 

Paper of an inappropriate size has been fed. Check 
whether the loaded paper size is correct or whether 
multiple sheets of paper have been fed. Then open 
and close the top cover. 

CHECK FEEDER 
390:PAPER JAM 

A paper jam occurred while supplying paper. 
Remove the paper jam. Or the cut type setting and 
paper sensor position of the machine do not match. 
Change the position of the top sensor and bottom 
sensor so that they do not overlap if their positions 
were matching. Change the position of the top 
sensor and bottom sensor so that they match if they 
were not overlapping. 

OPEN TOP COVER 
[ERRCODE]:PAPER JAM 

A paper jam occurred while feeding paper. Remove 
the paper jam. 

ERRCODE 380: Feed 
ERRCODE 381: Transport 
ERRCODE 382: Exit 
ERRCODE 389: Printing Page Lost 

CHECK CUTTER UNIT 
[ERRCODE]-02:ERROR 

An error has occurred in the cutter unit. Check the 
cutter unit. 

MARK NOT FOUND 
[ERRCODE]-06:ERROR 

The paper mark could not be found. Check the 
position of the paper sensor. 

REPLACE IMAGE DRUM 
[ERRCODE]:IMAGE DRUM LIFE 

The image drum unit has reached the end of its 
lifetime. Replace the image drum unit with a new 
one. 

REPLACE FUSER UNIT 
[ERRCODE]:FUSER UNIT LIFE 

The fuser unit has reached the end of its lifetime. 
Replace the fuser unit with a new one. 

REPLACE BELT UNIT 
[ERRCODE]:BELT UNIT LIFE 

The transfer belt unit has reached the end of its 
lifetime. Replace the transfer belt unit with a new 
one. 

CHECK IMAGE DRUM AND TONER CARTRIDGE 
546:TONER CARTRIDGE MISSING 

An error has occurred in the toner cartridge. Remove 
the toner cartridge, and set it again. 

IMAGE DRUM MISSING 
342:ERROR 

The image drum unit is not set correctly. Set the 
image drum unit again. 
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Message Description 
CHECK FUSER UNIT 
[ERRCODE]:FUSER UNIT MISSING 

The fuser unit is not set correctly. Set the fuser unit 
again. 

CLOSE [COVER] 
[ERRCODE]:[COVER] OPEN 

The displayed cover is open. Close the cover. 
ERRCODE 310: Top cover 
ERRCODE 589: Feeder cover 

CLOSE TONER REPLACEMENT COVER 
586:TONER COVER OPEN 

The toner replacement cover is open. Close the 
toner replacement cover. 

WAIT A MOMENT 
REBOOTING [%CODE%] 

The machine is restarting. Wait until the machine 
restarts. 

SHUTTING DOWN. PLEASE WAIT 
TURN OFF AUTOMATICALLY 

The machine is shutting down. Wait until the power 
turns off. 

TURN OFF POWER 
SHUTDOWN COMPLETED 

The shutdown process of the machine is complete. 
Turn the machine off. 

POWER OFF/ON 
[ERRCODE]:ERROR 

A critical error has occurred in the machine. Turn the 
machine off and then on again. If the machine does 
not recover, contact your dealer. 
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Connection Problems 
 Network Connection Problems 

 
Cause Remedy Reference 

A cross cable is being used. A cross cable is being used. Use a 
straight cable. 

- 

The machine was turned on before 
connecting the cable. 

Turn the machine on after 
connecting the cable. 

 Connecting a LAN Cable 

There is a compatibility problem 
with the hub. 

Select the correct connection in 
[ADMIN MENU] > [NETWORK 
SETUP] > [HUB LINK SETTING] 
of the menu. 

- 

The network connection settings 
are not suitable. 

To connect to a wired network, 
set [WIRED] to [Enabled] for the 
network connection. 

 Connecting a LAN Cable 
 Using Both a Wired LAN and 
Wireless LAN Connection 

The IP addresses are incorrect. • Check whether the IP address 
of the machine matches the IP 
address of the machine set in 
the computer. 

• Check whether the IP address is 
the same as another device. 

• Check whether the IP address, 
subnet mask, and gateway 
address are correct. 

 Checking Information About the 
Machine 

The WSD port is being used. Change the destination port for 
printing to the standard TCP/IP 
port. 

- 

 
 

  Wireless LAN Connection Problems 
 

Cause Remedy Reference 
The wireless LAN module is not 
enabled. 

Set [WIRELESS MODULE] in 
[BOOT MENU] to [ENABLE]. 

 Menu List 
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Cause Remedy Reference 
The network connection settings 
are not suitable. 

• [WIRELESS 
(INFRASTRUCTURE)] and 
[WIRELESS (AP MODE)] 
cannot be enabled at the same 
time. 

• To connect with [WIRELESS 
(INFRASTRUCTURE)], set 
[WIRELESS (AP MODE)] 
to [DISABLE] and then set 
[WIRELESS 
(INFRASTRUCTURE)] to 
[ENABLE]. 

• To connect with [WIRELESS 
(AP MODE)], set [WIRELESS 
(INFRASTRUCTURE)] to 
[DISABLE] and then set 
[WIRELESS 
(AP MODE)] to [ENABLE]. 

 Connecting via Wireless LAN 

[WIRELESS 
(INFRASTRUCTURE)] 
The machine is not connected to 
the wireless LAN access point. 

• Check whether the wireless LAN 
access point is turned on. 

• Check the settings of the 
wireless LAN access point, and 
perform manual or automatic 
setup. 

• Restart the wireless LAN 
function. 

• Select [ADMIN SETUP] 
> [NETWORK SETUP] 
> [ENABLING DEFAULT 
GATEWAY] > [WIRELESS 
(INFRASTRUCTURE)], and then 
select [RECONNECTION]. 

• Place the machine in a location 
near the wireless LAN access 
point with high visibility. (A 
distance of 30 m or less is 
recommended) 
Do not place an electric product 
that emits weak radio waves 
(such as a microwave oven or a 
digital cordless telephone) near 
the machine. 
If there is metal, aluminum 
window frame, or a reinforced 
concrete wall between the 
machine and the wireless LAN 
access point, connections may 
be harder to establish. 

 Connecting via Wireless LAN 
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Cause Remedy Reference 
[Wireless (AP Mode)] 
A wireless device (such as a 
computer, tablet, or smartphone) is 
not connected to the machine. 

• Check whether [WIRELESS 
(AP MODE)] is set to [ENABLE] 
in the machine. 

• Check the SSID/password of the 
machine, and perform manual 
setup. 

• Perform connection in a location 
near the machine with good 
visibility. 

• A maximum of four devices can 
be connected to the machine 
with the wireless (AP mode). 
Additional devices cannot be 
connected. Try connecting again 
after disconnecting a device. 

 Connecting via Wireless LAN 

The IP addresses are incorrect. • Check whether the IP address 
of the machine matches the IP 
address of the machine set in 
the computer. 

• Check whether the IP address is 
the same as another device. 

• Check whether the IP address, 
subnet mask, and gateway 
address are correct. 

 Checking Information About the 
Machine 

The WSD port is being used. Change the destination port for 
printing to the standard TCP/IP 
port. 

- 

 
 

  USB Connection Problems 
 

Cause Remedy Reference 
The cable standard does not 
match. 

Use a USB cable that conforms to 
the USB 2.0 standard. 

- 

A USB hub is being used. Directly connect the machine to 
the computer. 

 Connecting a USB Cable 

The printer driver is not installed 
correctly. 

Reinstall the printer driver.  Installing the Printer Driver to a 
Computer 
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Print Result Problems 
  List of Print Result Problems 

 
White streaks appear in the vertical 
direction 

 

 
Feed direction 

Horizontal white streaks periodically appear 
in the paper feed direction 

 

 
Feed direction 

The printing is faint in the vertical direction 
 
 

 
Feed direction 

Printing is light White dots and lines appear Condensation occurs in the printed paper 

Streaks appear in the vertical direction 
 

 

  
Feed direction  

Dots and horizontal streaks periodically 
appear in the paper feed direction 

Feed direction  

White background areas are faintly dirty 

 

 
 

Bleeding occurs around text 

 

 
 

Toner comes off when rubbed 

 

 

Gloss is uneven 

 

 
 

Black dots or white dots appear Dirt is printed 

 

 
 

The entire page is printed in black 

 

 
 

Nothing is printed Parts of the image are missing 

 

 

The area around the image is dirty 

The colors of the image are unexpected The black of CMY 100% is light The precision of barcode reading is low 
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  White Streaks Appear in the Vertical Direction 
 

 

Cause Remedy Reference 
The LED head is dirty. Wipe the LED head clean with a soft 

tissue. 
 Cleaning the LED Head 

Toner is low. If [REPLACE TONER] or [TONER 
EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 

The lightproof film of the image 
drum unit is dirty. 

Wipe the lightproof film clean with a 
soft tissue. 

 Replacing the Image Drum 
Unit 

The image drum unit is not set 
correctly. 

Set the image drum unit correctly.  Replacing the Image Drum 
Unit 

Foreign material is stuck in the 
image drum unit. 

Replace the image drum unit.  Replacing the Image Drum 
Unit 

 
 

  Horizontal White Streaks Periodically Appear in the Paper Feed 
Direction  

 

 

Cause Remedy Reference 
The image drum unit is not set 
correctly. 

Set the image drum unit correctly.  Replacing the Image Drum 
Unit 

The image drum is dirty. Enable drum cleaning. 
The lifetime of the image drum unit is 
shorter when this is set to ON. 

 Using the Operation Panel 

The image drum is dirty. Replace the image drum unit.  Replacing the Image Drum 
Unit 
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  The Printing Is Faint in the Vertical Direction 
 

 

Cause Remedy Reference 
The LED head is dirty. Wipe the LED head clean with a soft 

tissue. 
 Cleaning the LED Head 

Toner is low. If [REPLACE TONER] or [TONER 
EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 

 
 

  Printing Is Light 
 

 

Cause Remedy Reference 
Toner is low. If [REPLACE TONER] or [TONER 

EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 

The paper contains humidity. Use paper that is stored in 
an environment with suitable 
temperature and humidity. 

 Loading Paper 

The paper is not suitable. 
The paper weight setting is not 
suitable. 

Set [MENUS] > [FEEDER CONFIG] 
> [MEDIAWEIGHT] to a suitable 
value on the operation panel. Or, set 
[MEDIAWEIGHT] to a heavier value. 

 Loading Paper 

The toner save mode is enabled Set [ADMIN MENU] > [PRINT 
SETUP] > [TONER SAVE] to [OFF] 
in the menu. 

 Reducing Toner Consumption 
when Printing 
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  White Dots and Lines Appear 
 

 

Cause Remedy Reference 
The paper contains humidity or is 
dry. 

Use paper that is stored in 
an environment with suitable 
temperature and humidity. 

 Loading Paper 

 
 

  Condensation Occurs in the Printed Paper 
 

 

Cause Remedy Reference 
The paper contains humidity. Use paper that is stored in 

an environment with suitable 
temperature and humidity. 

 Loading Paper 

The machine is used in a location 
with high humidity or rapid 
changes in temperature and 
humidity. 

Use the machine in an environment 
with suitable temperature and 
humidity. 

 Installation 

 
 

  Streaks Appear in the Vertical Direction 
 

 

Cause Remedy Reference 
Toner is low. If [REPLACE TONER] or [TONER 

EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 

The image drum is damaged. Replace the image drum unit.  Replacing the Image Drum 
Unit 
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  Dots and Horizontal Streaks Periodically Appear in the Paper Feed 
Direction  

 

 

Cause Remedy Reference 
If the period is approximately 
63 mm, the glossy cylinder of the 
image drum is damaged or dirty. 

Gently wipe it with a soft tissue. 
Replace the image drum unit if it is 
damaged. 

 Replacing the Image Drum 
Unit 

If the period is approximately 
26 mm, foreign material is 
attached to the electrostatic roller 
in the image drum. 

Open and close the top cover or 
feeder cover, and perform printing 
again. 

 Names of Components 

The image drum unit has been 
exposed to light. 

Return the image drum unit to the 
inside of the machine and do not use 
the machine for several hours. 
If this does not solve the problem, 
replace the image drum unit. 

 Replacing the Image Drum 
Unit 

 
  White Background Areas Are Faintly Dirty 

 

 

Cause Remedy Reference 
The paper is has an electrostatic 
charge. 

Use paper that is stored in 
an environment with suitable 
temperature and humidity. 

 Loading Paper 

Heavy paper is being used. Use lighter paper.  Loading Paper 
Toner is low. If [REPLACE TONER] or [TONER 

EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 
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  Bleeding Occurs Around Text 
 

 

Cause Remedy Reference 
The LED head is dirty. Wipe it clean with a soft tissue.  Cleaning the LED Head 
The paper contains humidity. Replace the paper with new paper.  Loading Paper 

 
  Toner Comes off When Rubbed 

 

 

Cause Remedy Reference 
The paper weight setting is not 
suitable. 

Set [MENUS] > [FEEDER CONFIG] 
> [MEDIAWEIGHT] to a suitable 
value on the operation panel. Or, set 
[MEDIAWEIGHT] to a heavier value. 

 Loading Paper 

 
 

  Gloss Is Uneven 
 

 

Cause Remedy Reference 
The paper weight setting is not 
suitable. 

Set [MENUS] > [FEEDER CONFIG] 
> [MEDIAWEIGHT] to a suitable 
value on the operation panel. Or, set 
[MEDIAWEIGHT] to a heavier value. 

 Loading Paper 
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  Black Dots or White Dots Appear 
 

 

Cause Remedy Reference 
If the period is approximately 
63 mm, the glossy cylinder of the 
image drum is damaged or dirty. 

Gently wipe the image drum with a 
soft tissue. 
Replace the image drum unit if it is 
damaged. 

 Replacing the Image Drum 
Unit 

 
 

  Dirt Is Printed 
 

 

Cause Remedy Reference 
The paper contains humidity. Replace the paper with new paper.  Loading Paper 

 
  The Entire Page Is Printed in Black 

 

 

Cause Remedy Reference 
The machine may have failed. Contact your dealer. - 
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  Nothing Is Printed 
 
 
 
 
 
 
 

Cause Remedy Reference 
The machine may have failed. Contact your dealer. - 

 
 

  Parts of the Image Are Missing 
 

 

Cause Remedy Reference 
The paper contains humidity. Replace the paper with new paper.  Loading Paper 

 
 

  The Area Around the Image Is Dirty 
 

 

Cause Remedy Reference 
The image is not reduced to a 
ratio that matches the paper size. 

Reduce the image to a ratio that 
matches the paper size. 

 Keeping the Page Layout 
when Resizing a Document 
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  The Colors of the Image Are Unexpected 
 
 
 
 
 
 
 
 

Cause Remedy Reference 
Toner is low. If [REPLACE TONER] or [TONER 

EMPTY] is displayed, replace the 
toner cartridge. 

 Replacing the Toner Cartridge 

The toner adjustment was 
changed. 

The toner adjustment was changed. 
Perform color matching from the 
printer driver. 

 Changing the Color Settings 

The color balance has not been 
adjusted. 

Select [CALIBRATION] in the menu, 
and execute [ADJUST DENSITY], 
or [CYAN TUNING], [MAGENTA 
TUNING], or [YELLOW TUNING]. 

 Correcting the Color Density 
 Adjusting the Color Balance 
(Density) 

Color shift has not been adjusted. Open and close the top cover. Or, 
execute [CALIBRATION] > [ADJUST 
REGISTRATION] on the menu. 

 Names of Components 
 Menu LIst 

[Replace mono barcode with 
cyan] is enabled. 

From the [Setup] tab, go to [Barcode 
correction] > [Options] and deselect 
[Replace mono barcode with cyan]. 

 Correcting Barcodes for 
Printing 

Bar Width Adjustment is enabled. Disable Bar Width Adjustment on the 
[Setup] tab > [Barcode Correction] > 
[Options] of the printer driver. 

 Correcting Barcodes for 
Printing 

 
 

  The Black of CMY 100% Is Light 
 

 

Cause Remedy Reference 
[CMY100% DENSITY] is set to 
[ENABLE]. 

Set [ADMIN MENU] > [COLOR 
MENU] > [CMY100% DENSITY] to 
[ENABLE] on the menu. 

- 
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  The Precision of the Barcode Reading Is Low 
 
 
 
 
 
 
 

Cause Remedy Reference 
The color of barcodes/two- 
dimensional barcodes is light 

Disable the toner save function if it is 
enabled. 
If the remaining toner is low, replace 
the toner cartridge. 

 Reducing Toner Consumption 
when Printing 

 Replacing the Toner Cartridge 

Barcodes/two-dimensional 
barcodes are printed in a color 
that is difficult to scan 

Create barcodes/two-dimensional 
barcodes in cyan (RGB 0,255,255), 
and set the color setting of the printer 
driver to [Automatic] for printing. 

 Correcting Barcodes for 
Printing 

Small barcodes/two-dimensional 
barcodes are printed in black 

If the size of the barcodes/two- 
dimensional barcodes to print can 
be changed, increase the size for 
printing. 
If the color can be set for barcodes/ 
two-dimensional barcodes in the 
application, set the color to cyan 
(RGB 0,255,255), and set the 
color setting of the printer driver to 
[Automatic] and perform printing. 
If the color of barcodes/two- 
dimensional barcodes is fixed to 
black, select [Replace mono barcode 
with cyan] in [Barcode Correction], 
and perform printing. 

 Correcting Barcodes for 
Printing 

Bars are thick Disable [Adjust ultra fine lines] in 
[Advanced] in the printer driver. 
If the bar width can be adjusted in 
the application, set a bar width that is 
narrower than the width of the space, 
and perform printing. 
If the bar width cannot be adjusted 
in the application, set a narrower bar 
width in [Bar Width Adjustment] in 
[Barcode Correction], and perform 
printing. 
If the bar width cannot be adjusted in 
the application and the printer driver 
is not used, set a narrower bar width 
in [ADMIN SETUP] > [PRINT 
SETUP] > [BARCODE ADJUST] in 
the panel settings of the machine, 
and perform printing. 

 Correcting Faintness in Thin 
Lines and Small Text 

 Correcting Barcodes for 
Printing 
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Software Problems 
  Web Browser Problems 

 
Symptom Cause/Solution Reference 

Cannot connect to the machine. The LAN cable is disconnected. 
Check the connection of the LAN 
cable. 

 Connecting a LAN Cable 

The IP addresses are incorrect. 
Check the IP address of the machine, 
and enter the correct address. 

 Starting the Webpage 

 
  Windows Problems 

• USB Connection Problems 
 

Symptom Cause/Solution Reference 
An icon for the machine is 
not created in [Devices and 
Printers]. 

The printer driver is not installed 
correctly. 
Correctly reinstall the printer driver. 

 Installing the Printer Driver to 
a Computer 

Another printer driver cannot be 
installed when a printer driver is 
already installed. 

Refer to the reference procedure to 
execute a custom installation. 

 Installing Software 

An error message such as 
"Failed to install the printer 
driver" is displayed. 

Use plug-and-play. 
Follow the procedure indicated 
below. 
1. Make sure that the machine and 

the computer are turned off. 
2. Connect a USB cable. 
3. Turn on the machine. 
4. Turn on the computer. 
5. When [Found New Hardware 

Wizard] is displayed, follow the 
instructions on the screen to 
execute setup. 

- 
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• Problems Common to the Printer Driver and Utilities 
 

Symptom Cause/Solution 
[Help] is not displayed. The help function is not supported. 
The [User Account Control] screen is 
displayed. 

The [User Account Control] screen may be displayed when 
starting the installer or a utility. Click [Yes] or [Continue] to 
execute the installer or utility as an administrator. If you click 
[NO], the installer or utility is not started. 

The [Program Compatibility Assistant] 
screen is displayed. 

If the [Program Compatibility Assistant] dialog box is displayed 
after installation is complete (including when the installation is 
stopped before it is complete), make sure to click [This program 
installed]. 
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Machine Problems 
 

The Machine Does Not Operate 
 

Cause Remedy Reference 
The power cord is not inserted 
properly. 

Insert the power cord fully.  Turning On the Machine 

This machine is not turned on. Turn the machine on.  Turning On the Machine 
 
 

Nothing Is Displayed on the Screen when the Power Is Turned On 
 

Cause Remedy Reference 
The power cord is disconnected. Insert the power cord fully.  Turning On the Machine 
A power failure has occurred. Check whether power is supplied to 

the outlet. 
- 

 
 

Printing Does Not Start 
 

Cause Remedy Reference 
An error is displayed. Check the error messages and follow 

the on-screen instructions. 
 List of Messages 

The LAN cable/USB cable is not 
inserted. 

Insert the LAN cable/USB cable fully.  Using the Machine 

There is a problem with the LAN 
cable/USB cable. 

Use another LAN cable/USB cable. - 

The LAN cable/USB cable does 
not match the required standard. 

• Use a cable that conforms to the 
USB 2.0 standard. 

• Use a cable that conforms to the 
Ethernet 10BASE-T/100BASE-TX 
standard. 

- 

There may be a problem with the Execute [PRINT INFO] >  Printing and Checking a 
print function. [CONFIGURATION] on the operation Report 
 panel to print the settings, and check  
 the print performance.  

The communication protocol is Select [ADMIN SETUP] > - 
disabled. [NETWORK SETUP] in the menu,  
 and enable the communication  
 protocol that is used.  

The printer driver is not selected. Set the printer driver as the default 
printer. 

- 

The output port of the printer 
driver is incorrect. 

Specify the output port where the 
LAN cable/USB cable is connected. 

- 
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Cause Remedy Reference 
The machine is warming up to 
recover from the Power Save 
mode or Sleep mode. 

Lengthen the time until the machine 
enters the Power Save mode or 
Sleep mode. 
Select [MENUS] > [SYSTEM 
ADJUST] > [POW SAVE TIME] or 
[SLEEP TIME] on the operation 
panel, and set an appropriate time. 

 Setting the Power Save Mode 
Transition Time 

 Setting the Sleep Mode 
Transition Time 

The image drum cleaning 
operation may be executing. 

Wait until the machine finishes. - 

The temperature of the fuser unit 
is being adjusted. 

Wait until the machine finishes. - 

Data is being processed from 
another interface. 

Wait until the printing process is 
complete. 

- 

 
 

  Print Data Is Not Sent 
 

Cause Remedy Reference 
The LAN cable/USB cable is 
damaged. 

Connect a new cable. - 

The computer has timed out. Set a longer timeout period. - 

 
  An Abnormal Smell Is Emitted 

 
Cause Remedy Reference 

The machine is not level. Install the machine in a flat and 
stable location. 

- 

Paper waste or foreign material is 
inside the machine. 

Inspect the inside the machine and 
remove the material. 

- 

 
  A Resonant Sound Is Emitted 

 
Cause Remedy Reference 

Printing is being performed on 
heavy paper, etc. when the 
internal temperature of the 
machine has risen. 

This is not a problem with the 
machine. Keep using the machine as 
it is. 

- 
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  Printing Stops Before It Is Complete 
 

Cause Remedy Reference 
Temperature adjustment is being 
performed because the internal 
temperature of the machine has 
risen due to continuous printing 
over a long period, etc. 

Wait until the machine finishes. 
Printing will automatically resume 
when the temperature of the machine 
is suitable. 

- 

The temperature of the fuser unit 
is being adjusted. 

Wait until the machine finishes. - 

 
  Memory Runs Out 

 
Cause Remedy Reference 

The print data is complex. Use simpler print data. - 

 
  Printing Is Slow 

 
Cause Remedy Reference 

Printing is also being processed 
on the computer. 

Use a computer with a faster 
processing speed. 

- 

Select [Fine / Detail 
(1200 x 1200 dpi)] in [Quality] 
on the [Setup] tab of the printer 
driver. 

Select [Normal (600 x 600 dpi)] or 
[Draft (600 x 600 dpi)] in [Quality] on 
the [Setup] tab of the printer driver. 

- 

The print data is complex. Use simpler print data. - 

 
  The Power Turns Off Automatically 

 
Cause Remedy Reference 

If the machine is not used for a 
certain period of time (4 hours by 
default), it automatically turns off. 

To prevent the power from turning 
off, set [ADMIN SETUP] > [POWER 
SETUP] >[AUTO PW OFF] to 
[DISABLE] on the operation panel. 

 Setting the Auto Power Off 
Time 
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Paper Problems 
  Paper Jams Frequently Occur/The Paper Is Pulled in at an Angle 

 
Cause Remedy Reference 

The machine is not level. Install the machine in a flat and 
stable location. 

- 

The paper is too light or too 
heavy. 

The paper is too light or too heavy. 
Use paper that is suitable for the 
machine. 

 Loading Paper 

The paper contains humidity or 
has an electrostatic charge. 

Use paper that is stored in 
an environment with suitable 
temperature and humidity. 

 Loading Paper 

The paper is wrinkled or warped. Use paper that is suitable for the 
machine. If the paper is warped, fix 
it. 

 Loading Paper 

The paper is not loaded straight. Align the paper guide with the paper.  Loading Paper 

 
  The Machine Does Not Recover When the Paper Jam Is Removed 

 
Cause Remedy Reference 

The machine may not recover 
unless the top cover or feeder 
cover is opened and closed. 

Open and close the top cover or 
feeder cover. 

 Names of Components 

The combination of the cut type 
setting and paper sensor position 
of the machine does not match. 

Change the position of the top 
sensor and bottom sensor so that 
they do not overlap if their positions 
were matching. 
Change the position of the top sensor 
and bottom sensor so that they 
match if they were not overlapping. 

 Setting the Paper Sensors 

 
  The Paper Curls/The Paper Wrinkles 

 
Cause Remedy Reference 

The paper contains humidity or 
has an electrostatic charge. 

Use paper that is stored in 
an environment with suitable 
temperature and humidity. 

 Loading Paper 

Light paper is being used. Set [MENUS] > [FEEDER CONFIG] 
> [MEDIAWEIGHT] to a lighter value 
on the operation panel. 

 Loading Paper 
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  The Paper Gets Stuck in the Roller of the Fuser Unit 
 

Cause Remedy Reference 
The paper weight setting is not 
suitable. 

Set [MENUS] > [FEEDER CONFIG] 
> [MEDIAWEIGHT] to a suitable 
value on the operation panel. Or, set 
[MEDIAWEIGHT] to a heavier value. 

 Setting Paper Information on 
the Operation Panel 

Light paper is being used. Use heavier paper.  Paper Specifications 
There is an area near the tip 
of the paper that is almost 
completely printed. 

Try adding a margin to the paper tip. - 

 
  Paper Sticks to the Transfer Belt Unit 

 
Cause Remedy Reference 

Light paper or weak paper is 
being used. 

Use heavier paper. - 

 
  Paper Corners Are Folded 

 
Cause Remedy Reference 

The paper is curled. The paper is curled. Use paper that 
is stored in an environment with 
suitable temperature and humidity. 

 Loading Paper 

 
  The "308:PAPER JAM" error occurs when paper is not loaded  

 
Cause Remedy Reference 

There may have been a problem 
with the position of the paper 
sensors when sensor calibration 
was executed, which caused an 
invalid value to be detected. 

Execute [BOOT MENU] > [SENSOR 
RESET] on the operation panel. 

 BOOT MENU 
Adjusting the Paper Sensors 
(Sensor Calibration) 
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When a Power Failure Occurs 
When a power failure occurs, the machine operates as follows. 

 
 

Machine Status Operation 
Receiving Reception is interrupted. 
Printing Printing is interrupted. 

When the power supply recovers, start printing again. 
Standby Printing cannot be started. 

 

• If a power failure occurs while the machine is turned on, the machine does not turn on when the 
power supply resumes. 

• If you want the machine to automatically turn on when the power supply resumes after a power failure, 

set [BOOT MENU] > [POWER RETURN] to [ALWAYS ON] or [LAST STATE]. 

• Operation is not guaranteed if an uninterruptible power supply (UPS) or inverter is used. Do 

not use an uninterruptible power supply (UPS) or inverter. 
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Moving the Machine 

1 Turn off the machine. 
 
 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

2 Unplug all the cables. 
• Power cord 

• LAN cable/USB cable 

3 Remove the loaded paper. 

4 Lift up the machine and move it to the destination. 



230  

Transporting the Machine 
 

• Use the packaging, cushioning material, and cover toner that came with the machine when the 
product was purchased. 

 

1 Turn off the machine. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

2 Unplug all the cables. 
• Power cable 

• LAN cable/USB cable 

3 Remove the loaded paper. 

4 If a wireless LAN module is attached, remove it. 

5 Remove the toner cartridge. 

6 Attach the cover toners that were stored to replace the removed toner cartridge. 

7 Attach the cushioning materials. 

8 Insert the machine into the packaging. 
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Before Leaving the Machine 
Before leaving the machine, it is strongly recommended that you erase the information 
registered or saved to the machine. 

To delete the information, execute [ADMIN SETUP] > [OTHERS SETUP] > [ERASE 

PRIVACY DATA]. The information saved in the machine includes the following items. 

 
• Administrator password 

• Values registered to menus 

• Demonstration page data registered by users 

• Form data registered by users 

• Saved menu settings 

• Certificate 
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233 
 

 
 

 Management Software 
 
 
 

 

Type of Software 
Installing Software 
Web Page 
Configuration Tool 
Status Monitor 

 
 

10 
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Type of Software 

 
• System Requirements 

Windows 10/Windows 8.1/Windows 8/Windows 7 

Windows Server 2016/Windows Server 2012 R2/Windows 

Server 2012 Windows Server 2008 R2/Windows Server 2008 

 
Software Name Description 

Configuration Tool Changes the menu settings of the machine, performs cloning, and sets the 
network of the machine. 
Also enables form data to be registered and deleted. 

Web Page Configures the network settings of the machine. 
Status Monitor A utility for monitoring the status of the printer. Also enables the information 

included in the following reports to be retrieved as a CSV file. 
• Setting 
• Error Log 
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Installing Software 
Obtain the "Software DVD-ROM" or the software you want to install from the provider of your 
machine, and install the required software. 

When using the "Software DVD-ROM," select the software to install from the following list of 
software. 

- PCL6 Printer Driver 

- Configuration Tool 

- Status Monitor 
 
 
Connect the machine to the Internet or connect to a computer with a USB cable, and start 
installing. 
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Web Page 
Configures the network settings of the machine. 

 
 

  Web Page Settings  

• System 
 

 

Item Description 

Status Displays the current status of the machine. Displays 
warnings and errors that have occurred in the machine. 
Also enables you to check the operation status of the 
network services, a list of the machine information, and 
the IP address set in the machine. 

Counter Displays the print count. 

Network Enables you to check information on the network 
settings, such as the general information, TCP/IP status, 
and maintenance information. 

 
 

• Admin Setup 
This function is displayed when you are logged in to the machine as an administrator. 
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• Network Management 
 

 

Item Description 

General Network Settings Configures the network connection method. 

Wireless LAN (Infrastructure) Setting Configures wireless LAN (infrastructure). 

Wireless (AP Mode) Setting Configures wireless (AP mode) connections. 

TCP/IP Configures information regarding TCP/IP. 

NBT Configures information regarding NetBIOS over TCP. 

E-mail Alert Setting Configures e-mail notifications for errors that have 
occurred in the machine, etc. 

 E-mail alert 

SNMP Setting Configures SNMP. 

Trap Configures SNMP Trap. 

SNTP Configures SNTP. 

IPP Setting Configures information regarding IPP printing. 

Windows Rally Configures information regarding Windows Rally. 

IEEE802.1X Configures information regarding IEEE802.1X/EAP. 
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Item Description 

Security Protocol ON/OFF Disables network protocol and network services that are 
not used. 

IP Filtering Restricts access via TCP/IP. Also supports access from 
outside the company. However, this function requires 
knowledge regarding IP addresses. Incorrect settings 
may lead to serious trouble, such as becoming unable to 
access the machine from the network. 

MAC Address Filtering Restricts access by MAC address. Also supports access 
from outside the company. However, this function 
requires knowledge regarding MAC addresses. Incorrect 
settings may lead to serious trouble, such as becoming 
unable to access the machine from the network. 

Encryption (SSL/TLS) Enables communication between the computer (client) 
and the machine to be encrypted. 

IPSec Enables communication between the computer (client) 
and the machine to be encrypted and modification to be 
prevented. 

Web Page 
Authentication Method 

Configures the Web Page authentication method. 

Maintenance Restart/Initialize Restarts or initializes the network. When the network is 
restarted, the Web page is not displayed from a Web 
browser until the restart process is complete. When 
the network is initialized, information that has been set 
manually is lost because the IP address is initialized. The 
Web page also cannot be displayed. 

Network Scale This setting enables the machine to operate on the 
network more efficiently. When using a hub with the 
spanning tree function, this setting is effective if the 
machine is connected to a computer via a cross cable. 
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  Starting the Web Page  
 

• Set the security of your browser to the medium level or enable cookies. 

• A password is required to enter the [Admin Setup] menu. The default password is "999999." 

• You must log in as the administrator to change the settings of the machine via the Web page. 
 
 

The example environment used in the following description is indicated below. 

• Machine name: Pro330 

• Machine IP address: 192.168.0.2 
 

1 Start the Web browser. 
2 Enter the URL ("http://(IP address of the machine)") in the address bar, and press the 

<Enter> key. 
 

• For information on checking the IP address of the machine, refer to "Printing and Checking a Report". 
 

 
 

• When including a one digit or two-digit number in the IP address, do not enter zeros before the 

number. Doing so may prevent communication from being performed correctly. 

- Correct: http://192.168.0.2/ 
- Incorrect: http://192.168.000.002/ 

http://192.168.0.2/ 
http://192.168.000.002/ 
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  Logging In as the Administrator  
You must log in as the administrator to change the settings of the machine via a Web browser. 

 
1 Click [Admin Login]. 

 

2 Enter "admin" in [User Name] and the current password in [Password], and click [OK]. 

 
 

• The password is the same as the administrator password for the operation panel. 

• The default administrator password is "999999." If the administrator password has been 

changed, enter the changed password. 
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3 Set the printer information that can be checked on the network, and click [OK] or [SKIP]. 

 
 

• Settings can be omitted by clicking [SKIP]. 

• Select [Do not show this page again] and click [OK] or [SKIP] to prevent this from being displayed 
again. 

 

4 The following screen is displayed. 
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  Checking or Changing the Status of the Machine  
The following operations can be executed from the Web page on a computer. 

• Displaying the machine status 

• Configuring the machine 
 
 

System Requirements 
 

• Set the security of your browser to the medium level or enable cookies. 

• A password is required to enter the [Admin Setup] menu. The default password is "999999." 

• You must log in as the administrator to change the settings of the machine via the Web page. 
 
 

Configuring the Network 

 

• To connect via a LAN cable, refer to "Connecting a LAN Cable". 

• To connect via a USB cable, refer to "Connecting a USB Cable". 

• To connect via wireless LAN, refer to "Connecting via Wireless LAN". 
 
 

The example environment used in the following description is indicated below. 

• Machine name: Pro330 

• Machine IP address: 192.168.0.2 
 
 

• Displaying the machine status 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 The following screen is displayed. 
You can check the counter information and network information of the machine. 



243  

 
 

The settings of the machine can be changed from the [Admin Setup] tab. 
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  Encrypting Communication (SSL/TLS)  
You can encrypt the communication between the computer and the machine. 
Communication is encrypted via SSL/TLS in the following cases. A certificate is installed in 
the machine by default, which enables communication using HTTPS to be performed. 

 
• Creating a Certificate 

A certificate can be used when sending data to the machine on the network. This section 
describes how to create a certificate using the Web page. 

The following two types of certificates can be created. 

• Self-signed certificate 

A certificate issued by the machine. 

• CA certificate 

A certificate issued and signed by an external certificate authority for the CSR (certificate 
signature request) created by the machine. 

 

• Confirm that the previously installed certificate has been deleted before creating a new certificate. 

• If an IP address was set in the [Common Name] of the certificate, the certificate is disabled 

if the IP address of the printer is changed after creating the certificate. Create the certificate 

again. 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [SSL/TLS] 

• To delete a certificate that is already installed, click [Delete Certificate]. 
 

5 Follow the on-screen instructions to configure the detailed settings. 

6 Confirm the settings, and click [OK]. 
• If the certificate is a self-signed certificate, follow the on-screen instructions to close the Web 

page, and proceed to "Enabling Encryption." 

• To retrieve a certificate issued by a certificate authority, proceed to step 7. 

7 Follow the on-screen instructions to send the CSR to the certificate authority. 
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8 Click [OK]. 

9 Follow the on-screen instructions to install the certificate from the certificate authority. 

10 Click [Submit]. 
 

Proceed to "Enabling Encryption." 
 

• Importing a Certificate and Private Key 
This section describes how to import a certificate and private key using the Web page. 

A certificate and private key that have been issued can be imported in order to use a 
certificate issued by an external certificate authority. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [SSL/TLS] 

5 Select [Using Certificate and Private Key after imported] and import the certificate. 

• Certificates in the PKCS#12 format can be imported. 
 
 

Proceed to "Enabling Encryption." 
 

• Enabling Encryption 
Encryption can be enabled after creating a certificate. This section describes how to 
enable encryption using the Web page. 

When encryption is enabled, the communication is immediately encrypted after the 
setting is changed from the Web page. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [SSL/TLS] 
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5 Select [Enabled] for the protocol to encrypt. 

6 Click [Submit]. 
 

• Exporting a Certificate 
This section describes how to export a certificate using the Web page. 

The computer may request the certificate of the machine, depending on the 
function performing communication via SSL/TLS. 

In order to enable the computer to request the certificate of the machine, import the certificate 
of the machine that has been exported to the certificate store of the computer. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [SSL/TLS] 

5 Select [Export Certificate] to export the certificate. 

• The certificate is exported in the PEM format. 



247  

  Using IPP  
The machine can be added to a computer as an IPP printer. 

When IPP printing is enabled, data can be sent to the machine via the Internet. 
 
 

• Adding the Machine as an IPP Printer 
 

1 Click [Start], and select [Devices and Printers] > [Add a Printer]. 

2 Select [Add a network, wireless or Bluetooth printer] in the [Add a Printer] wizard. 

3 Select [The printer is not in the list] in the list of available printers. 

4 Select [Select the shared printer by name]. 

5 Enter "http://(The IP address of this machine)/ipp" or "http://(The IP address of this 
machine)/ipp/lp," and click [Next]. 

6 Click [Have Disk]. 

7 Insert the included "Software DVD-ROM" into a computer. 

8 Enter the following value in [Copy manufacturer's files from], and click [Use]. 
To install the PCL printer driver: "D:¥Drivers¥_PCL" 

 

• The DVD-ROM drive is set to the D drive in the above example. 
 

9 Select the INF file, and click [Open]. 

10 Click [OK]. 

11 Select the model, and click [OK]. 

12 Click [Next]. 

13 Click [Complete]. 

14 When installation is complete, print a test page. 
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  Encrypting Communication (IPSec)  
You can encrypt the communication between the computer and the machine. 

The communication is encrypted with IPSec. When IPSec is enabled, all applications 
use IPSec for encryption. 

50 hosts can be specified with an IP address. Access to the machine from unregistered hosts 
is refused. Access to unregistered hosts is also disabled. 

Configure the computer after configuring the machine. 
 

• The pre-shared key must be prepared in advance. 
 
 

• Configuring the Machine 

In order to enable IPSec, the Web page must first be used to configure the machine. 
 

§ IPSec communication is performed when IPSec is configured for both the printer and the 

host. IPSec communication is not performed unless IPSec is configured for the host. 

§ Make a note of the value specified in this procedure. It is required for configuring IPSec on the 
computer. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [IPSec]. 

5 Follow the on-screen instructions to configure the detailed settings. 

• Either [AH] or [ESP] must be enabled in "Phase2 Proposal." 
 

6 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

 
 

• If IPSec cannot be set up because the specified parameter is incorrect, the Web page cannot 

be accessed. In this case, disable IPSec from the operation panel of the machine or initialize 

the network settings. 
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Proceed to "Configuring the Computer." 
 

• Configuring the Computer 
Creating an IP Security Policy 

- Setting Key Exchange 

- Setting the IP Filter 

- Setting the Filter Operations 

- Assigning an IP Security Policy 
 
Configure IPSec on the computer. 

Follow the procedure below in order. 

 
 

• Configure the machine before configuring the computer. 

For details, refer to "Configuring the Machine". 
 
 

• Creating an IP Security Policy 
 

1 Click [Start], and select [Control Panel] > [System and Security] > [Administrative 
Tools]. 

2 Double-click [Local Security Policy]. 

3 Click [IP Security Policies on Local Computer] in the [Local Security Policy] window. 

4 Select [Create IP Security Policy] in the [Action] menu. 

5 Click [Next] in [IP Security Policy Wizard]. 

6 Enter [Name] and [Description], and click [Next]. 

7 Deselect [Activate the default response rule (earlier versions of Windows only)], and 
click [Next]. 

8 Select [Edit Properties], and click [Complete]. 
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• Setting Key Exchange 
 

1 Select the [General] tab in the IP security policy properties window. 

2 Click [Setup]. 

3 Enter a value (in minutes) in [Authenticate and generate a new key after every] in the 
[Key Exchange Settings] window. 

 

• Enter the same value as specified in [Lifetime] in "Phase1 Proposal" in "Configuring the 

Machine." [Lifetime] is specified in seconds, but enter a value in minutes in this step. 

4 Click [Methods]. 

5 Click [Add] in the [Key Exchange Security Methods] window. 

6 Specify [Integrity algorithm], [Encryption algorithm], and [Diffie-Hellman group]. 
 

• Select the same values as specified in [IKE Encryption Algorithm], [IKE Hush Algorithm], and 

[Diffie-Hellman group] in "Phase1 Proposal" in "Configuring the Machine." 

7 Click [OK]. 

8 Click [OK] in the [Key Exchange Security Methods] window. 

9 Click [OK] in the [Key Exchange Settings] window. 
 

• Setting the IP Filter 
 

1 Select the [Rules] tab in the IP security policy properties window. 

2 Click [Add]. 

3 Click [Next] in [Security Rules Wizard]. 

4 On the [Tunnel Endpoint] screen, select [This rule does not specify a tunnel], and click [Next]. 

5 On the [Network Type] screen, select [All Network Connections], and click [Next]. 

6 Click [Add] on the [IP Filter List] screen. 

7 Click [Add] in the [IP Filter List] window. 

8 Click [Next] in [IP Filter Wizard]. 

9 Click [Next] on the [IP Filter Description and Mirrored property] screen. 

10 Click [Next] on the [IP Traffic Source] screen. 

11 Click [Next] on the [IP Traffic Destination] screen. 



251  

12 Click [Next] on the [IP Protocol Type] screen. 

13 Click [Complete]. 

• Setting the Filter Operations 
 

1 Click [OK] in the [IP Filter List] window. 

2 In [Security Rules Wizard], select the new IP filter in the list, and click [Next]. 

3 Click [Add] on the [Filter Action] screen. 

4 Click [Next] in [Filter Action Wizard]. 

5 On the [Filter Action Name] screen, enter [Name] and [Description], and click [Next]. On 
the [Filter Action General Options] screen, select [Negotiate security], and click [Next]. 

6 On the [Communicating with computers that do not support IPsec] screen, select [Do 
not allow unsecured communication], and click [Next]. 

7 On the [IP Traffic Security] screen, select [Custom], and click [Setup]. 

8 Configure the settings in the [Custom Security Method Settings] window, and click [OK]. 

• Specify the same values as specified in [ESP Encryption Algorithm], [ESP Authentication 

Algorithm], [AH Authentication Algorithm], and [Lifetime] in "Phase2 Proposal" in 

"Configuring the Machine." 

9 Click [Next] on the [IP Traffic Security] screen. 

10 Select [Edit Properties], and click [Complete]. 
 

• Assigning an IP Security Policy 
 

1 To enable key PFS, select [Use session key perfect forward secrecy (PFS)] in the [Filter Action 
Properties] window. 

2 To perform IPSec communication with an IPv6 global address, select [Accept unsecured 
communication, but always respond using IPsec]. 

3 Click [OK]. 

4 Select the new filter operation, and click [Next]. 

5 On the [Authentication Method] screen, select the authentication method, and click 
[Next]. 
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• If an advance shared key was set in "Configuring the Machine," enable "Use this string to protect 

the key exchange (preshared key)" on the [Authentication Method] screen and enter the 

preshared key. 

6 Click [Complete]. 

7 Click [OK] in the IP security policy properties window. 

8 Select the new IP security policy in the [Local Security Policy] window. 

9 Select [Assign] in the [Action] menu. 

10 Confirm that [Yes] is displayed for the [Policy Assigned] of the new IP security policy. 

11 Click [X] in the [Local Security Policy] window. 
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  Using the IP Address Access Control Function (IP Filter)  
IP addresses can be used to control access to the machine. You can configure whether to 
allow printing or setting from the specified IP address. IP filtering is disabled by default. 

 

• Make sure to specify the correct IP address. If an incorrect IP address is specified, the machine 

will become unable to be accessed using the IP protocol. 

• If IP filtering is enabled, access to hosts not specified in this setting is refused. 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [IP Filtering]. 

5 Follow the on-screen instructions to configure the detailed settings. 

• If nothing is registered in [Administrator's IP Address to Register], the machine may become 

unable to be accessed, depending on the specified range of IP addresses. 

• If you are using a proxy server, the IP address of the host used may not match [Your Current Local 
Host/Proxy IP Address]. 

 

6 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

 
 

• Only IPv4 can be used for IP filtering. 
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  Using the MAC Address Access Control Function  
MAC addresses can be used to restrict access to the machine. You can allow or refuse access 
from specified MAC addresses. 

 

• Make sure to specify the correct MAC address. If an incorrect MAC address is specified, the 

machine will become unable to be accessed from the network. 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Security] > [MAC Address Filtering]. 

5 Follow the on-screen instructions to configure the detailed settings. 

• If nothing is registered in [Administrator's MAC Address to Register], the machine may 

become unable to be accessed, depending on the specified range of MAC addresses. 

• If you are using a proxy server, the MAC address of the host used may not match [Your 

Current Local Host/Proxy MAC Address]. 

6 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

 

• Access cannot be individually allowed or refused for each address. 
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  E-Mail Alert  
A mail server needs to be configured in advance in order to use this function. 

 

• For details, refer to "E-mail Configuration (Web Page)". 
 
 
 

• Sending Error Notifications via E-mail 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [E-mail] > [Alert Settings]. 

5 Enter the e-mail address to notify in [Failure Notification Settings]. 

6 Click [Setup] for the entered e-mail address. 
Click [COPY] to apply the notification conditions to another address. 

 

7 Select [Upon occurrence of an event] in [Failure Notification Method], and click [To Step 
2]. 

8 Follow the on-screen instructions to configure the detailed settings. 

9 Select an error or warning to send notification for to display the window for specifying the time 
difference between when the error occurs and when the notification is sent. 

10 Click [OK]. 

11 Click [View a summary of current configuration], confirm the current settings, and click 
[X] to close the window. 
You can also check the current settings for a maximum of two addresses in the main window. Select the 
address to check from the list box. 

12 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 
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• Periodically Sending Error Notifications via E-mail 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [E-mail] > [Alert Settings]. 

5 Enter the e-mail address to notify in [Failure Notification Settings]. 

6 Click [Setup] for the entered e-mail address. 
Click [COPY] to apply the notification conditions to another address. 

7 Select [Periodically] in [Failure Notification Method], and click [To Step 2]. 

8 Follow the on-screen instructions to configure the detailed settings. 

9 Click [OK]. 

10 Click [View a summary of current configuration], confirm the current settings, and click 
[X] to close the window. 
You can also check the current settings for a maximum of two addresses in the main 
window. Select the address to check from the list box. 

12 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

 
• Notification e-mail is not sent unless the target error has occurred. 
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  Using SNMPv  
Using an SNMP manager that supports SNMPv3 enables the management of the machine 
to be encrypted via SNMP. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [SNMP] > [Setup]. 

5 Follow the on-screen instructions to configure the detailed settings. 

6 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

• You can use a commercial SNMP manager tool to check and change the settings of the 

machine. For information on the MIB of the machine, access the "Software DVD-ROM" 

included with the machine, and check the MIB definition files in the [Misc] > [MIB Files] folder. 
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  Using IEEE802.1X (Wired LAN)  
The machine supports IEEE802.1X authentication. IEEE802.1X authentication is performed 
after enabling it on the Web page and connecting to the authentication switch. 
 

 
• Using EAP-TLS 
This section describes how to set EAP-TLS, which is a type of IEEE802.1X authentication. 

 
1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [IEEE802.1X]. 

5 Select [Enabled] for [IEEE802.1X]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Enter the user name in [EAP User]. 

8 Select [Do not use SSL/TLS Certificate for EAP authentication], and click [Import]. 

9 Enter the file name of the certificate. 
Only PKCS#12 files can be imported. 

10 Enter the certificate password, and click [OK]. 

11 Select [Authenticate Server], and click [Import]. 

12 Enter the file name of the CA certificate, and click [OK]. 
Specify the certificate of the certificate authority (CA) used for the RADIUS server 
authentication. PEM, DER, and KCS#7 files can be imported. 

13 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

14 Turn off the machine when it becomes online. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

15 Remove the LAN cable from the machine. 

16 Proceed to "Connecting the Machine to an Authentication Switch." 
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• Using PEAP 
This section describes how to set PEAP, which is a type of IEEE802.1X authentication. 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [IEEE802.1X]. 

5 Select [Enabled] for [IEEE802.1X]. 

6 Select [PEAP] in [EAP Type]. 

7 Enter the user name in [EAP User]. 

8 Enter the password in [EAP Password]. 

9 Select [Authenticate Server], and click [Import]. 

10 Enter the file name of the CA certificate, and click [OK]. 
Specify the certificate of the certificate authority (CA) used for the RADIUS server 
authentication. PEM, DER, and KCS#7 files can be imported. 

11 Click [Submit]. 
The new setting is enabled after the network function of the machine is restarted. 

12 Turn off the machine when it becomes online. 

• For information on turning off the machine, refer to "Turning Off the Machine". 
 

13 Remove the LAN cable from the machine. 

14 Proceed to "Connecting the Machine to an Authentication Switch." 
 

• Connecting the Machine to an Authentication Switch 
 

1 Make sure that the machine is turned off. 

2 Connect a LAN cable to the network interface connector of the machine. 
Insert the other end of the LAN cable into the authentication port of the authentication 
switch. 
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3 Turn on the machine. 

• For information on turning on the machine, refer to "Turning On the Machine". 
 

4 Set the IP address, etc. of the machine. 
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  Configuring IEEE802.1X (Wireless LAN)  
You can use wireless LAN to configure IEEE802.1X authentication. First configure IEEE802.1X 
authentication on the Web page of the machine, and then configure the wireless connection on 
the Web page. 

 
• Using EAP-TLS 

 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [IEEE802.1X]. 

5 Select [Disabled] for [IEEE802.1X]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Enter the user name in [EAP User]. 

8 Select [Do not use SSL/TLS Certificate for EAP authentication], and click [Import]. 

• If you selected [Use SSL/TLS Certificate for EAP authentication], the certificate must be 

configured in advance on the [SSL/ TLS] menu. 

9 Select the file of the certificate. 
Only PKCS#12 files can be imported. 

10 Enter the certificate password, and click [OK]. 

11 Select [Authenticate Server], and click [Import]. 

• If you selected [Not authenticate Server], proceed to step 13. 
 

12 Select the file name of the CA certificate, and click [OK]. 

• Specify the certificate of the certificate authority (CA) used for the RADIUS server 

authentication. PEM, DER, and PKCS#7 files can be imported. 

13 Click [Submit]. 

14 If the machine becomes online, proceed to "Configuring Wireless LAN (WPA/WPA2- EAP)." 
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• Using PEAP 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [IEEE802.1X]. 

5 Select [Disabled] for [IEEE802.1X]. 

6 Select [PEAP] in [EAP Type]. 

7 Enter the user name in [EAP User]. 

8 Enter the password in [EAP Password]. 

9 Select [Authenticate Server], and click [Import]. 

• If you selected [Not authenticate Server], proceed to step 11. 
 

10 Select the file name of the CA certificate, and click [OK]. 

• Specify the certificate of the certificate authority (CA) used for the RADIUS server 

authentication. PEM, DER, and PKCS#7 files can be imported. 

11 Click [Submit]. 
If the machine becomes online, proceed to "Configuring Wireless LAN (WPA/WPA2- EAP)." 

 
 

• Configuring Wireless LAN (WPA/WPA2-EAP) 
 

1 Open the Web page of this machine. 

• For information on starting the Web page, refer to "Starting the Web Page". 
 

2 Log in as the administrator. 

3 Select [Admin Setup]. 

4 Select [Network] > [Wireless(Infrastructure)] > [Manual Setup]. 
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5 Select [Enabled] in [Wireless(Infrastructure)] in [Setup]. 

• The default setting is [Disabled]. 
 

6 Enter the SSID name of the wireless AP to connect to in [SSID]. 

7 Select [WPA/WPA2-EAP] in [Security] in [Security Settings]. 

8 When all the basic settings and security settings are complete, click [Submit] on the 
bottom left of the Web screen to reflect the settings. It may take up to one minute to 
connect to the wireless AP. If the connection fails, reconfigure the wireless settings 
from the operation panel again or switch to wired LAN from the operation panel and 
reconfigure the wireless settings from the Web page. 
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Configuration Tool 
The Configuration Tool enables multiple devices to be managed or configured. 

 
 

  Registering the Machine  
When installing the machine for the first time, register it to the Configuration Tool. 

 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Register Device] from the [Tools] menu. 

3 When the devices that can be registered are displayed, select the machine and click 
[Register]. 

4 Click [Yes] on the confirmation screen. 
 
 

  Starting the Configuration Tool  
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 
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  Checking the Status of the Machine  
You can check the status and information of the machine. 

 
1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Info] tab. 

 
 

• If the machine is connected to the network, [Device Status] is displayed. 

• Click [Update Device Information] to update the information. 
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  Changing the Menu Settings  
You can check the status and information of the machine. You can change the menu settings 
of the machine or copy the settings to another machine. This section describes how to 
save/restore the menu settings to/ from a file. 

 
• Saving the Settings to a File 

 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Setting] tab. 

 

4 Click [Menu settings]. 
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5        Click [Backup settings]. 

 
 

6 Enter the file name, select the folder to save the file, and click [Save]. 
 
 

• Restoring the Settings from a File 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Setting] tab. 
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4 Click [Menu settings]. 
 

 
 

5     Click [Restore Settings]. 
 

 

6 Check the displayed message, and click [Yes]. 

7 Select the file to restore, and click [Open]. 

8      Click [Save to device]. 
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• Changing the Administrator Password of the Machine 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Setting] tab. 

 

4 Click [Change password]. 

 

5 Enter the current password and new password, and click [OK]. 
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  Copying Settings (Cloning)  
Menu settings can be copied to another machine. 

 
1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select the machine to clone from [Registered Device Table]. 

3 Select the [Device Setting] tab. 

 

4 Click [Cloning]. 

 

5 Enter the administrator password, and then click [OK]. 

• The default password is "999999." 
 

6 Select the destination device and the cloning settings. 

7 Click [Execute]. 
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8 Enter the administrator password of the destination device, and click [OK]. 
The result is displayed. 
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  Configuring the Network  
You can configure the network of the machine. 
 

• Searching for the Machine on a Network 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Network Setting] in the [Plug-in] menu. 

3 Select [Discover Devices]. 
i. The search results are displayed. 

 

 

• Specifying the Search Conditions 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Network Setting] in the [Plug-in] menu. 

3 Select [Environment Settings]. 
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4 Configure the search conditions as required, and click [OK]. 

 

• Changing the IP Address 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Network Setting] in the [Plug-in] menu. 

3 Select [Discover Devices]. 

4 Select the machine from the list of devices. 

5      Click [Device Settings]. 
6 Change the settings as required. 

7 Click [Setup]. 

8 Enter the administrator password, and then click [OK]. 

• The default password is "999999." 
 

9 Click [OK] and restart the device. 
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  Registering Forms (Form Overlay)  
Forms for logos, etc. can be registered in the machine for performing overlay printing. This 
section describes how to register forms. 

 

• For information on performing overlay printing, refer to "Overlaying Text or Logos when Printing". 
 
 
 

• Creating Forms 
 

1 Click [Start], and then select [Devices and Printers]. 

2 Right-click the icon of the machine, and select the required printer driver in [Printer 
properties]. 

3 Select the [Ports] tab, select [FILE:] in [Port], and select [Apply]. 

4 Create the forms to register to the machine. 

5 Print. 

6 Enter the file name to save. 
Example: C:\temp\form.prn 

7 Select the original port in [Port] on the [Ports] tab, and select [OK]. 
 

• Registering Forms to the Machine Using the Configuration Tool 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Storage Manager] in the [Plug-in] menu. 

3      Click [New Project]. 
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4      Click [Add File to Project], and select the form file you created. 
The form is added to the project. 

 

 

5 Click the form file. 

6 Enter the form ID (of your choice) in [ID], and click [OK]. 

• Do not change [Target Volume] or [Path]. 
 

• Specify the form ID entered in [ID] when performing overlay printing. 
 

7 Select the machine in the window on the bottom of the Storage Manager plug-in 
screen. You can select multiple machines to register forms to. 

 

• If the machine is not registered in the Configuration Tool, refer to "Registering the Machine". 
 

8      Click [Send project files to printer]. 

9 Delete items registered in the machine before performing registration. 
Select the form, and click [OK]. 
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10 Enter the administrator password, and then click [OK]. 

 

11 Confirm the setting results, and click [Back]. 
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  Registering a Demonstration Page  
You can register demonstration pages to the machine for printing. This section describes how to 
registering a demonstration page. 

 
• Creating a Demonstration Page 

 

1 Click [Start], and then select [Devices and Printers]. 

2 Right-click the icon of the machine, and select the required printer driver in [Printer 
properties]. 

3 Select the [Ports] tab, select [FILE:] in [Port], and select [Apply]. 

4 Create the forms to register to the machine. 

5 Print. 

6 Enter the file name to save. 
Example: C:\temp\form.prn 

7 Select the original port in [Port] on the [Ports] tab, and select [OK]. 

8 Select the created file, and change the extension to “. DMO”. 
 

• Registering a Demonstration Page to the Machine Using the Configuration Tool 
 

• Demonstration pages are referred to as "demo pages" hereinafter. 
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Storage Manager] in the [Plug-in] menu. 

3    Click [New Project]. 
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4   Click [Add File to Project], and select the demo page file you created. 
Select [Demo page file(*.DMO)] on the bottom right of the screen to select the created 
demo page file. 

 

 

5 Click the demo page file. 

6 Enter a component name for the demo page in [Component], and click [OK].  

7 Select the machine in the window on the bottom of the Storage Manager plug-in 
screen. You can select multiple machines to register demo pages to. 

 

• If the machine is not registered in the Configuration Tool, refer to "Registering the Machine". 
 

8      Click [Send project files to printer]. 

9 Delete items registered in the machine before performing registration. 
Select the demo page, and click [OK]. 

 

 

10 Enter the administrator password, and then click [OK]. 
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11 Confirm the setting results, and click [Back]. 
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  Checking the Free Memory/Storage Space  
 

1 Click [Start], and select [General] > [Configuration Tool]. 

2 Select [Storage Manager] in the [Plug-in] menu. 

3 Click the device name in the device selection area on the bottom of the Storage 
Manager plug-in screen. 
Communicating with the device displays the storage, volume name, size, free space, 
location name, label, status, file name, size, and comment, etc. 
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  Removing the Machine  
You can cancel the registration of the machine. 

 
1 Click [Start], and select [General] > [Configuration Tool]. 

2 Right-click the machine in [Registered Device Table]. 

3 Select [Remove device]. 

4 Click [Yes] on the confirmation screen. 
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  Names and Functions of Each Screen  
This section describes the names and functions of each screen. 

 
• [Device Info] Tab 

Displays information related to the machine. 
 

 
 

• [Device Setting] Tab 
Configures and copies the menus of the machine. 

 
 
 
 
 
 
 

1 
2 
3 

 
 
 
 
 
 
 
 

 Item Description 

1 Menu settings Changes the settings of the menu items of the machine. 

2 Cloning Copies the settings of the menu items of the machine to another 
machine. 

3 Change password Changes the administrator password of the machine. 

1 
2 
3 
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• [Network Setting] Plug-in Configures the network. 
 
 
 
 
 

4 
5 

 
 
 
 
 
 
 
 
 
 
 

 Item Description 

4 Discover Devices Discovers network devices. 

5 Environment Settings Changes the device detection standard and communication options. 
 
 

• [Storage Manager] Plug-in 
Registers and edits the files to download to the machine. 

 

4 
5 
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Status Monitor 
The Status Monitor is a utility for displaying the status of printers on a 

computer. The Status Monitor includes the following functions. 

• Displaying the machine status 

• Retrieving information included in the following reports as a CSV file 
 

- Setting 

- Error Log 
 

  System Requirements  
Windows 10/Windows 8.1/Windows 8/Windows 7/ 
Windows Server 2016/Windows Server 2012 R2/Windows 
Server 2012/ Windows Server 2008 R2/Windows Server 2008 

§ Administrator privileges for the computer are required for setup. 
§ In order to use the Status Monitor, the printer driver is must be installed in advance, USB or 

the standard TCP/IP port must be specified for [Ports] in the printer driver, and the machine 

must be connected. 
 
 

  Starting the Status Monitor  
The Status Monitor automatically starts when printing is performed. Perform the procedure 
below to start it manually. 

 

1 Select [Start] > [General] > [Pro330 Status Monitor] to start the Status Monitor. 
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  Displaying the Printer Status  
[Printer State] Tab 

 
1 

 
2 

3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 
 
 
 
 
 

No. Description 

1 Displays the name of the printer for monitoring. 

2 Displays the printer status as text. 

3 Displays the printer status that has occurred concurrently with that on 
top as text. (Only displayed when connected via USB) 

4 Displays all the concurrent statuses of the printer as text. 
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  Switching the Printer Settings  
[Printer Setup] Tab 

 
 
 
 
 
 
 
 
 
 
 
 
 

1 
 

2 
 

3 
4 

 
 
 
 
 
 
 
 

No.  Description 

1 Select Printer Changes the destination printer. 

2 Output Report Data Select [Setting] or [Error Log] from the pull-down menu, and click the 
[Execute] button to output the report data in the CSV format. 

3 Configuration Outputs detailed information on the printer settings. 

4 Error Log Outputs the error log of the printer. 
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  Switching the Status Monitor Settings  
[Preferences] Tab 

 
 
 
 
 
 
 
 
 
 

1 
2 

 

3 
 

4 
 
 
 

5 
 
 
 
 
 
 
 
 

No.  Description 

1 Minimized View  

2 Display Status Panel Displays the printer status using text and the background color of the 
icon. 

3 Display icon only Displays the printer status using an icon displayed on the task bar. 

4 Alert View Specifies the display position of the status monitor when a warning 
occurs in the printer. 
When selected, a popup is displayed in front when an error occurs in 
the printer. When deselected, a popup is not displayed, even when an 
error occurs in the printer. 

5 Consumable Warnings Configures how the consumable warning is displayed. 
When selected, a warning is displayed for the first warning, etc. of the 
day when the PC starts. When deselected, a warning is displayed at 
the start of continuous documents. 
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General Specifications 
 
 

Model Model Number 
Pro330 N36700A/N36700B 

 
 

Item Pro330 
CPU ARM Cortex A9(533MHz) 
Memory DDR3 16bit 512MB 
ROM 64MB 
Weight 
(including consumables) 

Approx. 9.5kg 

Dimensions (W x D x H) 198mm(7.8") x 380mm(15") x 195mm(7.7") 
Power supply N36700A: 110 - 127V AC +/-10% 

N36700B : 220 - 240V AC +/-10% 
Power consumption Typical operation Average Approximately 250W 

Idle Average Approximately 10W 
Peak 650W 
Power save mode Average Approximately 5W 
Sleep mode Average Approximately 1W *1 
Auto power off mode ≤ 0.5W 

Operating condition Operating Temperature:10 - 32 °C 
Humidity:20 - 80 %RH 

Idle Temperature:0 - 43 °C 
Humidity:10 - 90 %RH 

Interface USB 2.0, 
Ethernet 10BASE-T/100BASE-TX/IEEE802.11 
b/g/n/a Wireless LAN (Option), 

Display 16 charactors x 2 lines 
Supported OS Windows 10/Windows Server 2016/ 

Windows 8.1/Windows Server 2012 R2/ 
Windows 8/Windows Server 2012/ 
Windows 7/Windows Server 2008 R2/ 
Windows Server 2008 

Device service life 120km or 5 years 
Storage environment Temperature: -10 - 43 °C 

Humidity:10 - 90 %RH 
*1: Default setting. May differ according to the device settings. 
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Printing Specifications 
 
 

Item Pro330 
Printing method LED color 
Page-description language PCL5c, PCL6(PCLXL) 
Resident fonts Bitmap: 4 fonts 

Scalabel: 27 fonts 
Resolution 1200x1200dpi 
Color Yellow, Magenta, Cyan 
Print speed Max 6 IPS 
Paper size Width: 25 - 86 mm 

Length: 53 - 551 mm 
Media type Plain, User Type 1 - 5 
Warm-up time 23 sec 
Usage Environment Conditions • When in operation 

10 - 32°C/ Relative Humidity of 20 - 80% 
(maximum wet bulb temperature of 25°C, 
aximum dry bulb temperature of 2°C) 

• When not in operation 
0 - 43°C/ Relative Humidity of 10 - 90% 
(maximum wet bulb temperature of 26.8°C, maximum 
dry bulb temperature of 2°C) 

Conditions for the guarantee of print quality • Operating Range 
Temperature 10°C, humidity 20 to 80% RH 
Temperature 32°C, humidity 20 to 60% RH 
Humidity 20% RH, temperature 10 to 32°C 
Humidity 80% RH, temperature 10 to 27°C 

• Full-color Print Quality Assured Range 
Temperature 17 to 27°C, humidity 50 to 70% RH 

Consumables Toner Cartridge, Image Drum Unit, Transfer Belt Unit, 
Fuser Unit 
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Network Related 
 
 

Item Pro330 
Interfaces Ethernet 10BASE-T/100BASE-TX, 

IEEE802.11 a/b/g/n wireless LAN 
Protocols TCP/IPv4, TCP/IPv6, NetBIOS over TCP, LPR, 

Port9100, IPP, FTP, HTTP, TELNET, SMTP, POP3, 
SNMPv1/v3, DHCP, DHCPv6, DNS, DDNS, UPnP, 
WINS, Bonjour, SNTP, LLTD, Web Services Discovery 
(WSD), SSL/TLS, IPSec, IEEE802.1X 

 
 

Wireless LAN Specifications 
 

Item Pro330 
Wireless LAN Standard IEEE802.11a/b/g/n (2.4 GHz/5 GHz) 
Security Disabled, WEP, WPA-PSK, WPA2-PSK, WPA-EAP, 

WPA2-EAP 
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List of Included Fonts 
 
 

No. Font Name List Description 
I0 Courier Scalable Fonts 
I1 Courier Bold 
I2 Courier Italic 
I3 Courier Bold Italic 
I4 CG Times 
I5 CG Times Bold 
I6 CG Times Italic 
I7 CG Times Bold Italic 
I8 Univers Medium 
I9 Univers Bold 
I10 Univers Medium Italic 
I11 Univers Bold Italic 
I12 Letter Gothic 
I13 Letter Gothic Bold 
I14 Letter Gothic Italic 
I15 Letter Gothic Bold Italic 
I16 Arial 
I17 Arial Bold 
I18 Arial Italic 
I19 Arial Bold Italic 
I20 Times New 
I21 Times New Bold 
I22 Times New Italic 
I23 Times New Bold Italic 
I24 Symbol 
I25 Wingdings 
I26 OCRB Subset2 
I27 Line Printer Bitmap Fonts 
I28 OCR-A 
I29 OCR-B 
I30 USPS POSTNET Bar Codes 
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Consumables/Maintenance Parts/Options 
Purchase these consumables, maintenance parts, and options from the dealer where 
you bought the machine. 

 
• Consumables 

 

Product Name Model Description 
Toner Cartridge  Enables printing of approximately 

5,000 pages. 
Image Drum Unit  Enables printing of approximately 

25,000 pages. 
 

• Maintenance Parts 
 

Product Name Model Description 
Fuser Unit  Enables printing of approximately 

100,000 pages. 
Transfer Belt Unit  Enables printing of approximately 

100,000 pages. 
Paper Feed Roller  Enables printing of approximately 60 km. 
Feed Roller  Enables printing of approximately 60 km. 

 
• Options 

 

Product Name Model Description 
Wireless LAN Module  Enables wireless connections. 
Presenter Unit  The Presenter Unit is installed to stop the 

printed paper before it is fully ejected. 
 

 
• The print quality deteriorates after one year or more passes since you open the toner cartridge 

and image drum unit. In this case, prepare a new consumable for replacement. 

• Do not open the package until the consumable is ready for use. 

• Avoid direct sunlight and store it in a location in the range of 0 to 35°C temperature and 20 to 85% 
relative humidity. 

• Do not store it in a location subject to high or rapid changes in temperatures or humidity. 

• Keep it away from children. 



  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



  

 
 
 
 
 
 
 

 

 


